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The ideas that go into a book of this size do not all originate with a single individual. Research for
many of the topics was done at user group meetings, SolidWorks Corporation’s discussion forums,
and SolidWorks Customer Portal, as well as the blogs and Web sites of many individuals. I would
like to thank all of the individuals who have posted to the public forums or blogs. Many of these
people have knowingly or unknowingly contributed to my SolidWorks education, as well as that
of many other SolidWorks users around the world.



Welcome to the SolidWorks 2009 Bible. This book has been written as a desk reference for begin-
ning and intermediate SolidWorks users. SolidWorks is such an immense software program that
trying to cover all of its functions is an extremely ambitious undertaking, and I know that a few
have been left out. Because of the scope of the topic, I have limited the book to covering the basic
SolidWorks package, without the Office, Office Professional, or Office Premium add-ins, although
[ have devoted half of a chapter to Toolbox.

About This Book

You will find enough information here that the book can grow with your SolidWorks needs. I have
written tutorials for most of the chapters with newer users in mind, because for them, it is most
helpful to see how things are done in SolidWorks step by step. The longer narrative examples give
more in-depth information about features and functions, as well as the results of various settings
and options.

I have included an extensive appendix covering the Tools, Options settings. This offers an in-depth
explanation of each option, including both System Options and Document Properties. This appen-
dix uses special symbols to identify items that are new for SolidWorks 2007 or that affect file size
or speed.

How This Book Is Organized

This book is divided into eight parts.

Part I: SolidWorks Basics

This part explores basic concepts and terminology used in SolidWorks. You need to read this sec-
tion if you are new to the software and especially if you are new to 3D modeling or parametric his-
tory-based design.

Part Il: Building Intelligence into Your Parts

This part takes a deeper look at creating parametric relations to automate changes.



Part I1I: Working with Assemblies

Part III delves into assembly modeling in it various aspects, from efficiency to in-context modeling.

Part IV: Creating and Using Libraries

Part IV helps you understand how to build and manage libraries of various types with an eye
toward upgrading versions, best practice and reusing data when possible.

Part V: Creating Drawings

This part examines the functionality within the 2D drawing side of the software. Whether you are
creating views, making tables or customizing annotations, this chapter has something for everyone.

Part VI: Using Advanced Techniques

This part examines several types of advanced techniques, such as surface modeling and multi-body
modeling. This is information you won't find in other SolidWorks books, explained here by some
one who uses the functionality daily.

Part VII: Working with Specialized Functionality

Specialized functionality such as sheet metal, weldments, plastics and animation requires detailed
information. Part VII includes these topics because they are key to unlocking all of the power avail-
able in SolidWorks.

Part VIII: Appendices

The appendices in this book cover a range of ancillary data from how to implement the software to
a detailed and complete list of the available options. The Tools=>Options list in Appendix B is one

of those things that distinguishes this book from others available. You need to know where to find
settings, and this appendix has it all.
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Icons Used in This Book

This book uses a set of icons to point out certain details in the text. While they are relatively self-
explanatory, here is what each of these icons indicates:

L IOTE Notes highlight useful information that you should take into consideration, or an
\ - important point that requires special attention.
TP Tips provide you with additional advice that makes the software quicker or easier to
use.
~ . 1 -r A~ | Caution icons warn you of potential problems before you make a mistake.

. The New Feature icon highlights features and functions that are new to
IELY EEy l rre
HEYY FEATURE SolidWorks 2009.

ClOSS-PER Cross-Ref icons point out where you can find additional information about a topic
— 1= SYIIZET elsewhere in the book.

This icon points you toward related material on the book’s CD.

Ol ihe CD-2OM

The SolidWorks 2009 Bible is unique in its use of these two icons:

T PR ACTICLE Best practice icons point out recommended settings or techniques that are safe in
PRAC -2 st situations.

- .| ~- Performance icons elaborate on how certain settings, features, or techniques affect
PERFORNANCE . S
—i=t VA rebuild speed o file size.

These icons point out and describe techniques and settings that are either recommended or not
recommended for specific reasons. Best Practice is usually considered to be very conservative
usage, where the stability of the parametrics and performance (a euphemism for rebuild speed) are
the ultimate goals. These two aspects of SolidWorks models are usually weighed against modeling
speed (how long it takes you to create the model).

Best Practice and Performance recommendations need to be taken seriously, but you should treat
them as guidelines rather than as rules. When it comes right down to it, the only hard and fast rule
about SolidWorks is that there are no hard and fast rules. In fact, I believe that the only reason to
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have rules in the first place is so that you know when you can break them. Parametric stability and
modeling speed are not always the ultimate goals, and are often overridden when workaround
techniques are used simply to accomplish a geometric goal.

Because not everyone models with the same goals in mind, a single set of rules can never apply for
everyone. You must take the best practice suggestions and apply them to your situation using your
own judgment.

My point of view while writing this book has been that of someone who is actually using the soft-
ware, not of someone trying to sell ideas, nor of someone trying to make the software look good,
or even that of an academic trying to make a beautiful argument. I try to approach the software
objectively as a tool, recognizing that complex tools are good at some things and not so good at
others. Both kinds of information (good and not-so-good) are useful to the reader. Pointing out
negatives in this context should not be construed as criticizing the SolidWorks software, but rather
as preparing the reader for real-world use of the software. Any tool this complex is going to have
imperfections. Hopefully some of my enthusiasm for the software also shows through and is to
some extent contagious.

Terminology

An important concept referred to frequently in SolidWorks is design intent. As a practical matter,
use the phrase design for change to further distinguish design intent from other design goals.

The reader needs to be familiar with some special terminology before continuing. In many cases, a
SolidWorks vernacular or slang is used when the official terminology is either not descriptive
enough or, as is sometimes the case, has multiple meanings. For example, the word shortcut has
multiple meanings in the SolidWorks interface. It is used to describe right mouse button menus as
well as hotkeys. As a result, [ have chosen not to use the word shortcut and instead substitute the
words RMB and hotkey.

I frequently use RMB to refer to Right Mouse Button menus, or other data that you access by click-
ing the right mouse button on an item. The word tree refers to the list of features in the
FeatureManager. Also, command and option names are referred to using all initial capitals, even
when SolidWorks does not use the same capitalization. For example, the setting Single Command
Per Pick is listed in Tools®> Options as Single command per pick. I do this to help the reader dis-
tinguish command names from other general text.
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Differences are frequently found between the names of features on toolbars and the names in the
menus or PropertyManager titles. In these cases, the differences are usually minor, and either name
may be used.

Most functions in SolidWorks can work with either the object-action or the action-object scenarios.
These are also called pre-select and select, respectively. For example, the Hole Wizard is one tool for
which pre-selection is definitely recommended because a difference in functionality is seen between
pre-selection and selection. The Fillet feature shows no difference between using pre-selection and
selection, although for some fillet options such as face fillet, pre-select is not enabled. Most features
allow pre-selection, and some functions, such as inserting a design table, require pre-selection.
Although you cannot identify a single rule that covers all situations, most functions accept both.

Frequently in this book, I have suggested enhancement requests that the reader may want to make.
This is because SolidWorks development is driven to a large extent by customer requests, and if a
large number of users converge on a few issues, then those issues are more likely to be fixed or
changed. Again, the enhancement request suggestions are not made to criticize the software, but to
make it better. I hope that several of you will join me in submitting enhancement requests.

SolidWorks is an extremely powerful modeling tool, very likely with the best combination of
power and accessibility on the MCAD market today. This book is meant to help you take advan-
tage of its power in your work and even hobbyist applications. If I could impart only a single
thought to all readers of this book, it would be that with a little curiosity and some imagination,
you can begin to access the power of SolidWorks for geometry creation and virtual product proto-
typing. You should start with the assumption that there is a way to do what you are imagining, and
that you should be open to using different techniques.

For AutoCAD users making the transition to SolidWorks, you should simply forget everything you
know about AutoCAD, because most of it, except for the most general geometric concepts, will not
apply to SolidWorks, and will often simply confuse you.

Whoever you are, I hope that you find insight deeper than simply “what does this button do?” in
this book. I hope that you will find an intuition for thinking like the software. Jeff Ray, CEO of the
SolidWorks Corporation has said that the goal is to make the software as “intuitive as a light
switch.” While most people will agree that they have some work left to achieve that particular goal,
[ believe that approaching the interface intuitively, rather than attempting to remember it all by
rote, is the best method. Good luck to you all.



Contacting the Author

You might want to contact me for some reason. Maybe you found an error in the book, or you
have a suggestion about something that you think would improve it. It is always good to hear what
real users think about the material, whether you like it or thought it could be improved.

The best way to contact me is either through email or through my blog. My email address is
matt@dezignstuff.com. You will find my blog at http://dezignstuff.com/blog. On
the blog you can leave comments and read other things I have written about the SolidWorks soft-
ware, CAD, and engineering or computer topics in general. I encourage you to also leave feedback
on websites where you might have purchased the book. For example, Amazon allows customers to
review books, and book reviews are always beneficial.

If you want to contact me for commercial help with a modeling project, the email address above is
the best place to start that type of conversation.

Thank you very much for buying and reading this book. I hope the ideas and information within
its pages help you accomplish your professional goals.
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SolidWorks Basics

essential. I recommend reading these chapters in order,
since the material in each chapter builds on the material of
the previous chapter.

If you are a new SolidWorks user, the chapters of Part [ are

If you are an existing SolidWorks user but new to the post 2009
releases, I strongly recommend Chapters 2 and 5. Even if you
are a very experienced user, I recommend Chapter 5. The visu-
alization techniques are things we all use on a constant basis in
the software, and picking up even a small tip can add to your
productivity dramatically.

IN THIS PART

Chapter 1
Introducing SolidWorks

Chapter 2
Navigating the SolidWorks
Interface

Chapter 3
Working with Sketches

Chapter 4
Creating Simple Parts,
Assemblies, and Drawings

Chapter 5
Using Visualization Techniques




Introducing SolidWorks

f you are coming to SolidWorks from Inventor, Solid Edge, or another

program in that class, you will find SolidWorks to be very familiar

territory, with a similar if not identical design philosophy. SolidWorks
also shares a lot of underlying structure with Pro/ENGINEER, and if you are
coming from that product, there will be some relearning, but much of your
training will be transferable.

If you are coming from 2D AutoCAD, CADKEY, or MicroStation,
SolidWorks may at first cause a bit of culture shock for you. However, once
you embrace feature-based modeling, things will go more easily. As you will

see, SolidWorks, and in fact most solid modeling in general, is very process-
based.

Regardless of how you arrived here with this SolidWorks Bible in your hand,
here you are. Together we will progress through basic concepts to advanced
techniques, everyday settings, and subtle nuances. This book will serve as
your tutor and desk reference for learning about SolidWorks software.

This chapter will familiarize beginners with some of the tools available to
make the transition, and with some of the basic facts and concepts that you
need to know to get the most out of SolidWorks.

If all you want to do is to start using the software, and you are not concerned
with understanding how or why it works, you can skip directly to Chapter 4
for sketches or Chapter 5 to start making parts, assemblies, and drawings. Of
course, I recommend getting a bit of background and some foundation.

IN THIS CHAPTER

Starting SolidWorks for the
first time

Identifying different types of
SolidWorks documents

Understanding feature-based
Modeling

Understanding history-based
Modeling

Sketching with parametrics

Understanding Design Intent

Editing Design Intent

Working with associativity

Tutorial: Creating a part
template
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Starting SolidWorks for the First Time

SolidWorks has many tools for beginning users that are available when the software is installed. A
default installation presents you with several options when the software is started the first time.
Following is a catalog of these options and how to get the most benefit from them.

If you plan to go to formal SolidWorks reseller-based training classes, it is a very good idea to go
through some of the tutorials mentioned in this section first; this way you are prepared to ask edu-
cated questions and have a leg up on the rest of the class. You will get more out of the training
with the instructor if you have seen the material once before.

SolidWorks License Agreement

It is useful to be familiar with what this document says, but the agreement does not have any bear-
ing on learning how to use the software other than the fact that it allows for a Home Use License.
Many users find this part of the license agreement, shown in Figure 1.1, helpful. The primary user
of the license at work is also allowed to use the license at home or on a portable computer. This is
often a good option for learning, additional practice or completing the design of the deck or soap-
box derby car. If your business uses floating licenses, the rules are somewhat different. Contact
your reseller for details. In any case, select Accept to get past the License Agreement page.

FIGURE 1.1

The SolidWorks License Agreement

Welcome to SolidWorks

The Welcome to SolidWorks screen, shown in Figure 1.2, is the next thing to greet you. This helps
you establish what type of tools you would like to see in the interface and gives you some help
options. You may not get the chance to see this dialog box if someone else, for example an IT per-
son, has installed and done an initial test on your software for you.

Quick Tips

Quick Tips enables balloons with tips to help you get started with several tasks. For example, the
first Quick Tip you see may be this one, shown in Figure 1.3. When you begin to create your first
document in SolidWorks, a Quick Tip helps guide you on your way.
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Welcome to SolidWorks screen

FIGURE 1.3

New SolidWorks Document Quick Tip

As you begin working, Quick Tips displays a box, shown in Figure 1.4, at the lower-right corner of
the Graphics Window that offers context-sensitive help messages. As you work with the software,
these messages change to remain relevant to what you are doing.

You can turn Quick Tips on or off using the small square on the Status Bar in the lower-right cor-
ner, as shown in Figure 1.5. You can turn the Status Bar itself on or off in the View menu; how-
ever, the Status Bar serves many useful purposes, even for advanced users, so I recommend you
leave it turned on. You can also turn off Quick Tips in the Help menu by selecting Quick Tips. The
on/off setting is document-type sensitive, so if you turned Quick Tips off in part mode, you will
need to do it again for assemblies and drawings, as well. Quick Tips are a great way to get going or
to get a little refresher if it has been a while or several versions have gone by since you last saw the
software, but you shouldn’t need them forever.
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FIGURE 1.4

The main Quick Tip window

FIGURE 1.5

Turning Quick Tips on or off

The first time you create a document, you will be prompted to select units for your default tem-
plates, as shown in Figure 1.6. This is an important step, although you can make changes later if
needed. SolidWorks stores most of the document-specific settings in document templates, which
you can set up with different settings for each type of document — parts, assemblies, and draw-
ings. More information on part and assembly templates can be found later in this chapter. Drawing
Templates are described in detail in Chapter 20.

The main significance of this default template unit option is not so much the units as the dimen-
sioning standard that is selected. ISO (International Organization for Standardization) and ANSI
(American National Standards Institute) standards use different methods of projecting views. I1SO
is typically a European standard and uses First Angle Projection, while ANSI is an American stan-
dard and uses Third Angle Projection. The standard projection used throughout this book is Third
Angle.
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Default template units selection

The difference between Third and First angle projections can cause parts to be manufactured
incorrectly if those reading the prints (or making the prints) do not catch the difference or see that
there is some discrepancy. Figure 1.7 demonstrates the difference between the two projection
types. Make sure to get the option correct. If someone else, such a computer specialist who is not
familiar with mechanical drafting standards, initially sets up SolidWorks on your computer, you
will want to verify that the default templates are correct.

FIGURE 1.7

Differences between First (left) and Third (right) angle projections

Notice that the icons in the View Orientation drop down are arranged in a Third Angle projection
fashion. This might be confusing for people accustomed to using First Angle.

Another setting affecting projections that you will want to check is found at Tools= Options,
Display/Selection®> Projection type for four view viewport. This does not follow the dimensioning
standard selected for the default templates or the country in which the software is installed.
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Online documentation

Several types of online documentation are available to help SolidWorks learners along their path. A
great place to start is with the SolidWorks Resources tab of the Task Pane (on the right side of the
screen). This is the first tab in the list with the Home icon. The Getting Started section of the
SolidWorks Resources tab is shown in Figure 1.8.

FIGURE 1.8

Getting Started on the SolidWorks Resources tab of the Task Manager

Tutorials

Following the link in the Help menu to the Online Tutorials leads you to a list of tutorials on
subjects from sheet metal to macros, in parts assemblies, and drawings. These tutorials are certainly
worth your time, and will build your skills and knowledge of basic functionality. This SolidWorks
Bible distinguishes itself by going into far more detail and depth about each function, adding
information such as best practice, performance considerations, and cautionary data, and acting as a
thorough desk reference. The purpose of this book is not really to duplicate all of the resources for
beginners, but to take the information into far more depth and detail, and answer the “why”
questions instead of just the “how” questions.

What's New

With every release, SolidWorks publishes a What's New document to help you keep up to speed
with the changes. This is typically a PDF file with accompanying example files. If you have missed a
version or two, reading through the What's New files can help get you back on track. Again, don’t
expect a lot of detail or interface screen shots, but it should at least introduce the basic changes.

Moving from AutoCAD

In the Help menu is a selection called Moving from AutoCAD. This is intended to help
transitioning users acclimate to their new surroundings. Terminology is a big part of the equation
when making this switch, and figures prominently in the Moving from AutoCAD help file.

Likely the most helpful tools in Moving from AutoCAD are the Approach to Modeling and
Imported AutoCAD Data sections. This information is useful whether you are coming to
SolidWorks from AutoCAD or another CAD package.



Introducing SolidWorks _

Online User’s Guide

The Online User’s Guide is the traditional Help file. You can use either the Index or Search
capabilities to find what you are looking for. The Online User’s Guide contains screen captures and
animations, sample files, and even a separate API (programming) help file. Frankly, it is not
incredibly detailed, and often skips over important facts like what you might use a certain function
for, or what the interface looks like, or even where you might find the command in the first place.
The SolidWorks documentation is set to get some upgrades, so it remains to be seen if this is really
an improvement or not. Meanwhile, this SolidWorks Bible fills in most of the gaps in information
about the standard version of the software.

Tip of the Day

SolidWorks Tip of the Day is displayed at the bottom of the SolidWorks Resources tab of the Task
Pane. Cycling though a few of these or using them to quiz coworkers can be a useful skills-building
exercise.

Hardcopy documentation

Hardcopy documentation has regrettably dwindled from all software companies. Software manu-
facturers often claim that keeping up with the changes in print is too much work and inefficient.
Still many users prefer to have a physical book in their hands, to spread out on the desk next to
them; to earmark, highlight, and mark with post-its; and take notes in, as evidenced by you hold-
ing this book at this moment. Hardcopy documentation has an important role to play in the dis-
semination of information, even in a highly dynamic electronic age. The following items are still
provided in hardcopy format.

B The Quick Start pamphlet acts as a rough outline for issues from installation to getting
help. It is approximately ten pages and contains information that complete new users
need to know.

B The Quick Reference Guide is a fold-out card that has reminders of some of the symbols
displayed in the FeatureManager and other locations, as well as some of the default hot-
keys and customization options.

Identifying SolidWorks Documents

SolidWorks has three main data type files. However, there are additional supporting types that
you may want to know if you are concerned with customization and creating implementation
standards. Table 1.1 outlines the document types.
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TABLE 1.1

Design Documents

.SLDASM
.SLDDRW
.SLDPRT

Templates and Formats

.asmdot.
.asmprp
.drwdot
.drwprp
journal.doc
.prtdot
.prtprp
.sldbombt
sldtbt
.slddrt
.sldholtbt
.sldrevtbt
.sldwldtbt
Xls

Library Files
.sldblk
sldifp

Styles

.sldgtolfvt
.sldsffvt
.sldweldfvt

Symbol Files

gtol.sym

swlines.lin
Others
.btl

calloutformat.txt

10

Document types

Description

SolidWorks Assembly File Type
SolidWorks Drawing File Type
SolidWorks Part File Type

Description

Assembly Template

Assembly custom properties tab template
Drawing Template

Drawing custom properties tab template
Design Journal Template

Part Template

Part custom properties tab template
BOM Template (table-based)

General Table Template

Drawing Sheet Format

Hole Table Template

Revision Table Template

Weldment Cutlist Template

BOM Template (Excel-based)

Description

Blocks
Library Part File

Description

Geometric Tolerance Style
Surface Finish Style
Weld Style

Description

Symbol file allows you to create custom symbols

Line Style definition file allows you to create new line styles

Description

Sheet Metal Bend Table

Hole Callout Format File
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Others Description

.sldclr Color Palette File

.sldreg SolidWorks Settings File

.sldmat Material Database

.sldstd Drafting standard

.swb, swp Macros, Macro Features

.txt Custom Property File, Sheet Metal Bend Line Note File
xls Sheet Metal Gauge Table

Saving your setup

If you have taken time to set up a computer and then need to reinstall SolidWorks, move to
another computer, or duplicate the setup for another user, you need to copy out the files you have
used or customized. All these files are located by default in different folders within the SolidWorks
installation directory. Chapter 2 deals with interface settings and creating a registry settings file to
copy to other computers or use as a backup, but that does not address also copying the files of var-
ious types that also comprise an installation customization.

BEST PRACTLOL Especially when you are doing complex implementations that include templates for

DIyl FaAC. various types of tables or customized symbol files, it is important to have copies of
these files in a location other than the default installation folder. Uninstalling SolidWorks or
installing a new version will wipe out all of your hard work. Use the Tools=> Options = File loca-
tions to locate these files in separate library folders that can be on the local hard drive or on a
network location.

Templates

[ have included some of my part and assembly templates on the CD-ROM for you. Copy these files
to the location specified at Tools® Options= File Locations = Document Templates.

When you begin to create a new document, and the New SolidWorks Document dialog box gives
you the option to select one of several files to start from, those files are templates. Think of tem-
plates as “start parts” that contain all of the document-specific settings for a part (Tools=
Options= Document Properties). The same concept applies to assemblies and drawings.
Templates generally do not have any geometry in them (although it is possible).

TR The Novice interface for the File, New SolidWorks Document dialog box only allows
you to select default templates. The Advanced interface allows you to select any
available template.

As shown in Figure 1.9, several tabs can be displayed on the advanced interface. Each of these tabs
is created by creating a folder in the template directory specified in Tool=> Options.

11
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FIGURE 1.9

The Novice and Advanced interfaces for the New SolidWorks Document dialog

Using multiple document templates
Using multiple templates enables you to start working from multiple starting points, which is an

advantage in many situations such as:

Standardization for a large number of users

Working in various units

Preset materials

Preset custom properties

Parts with special requirements, such as sheet metal or weldments

Drawings of various sizes with formats (borders) already applied

Drawings with special notes already on the sheet

12
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O e Drawing templates and formats are complex enough that I cover them in a separate

—iiUyyminrr chapter. Chapter 20 Automating Drawings — The Basics discusses the differences
between templates and formats and how to use them to your best advantage. This chapter
addresses part and assembly templates.

Depending on your needs, it might be reasonable to have templates for metric and inch part and
assembly, templates for steel and aluminum, and templates for sheet metal parts and for weld-
ments, if you design these types of parts. If your firm has different customers with different
requirements, you might consider using separate templates for those customers. Over time, you
will discover the types of templates you need, because you will find yourself making the same
changes over and over again.

To create a template, open a document of the appropriate type (part or assembly), and make the
settings you wish the template to have; for example, units are one of the most common reasons to
make a separate template, but in fact any of the Document Property settings is fair game for a tem-
plate, from the dimensioning standard used to image quality settings.

Document Property settings are covered extensively in Appendix B.

~

or ~ r)rr
CRROSS-EF

Some document specific settings are not contained in the Document Properties dialog box. Still,
these settings are saved with the template. Settings that fall into this category are the View menu
entity type visibility options and the Tools=> Sketch Settings options.

Custom Properties are another piece of the template puzzle. If you use or plan to use BOMs (bills
of materials), PDM (product data management), or linked notes on drawings, you need to take
advantage of the automation options available with custom properties. Setting up custom proper-
ties is covered in detail in Chapter 20.

Also, the names of the standard planes are template specific. For example, the standard planes may
be named Front, Top, and Side; or XY, XZ, and ZY; or Planel, Plane2, and Plane3; or North, Plan,
and East; or Elevation, Plan, and Side for different uses.

Locating templates

The templates folder is established at Tools®> Options= File Locations= Document Templates.
This location may be a local directory or a shared network location. Multiple folders may be speci-
fied in the list box, each of which corresponds to a tab in the New Document’s Advanced interface.

Once all of the Document Properties, custom properties, and other settings are set to your liking
and you are ready to save the file as a template, click Files> Save As and in Files of Type, select
Part Templates. SolidWorks prompts you to save the template in the first folder listed in the File
Locations list. You can create assembly templates in the same way, but changing the settings for an
assembly document.

You can also create additional tabs on the New SolidWorks Document dialog box can also be cre-
ated by making subfolders in the main folder specified in the File Locations area. For example, if
your File Locations list for Document Templates looks like Figure 1.10, then your New dialog will
look like Figure 1.11.

13
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FIGURE 1.10

Tools=> Options= File Locations list

FIGURE 1.11

New SolidWorks Document dialog box

Adding subfolders to either of the locations listed in File Locations results in additional tabs in the
New dialog, as shown in Figures 1.12 and 1.13.

FIGURE 1.12

Additional subfolders added to a File Locations path

FIGURE 1.13

Resulting tabs in New SolidWorks Document dialog box

14
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Default templates

Default templates are established at Tools®> Options® Default Templates. The default templates
must be in one of the paths specified in File Locations. Figure 1.14 shows the Default Templates
settings.

FIGURE 1.14

Tools= Options = Default Templates settings

The Default Template option, Always use these default document templates Prompt user to select
document template, applies to situations when a template is required by an automatic feature in
the software such as an imported part, or a mirrored part. In this situation, depending on the set-
ting selected, the system either automatically uses the default template or the user is prompted to
select a template.

- Allowing the software to apply the default template automatically can have a great
- impact on speed. This is especially true in the case of imported assemblies, which
would require you to manually select templates for each imported part in the assembly if the
Prompt user... option is used.

PERFORMANC

Sharing templates

If you are administering an installation of a large number of users, or even if there are just a couple
of users working on similar designs, shared templates are a must. If every user is doing what she
thinks best, you may get an interesting combination of conflicting ideas, and the consistency of the
company’s documentation may suffer. Standardized templates cannot make users model, assemble,
and detail in exactly the same way, but they do start users off on the same foot.

To share templates among several users, create a folder for templates on a commonly accessible
network location, preferably with read-only access for users and read-write permissions for admin-
istrators. Then point each user’s File Locations and Default templates to that location. Access prob-
lems due to multiple users accessing the same files do not arise in this situation because templates
are essentially copied to create a new document, not used directly.

15
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( One of the downfalls of this arrangement is that if the network goes down, users no
longer have access to their templates. This can be averted by also putting copies of
the templates on the local computers; however, it has the tendency to undermine the goal of
consistent documentation. Users may tend to use and customize the local templates rather than
use the standardized network copies.

CAD administration and organizing any group of people on some level always comes down to
trusting employees to do the right thing. There is no way to completely secure any system
against all people trying to work around the system, so you must rely on having hired people you
can train and trust.

Understanding Feature-Based Modeling

There is some terminology that you need to come to grips with before diving into building models
with SolidWorks. Notice that I talk about “modeling” rather than “drawing,” or even “design.” This
is because SolidWorks is really virtual prototyping software. Whether you are building an assembly
line for automotive parts or designing decorative perfume bottles, SolidWorks can help you visual-
ize your geometrical production data in the most realistic way possible without actually having it
in your hand. This is more akin to making a physical model in the shop than drawing on paper.

“Feature-based” modeling means that you build the model by incrementally identifying functional
shapes, and applying processes to create the shapes. For example, you can create a simple box by
using the Extrude process, and you can create a sphere by using the Revolve process. However,
you can make a cylinder by using either process, by revolving a rectangle or extruding a circle. You
start by visualizing the 3D shape, and then apply a 3D process to a 2D sketch to create that shape.
This concept on its own is half of what you need to know to create models with SolidWorks.

Figure 1.15 shows images of simple feature types with the 2D sketches from which they were created.

Many different feature types in SolidWorks enable you to create everything from the simplest
geometry shown previously to more complex artistic or organic shapes. In general, when I talk
about modeling in this book, I am talking about solid modeling, although SolidWorks also has a
complete complement of surfacing tools. I will discuss the distinction between solid and surface
modeling in Chapter 27.

Table 1.2 lists some of the most common features that you find in SolidWorks, and classifies them

according to whether they always require a sketch, a sketch is optional, or they never require a
sketch.
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Simple extruded and revolved features

TABLE 1.2

Feature Types
Sketch Required Sketch Optional No Sketch (Applied Features)
Extrude Loft Fillet
Revolve Sweep Chamfer
Rib Dome Draft
Hole Wizard Shape Shell
Wrap Deform Flex

In addition to these features, there are other types of features that create reference geometry (such
as curves, planes, and axes, surface features (covered in Chapter 27), and specialty features for
techniques like weldments (Chapter 31), plastics/mold tools (Chapter 32), and sheet metal
(Chapters 29 & 30).

17
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Understanding History-Based Modeling

In addition to being feature-based, SolidWorks is also history-based. To show the process history,
there is a panel to the left side of the SolidWorks window called the FeatureManager. The
FeatureManager keeps a list of the features in the order in which you have added them. It also
enables you to reorder items in the tree (in effect, to change history). Because of this, the order in
which you perform operations is important. For example, consider Figure 1.16. This model was
created by the following process, left to right starting with the top row:

Create a sketch.

Extrude the sketch.

Create a second sketch.
Extrude the second sketch.
Create a third sketch.
Extrude Cut the third sketch.
Apply fillets.

Shell the model.

S NS wm kWS

1f the order of operations used in the previous part were slightly reordered (by putting the shell
and fillet features before Step 6), the resulting part would also look slightly different, as shown in
Figure 1.17.

Figure 1.18 shows a comparison of the FeatureManager design trees for the two different feature
orders. You can reorder features by dragging them up or down the tree. Relationships between fea-
tures can prevent reordering; for example, the fillets are dependent on the second extruded feature,
and cannot be reordered before it. This is referred to as a Parent/Child relationship.

Reordering and Parent/Child relationships are discussed in more detail in Chapter
11, Editing and Evaluation.

The part used for this example is available in the material from the CD-ROM, named
Chapter 1 — Features.SLDPRT. Parts on the CD-ROM exist for both 2007 and 2009
versions.

The order of operations, or history, is important to the final state of the part. For example, if you
change the order so that the shell comes before the extruded cut, the geometry of the model
changes, removing the sleeve inside instead of the hole on top. You can try this for yourself by
opening the part indicated previously, dragging the Shelll feature in the FeatureManager, and
dropping it just above the Cut-Extrudel feature.

L ICSTE You can only drag one item at a time in the FeatureManager. So you may drag the

Shell, and then drag each of two fillets, or you could just drag the Cut feature down
the tree. Alternatively, you can put the shell and fillets in a folder and drag the folder to a new
location.

Reordering is limited by parent-child relationships between dependent features.
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Features used to create a simple part
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FIGURE 1.17

Using a different order of features for the same part

FIGURE 1.18

Compare the FeatureManager design trees for the parts shown in Figure 1.16 and Figure 1.17.

CrosS
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You can read more about reordering folders in Chapter 11, Editing and Evaluations.
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In some cases, reordering the features in the FeatureManager may result in geometry that might
not make any sense; for example, if the fillets are applied after the shell, they might break through
to the inside of the part. In these cases, SolidWorks gives an error that helps you to fix the problem.

In 2D CAD programs where you are just drawing lines, the order in which you draw the lines does
not matter. This is one of the fundamental differences between history-based modeling and non-
history-based drawing.
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Features are really just like steps in building a part; the steps can either add material or remove it.
However, when you make a part on a mill or lathe, you are only removing material. The
FeatureManager is like an instruction sheet to build the part. When you reorder and revise history,
you change the order of operations and thus the final result.

Sketching with Parametrics

You have already seen that sketching is the foundation that underlies the most common feature
types. You will now find that sketching in parametric software is vastly different from drawing
lines in 2D CAD.

Dictionary.com defines the word parameter as “one of a set of measurable factors . . . that define a
system and determine its behavior and [that] are varied in an experiment.” SolidWorks sketches
are parametric. What this means to you as a SolidWorks user in a practical sense is that you can
create sketches that change according to certain rules, and maintain relationships through those
changes. This is the basis of parametric design. It extends beyond sketching to all of the types of
geometry you can create in SolidWorks.

In addition to 2D sketching, SolidWorks also makes 3D sketching possible. Of the two methods,
2D sketches are by far the more widely used. You create 2D sketches on a selected plane, planar
solid, or surface face, and use them to establish shapes for features such as Extrude, Revolve, and
others. Relations in 2D sketches are often created between sketch entities and other entities that
may or may not be in the sketch plane. In situations where other entities are not in the sketch
plane, the out-of-plane entity is projected into the sketch plane in a direction that is normal to the
sketch plane. This does not happen for 3D sketches.

You use 3D sketches for the Hole Wizard, routing, and weldments, among other applications such
as complex shape creation.

For more information on 3D sketching, please refer to Chapter 31.

~
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For a simple example of working with sketch relations in a 2D sketch, consider the sketch that is
shown in Figure 1.19. The only relationships between the four lines are that they form a closed
loop that is touching end to end, and one of the corners is coincident to the part origin. The small
square icon near the origin shows the symbol for a coincident sketch relation. The setting to enable
or disable these sketch relation symbols is found at View 5> Sketch Relations.

If you drag any of the unconstrained corners (except for the corner that is coincident to the origin),
the two neighboring lines will follow the dragged endpoint, as shown in Figure 1.20. Notice the
ghosted image left by the original position of the sketch. This is helpful when experimenting with
changes to the sketch because you can see both the new and the old states of the sketch. The set-
ting to enable or disable this ghosted position is found at Tools= Options = Sketch = Ghost Image
On Drag.

21
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FIGURE 1.19

A sketch of four lines

FIGURE 1.20

Dragging an endpoint

If you add a parallel relation between opposing lines, they now act differently, as shown in Figure
1.21. A parallel relation is added by selecting the two lines to be made parallel and selecting
Parallel from the PropertyManager panel. You can also select the Parallel relation from the context
bar that pops up in the graphics window when you have both lines selected.

You can read more about the PropertyManager in Chapter 2, Navigating the

~oe)SoLER
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FIGURE 1.21

Dragging an endpoint where lines have relations

Next, a second parallel and a horizontal relation are added, as shown in Figure 1.22. If you are fol-
lowing along by re-creating the sketch on your computer, you will notice that one line has turned
from blue to black.

22
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Horizontal and parallel relations are added.

The colors represent sketch states. It may be impossible to see this in the black and white printing
of this book, but if you are following along on your own computer, you can now see one black line
and three blue lines. Sketch states include Underdefined, Overdefined, Fully Defined, Unsolvable,
Zero Length, and Dangling.

B Blue: Underdefined. The sketch entity is not completely defined. You can drag a portion
of it to change size, position, or orientation.

B Red: Overdefined. This can mean a number of things, but it is usually caused by con-
flicting relations or dimensions. For example, if a line has both horizontal and vertical
relations, it becomes overdefined because one of the relations is satisfied, while the other
is not.

B Black: Fully Defined. The sketch entity is fully defined by a combination of sketch rela-
tions and dimensions. A sketch cannot be fully defined without being connected in some
way to something external to the sketch, such as the part origin or an edge. Multiple
external entities may be used, as appropriate. (The exception to this rule is the use of the
Fix constraint, which, although effective, is not a recommended practice.)

B Pink: Unsolvable. The difference between pink and red is that red conflicts with another
relation but is in a potentially correct location, whereas pink conflicts with another rela-
tion, but is not able to move to a correct location, generally because of another red entity.

B Yellow: Zero Length. Solving the sketch relations would result in a zero-length entity;
for example, this can occur where an arc is tangent to a line, and the centerpoint of the
arc is also coincident to the line.

B Brown: Dangling. The relation has lost track of the entity to which it was connected.

There can be entities with different states within a single sketch. Also, endpoints of lines can have a
different state than the rest of the sketched entity. For example, a line that is sketched horizontally
from the origin has a coincident at one endpoint to the origin, and the line itself is horizontal. As a
result, the line and first endpoint are black, but the other endpoint is underdefined because the
length of the line is not defined. Sketch states are indicated in the lower-right corner of the graph-
ics window and also in the status bar. You can see that dragging one corner allows only the lines to
move in certain ways, as shown in Figure 1.23.

23
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FIGURE 1.23

Sketch motion is becoming more constrained.

In addition to sketch relations. dimensions applied using the Smart Dimension tool are also part of
the parametric scheme. If you apply an angle dimension (by clicking the two angled lines with the
Smart Dimension tool) about the origin and try dragging again, as shown in Figure 1.24, you see
that the only aspect that is not locked down is the length of the sides. Notice also that when the
angle dimension is added, another line turns black.

FIGURE 1.24

Open degrees of freedom can be dragged.

Finally, adding length dimensions for the unequal sides completes the definition of the sketch, as
shown in Figure 1.25. At this point, all lines have turned black. This is the state that we call “fully
defined.” Between the dimensions and sketch relations, there is enough information to re-create
this sketch exactly.

Itis considered best practice to fully define all sketches. However, there are times
when this is not practical. When you create freeform shapes, generally through the
use of splines, these shapes cannot easily be fully defined, and even if they are fully defined, the
extra dimensions are usually meaningless, because it is impractical to dimension splines on man-
ufacturing drawings.

VN ashiNe

BEST PRACTLCE

It is the idea of reacting to change that is of most concern regarding parametric sketching. There
are other factors that can also drive the sketch, such as equations, other model geometry that is
external to the sketch, and even geometry from another part in an assembly, as you shall see later.

24
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The fully defined sketch cannot be dragged, and there are no degrees of freedom.

Understanding Design Intent

“Design Intent” is a phrase that you will hear SolidWorks users use a lot. I like to think of it as
“design for change.” Design Intent means that when you put the parametric sketch relations
together with the feature intelligence, you can build models that react to change in predictable
ways.

An example of Design Intent could be a statement in words that describes general aspects that help
define the design of a part, such as “This part is symmetrical, with holes that line up with Part A,
and thick enough to be flush with Part B.” From this description, and the surrounding parts, it is
possible to re-create the part in such a way that if Part A or Part B changes, the part being
described updates to match.

Some types of changes can cause features to fail or sketch relations to conflict. In most situations,
SolidWorks has ample tools for troubleshooting and editing that allow you to either repair or
change the model. In these situations, it is often the Design Intent itself that is changing.

BEST DR ATk When editing or repairing relations, it is considered best practice to edit rather than
DIy FaAc.z delete. Deleting often causes additional problems further down the tree. Many
users find it tempting to simply delete anything that has an error on it.

Editing Design Intent

Design Intent is sometimes thought of as a static concept that controls changing geometry.
However, this is not always the way things are. Design Intent itself often changes, thus requiring
the way in which the model reacts to geometric changes to also change. Fortunately, SolidWorks
has many tools to help you deal with situations like this.

25
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View, Sketch Relations

To see the sketch relations is one of the most obvious tools necessary for visualizing existing
Design Intent. You can show or hide icons that represent the relations using the menu selection
View, Sketch Relations. When shown, these relations appear as a small icon in a small colored box
in the graphics area next to the sketch entity. Clicking on the icon highlights the sketch elements
involved in that relation. Refer to Figures 1.19 through 1.25 for examples of these relations.

—_” P View, Sketch Relations is an excellent candidate for use with a hotkey, thus

cro
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allowing you to easily toggle the display on and off.

For more information on creating and managing hotkeys, see Chapter 2, Navigating
the SolidWorks Interface.

~eo e
Du-ILET

You can use the sketch relation icons that are visible on the screen to delete relations by selecting
the icon and pressing Delete on the keyboard. You can also use them to quickly tell the status of
sketch relations by referring to the colors defined earlier.

Display/Delete Relations

You can find the Display/Delete Relations tool on the Sketch toolbar or by selecting a sketch entity
in an open sketch. The sketch status colors that were defined earlier also apply here, with the rela-
tions appearing in the appropriate color. (Relations are not shown in blue or black, only the colors
that show errors, such as red, yellow, pink, and brown.) This tool also allows you to group rela-
tions by several categories:

All in This Sketch

Dangling

Overdefining/Not Solved

External

Defined in Context

Locked

Broken

Selected Entities

In the lower Entities panel, you can also replace one entity with another, or repair dangling
relations.

You can read more about repairing dangling entities in Chapter 11.
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Suppressed sketch relations

Suppressing a sketch relation means that the relation is turned off and not used to compute the posi-
tion of sketch entities. Suppressed relations are generally used in conjunction with configurations.
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CROSSPER Configurations are dealt with in detail in Chapter 10.

Working with Associativity

Associativity in SolidWorks refers to links between documents, such as a part that has an associa-
tive link to a drawing. If the part changes, the drawing updates as well. Bi-directional associativity
means that the part can actually be changed from the drawing. One of the implications of this is
that you do not edit a SolidWorks drawing by simply moving lines on the drawing; you must
change the model, which causes all views of the part or assembly to update correctly.

Other associative links include using base parts, where one part is inserted as the first feature in
another part. This might be the case when you build a casting. If the part is designed in its “as cast”
state, it is then inserted into another part where machining operations are performed by cut fea-
tures and the part is transformed into its “as machined” state. This technique is also used for plastic
parts where a single shape spans multiple plastic pieces. A “master part” is created and split into
multiple parts that could, for example, become a mouse cover and buttons.

One of the most important aspects of associativity is file management. Associated files are kept
connected by filenames. If a document name is changed, and one of the associated files does not
know about the change, then the association between the files can become broken. For this reason,
you should use SolidWorks Explorer to change names of associated files. There are other tech-
niques that work, as well as some techniques that you should avoid.

e~k o, ~- ~- Itis considered poor practice to change filenames, locations or changing the name

BEST PRalTICE of a folder in the path of documents that are referenced by other documents with
Windows Explorer. Links between parts, assemblies, and drawings can be broken in this way.
Using SolidWorks Explorer or a Product Data Management, or PDM, application is the preferred
method for changing filenames.

Refer to Appendix A, Implementing SolidWorks, for more detailed suggestions for
file management techniques.

Tutorial: Creating a Part Template

This simple tutorial steps you through making a few standard part templates for use with inch and
millimeter parts and some templates for a couple of materials, as well.

1. Select from the menu Tools, Options = System Options = File Locations, and select
Document Templates from the Show folder for list.

2. Click the Add button to add a new path to a location outside of the SolidWorks
installation directory; for example, D:\Library\Templates.

3. Click OK to dismiss the dialog and accept the settings.
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Select File®> New from the menu.

Create a new Part document, selecting any template if using the Advanced interface.
Select from the menu Tools = Options = Document Properties = Detailing.

Make sure the ANSI standard is selected.

Change to the Units page.

Change the unit system to IPS, inches, with 3 decimal places, using millimeters as
the dual units, with 2 decimal places. Set angular units to Degrees with 1 decimal
place.

Change to the Grid/Snap page.
Turn off Display grid.
Change to the Image Quality page.

Move the slider 2/3 of the way to the right, so it is closer to High. Make sure the Save
tessellation with part document option is on.

Click OK to save the settings and exit the Tools, Options dialog.

RMB (right mouse button) on the Materials entry in the FeatureManager, and select
1060 Alloy from the list.

From the menu select File=> Properties, and click the Custom tab.

Add a property called material of type Text. In the Value / Text Expression column,
click the down arrow and select Material from the list. Notice that the Evaluated Value
shows 1060 Alloy.

Add another property called description and give it a default value of Description.
At this point, the window should look like Figure 1.26.

FIGURE 1.26

Setting up Custom Properties

Click OK to close the Summary Information window.

Change the names of the standard planes by clicking them twice slowly or clicking
once and pressing F2. Rename them to Front, Top, and Side, respectively.
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Ctrl-select the three planes from the FeatureManager, RMB and select Show.
From the View menu, make sure that Planes is selected.

RMB on the Front plane and select Insert Sketch.

Select the Line tool and click and drag anywhere to draw a line.

Select the Smart Dimension tool and click on the line, then click in space
in the Graphics Window to place the dimension. If you are prompted for a dimen-
sion value, press 1 and click the checkmark, as shown in Figure 1.27.

FIGURE 1.27

Drawing a line and applying a dimension

Press Esc to exit the Dimension tool and RMB on the displayed dimension and
select Link Value.

Type thickness in the Name box, and click OK.
Press Ctrl+B (rebuild) to exit the sketch, select the sketch from the

FeatureManager, and press Delete on the keyboard.

This exercise of creating the sketch and deleting it was done only to get the link
value “thickness” entered into the template. Once this is done, every part made

from this template that uses an Extrude feature will have an option box for Link to Thickness,
which allows you to automatically establish a thickness variable for each part you create. This is
typically a sheet metal part feature, but it can be used in all types of parts.

29.

30.

31.
32,

Click Filew Save As and then select Part Template from the drop-down list. Ensure
it is going into your template folder by giving it an appropriate name and clicking Save.

Edit the material applied to change it from 1060 Alloy to Plain Carbon Steel, and
save as another template with a different name.

Change the primary units to millimeters with 2 places, and save as a third template file.

Exit the file.
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Summary

Product development is about design, but it is even more about change. You actually design
something once, but you may modify it endlessly (or it may seem that way sometimes). Similarly,
SolidWorks is about design, but it really enables change. Think of SolidWorks as virtual
prototyping software that allows you to change your prototype rather than having to make a new
one. Virtual prototypes will never completely replace physical models, but they may reduce your
dependence on them to some extent.

SolidWorks is also about reusing data. Associativity allows you to model a part once and use it for
Finite Element Analysis (FEA), creating 2D drawings, building assemblies, creating photorealistic
renderings, and so on. When you make changes to the model, your drawing is automatically
updated, and you don’t have to reapply FEA materials and conditions or redo the rendering setup.
Associativity saves you time by reusing your data. Associativity and change driven by feature-based
and history-based modeling can take some getting used to if you have had limited exposure to it,
but with some practice, it becomes intuitive and you will see the many benefits for enabling
change. Parametric sketching and feature creation help you to maintain Design Intent and also
adjust it as necessary.



Navigating the SolidWorks

Interface

n this chapter, you learn how to effectively identify, use, and customize

the various aspects of the SolidWorks 2009 interface. In the 2008

release, Solidworks made some drastic changes to the interface. If you
are familiar with older versions of the software, you may want to take a
moment to acquaint yourself with some of the changes.

The interface changes in 2009 intend primarily to clean up the work area.
With each release, the software provides more features and functions, and
the previous interface scheme could not accommodate the space required for
all these functions. The new interface scheme attempts to put the tools you
need where you need them, when you need them.

Some of the changes are controversial, so in this chapter I present options for
people who like to work differently from the way assumed by the new
changes.

Settings control many aspects of the SolidWorks interface. These settings are
covered in detail in Appendix B. Each interface element that is identified in
Figure 2.1 is explained in greater detail in its own section of this chapter.

Once you have mastered the various interface elements and customized your
SolidWorks installation, working with the software becomes much more effi-
cient and satisfying. You may find that you can only master the interface
with a lot of experience. The interface is complex, and can be daunting.
Many existing users may find aspects of it in this book that they were not
aware of even though they have been to training and used the software for
years.
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FIGURE 2.1

Elements of the SolidWorks interface

FeatureManager filter ~CommandManager toolbar area
CommandManager tabs

Configuration Mgr
and TolAnalyst tabs

Flyout for Menu Bar menus

Menu Bar toolbar
Heads-up View toolbar

SolidWorks Search

View Indicator Status Bar

MotionManager Part Origin

FeatureManager Shortcut “S” toolbar
Rollback bar Coordinate Triad  PropertyManager
(detached)
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Display Pane Expander

Context toolbar

Task Pane buttons

Toolbar Expander

Right-Mouse Button menu

Toolbar
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Identifying Elements of the
SolidWorks Interface

The major elements of the SolidWorks interface are the graphics window, where all of the action
takes place, the FeatureManager, which is the list of all the features in the part, the PropertyManager,
where most of the data input happens, and the CommandManager/Toolbars, where you access most
of the commands in the software. Of these, I cover the CommandManager/Toolbars first.

Using the CommandManager and toolbars

The CommandManager has been a controversial element of the interface since its introduction
several releases ago, and especially since it was drastically revamped in SolidWorks 2008.
SolidWorks has chosen to use the most radical options possible for the default install, so many
users are turned off by its unwieldy initial appearance. If you are using SolidWorks 2009, I ask
that you give the CommandManager a chance, because it saves interface space, groups related
commands, and offers many customization options.

The changes to the CommandManager in the 2008 release are half completed. In my opinion, the
changes started in 2008 do not make much sense until they are finished in 2009. If you use either
the 2009 or 2007 interface first and then try to use 2008, this becomes obvious.

The CommandManager resembles in some respects the Microsoft (MS) Ribbon interface found in
Office 2007 applications. SolidWorks did not do a strict implementation of the MS Ribbon,
because SolidWorks wanted to add more customizability. A far more complete array of interface
configuration possibilities await you with SolidWorks 2009. In this section of the chapter I will
show you how to make the 2009 CommandManager work for you, or how to use regular or flyout
toolbars to effectively replace it.

CommandManager

The CommandManager is an area of the interface that you can use to save space traditionally used
by toolbars. The main mission of the CommandManager is to enable you to have easy access to all
toolbars, and even access to customized groups of icons not available on a single default toolbar,
without cluttering the entire screen with toolbars.

The CommandManager accomplishes this by using small tabs under the left end of the toolbar
area to allow you to switch the toolbar that appears. Figure 2.2 shows the CommandManager in
customize mode, showing all of the tabs available in a default setup. To get the CommandManager
into customize mode, right-click on one of the Command Manager tabs and select Customize
CommandManager. Alternatively, you can select Tools=> Customize through the pull-down menus.
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FIGURE 2.2

HOUTE

To access the pull-down menus in a default setup, place the cursor over the
SolidWorks logo or the small flyout triangle to the right of it in the upper-left corner
of the SolidWorks window. Figure 2.1 shows the flyout for pull-down menus. To keep the menu
in that position, click on the push pin on the right end of the flyout menu bar.

Customizing the CommandManager

FIGURE 2.3

Customizing the CommandManager

Notice the last tab along the bottom of the CommandManager on the right. If you wanted to add a
custom tab, you would just right-click this tab and select the toolbar you want to add. You can also
select to add a blank tab and populate it with individual buttons. Figure 2.3 shows a detail of the
menu options after right-clicking on the tab.

Adding tabs to the CommandManager

34

To add individual buttons, first find the button you want to add in the Tools, Customize dialog, in
the Commands tab, then switch the CommandManager to the tab you want to add the button to,
and drag the button from the Customize dialog to the CommandManager. You can remove buttons
from the CommandManager by dragging them into the blank graphics window area.

Docking the CommandManager

In SolidWorks 2009, you can undock the CommandManager and leave it undocked, pull it to a
second monitor, or dock it vertically to the left or right. To undock it, click and drag on any non-
toolbar button area of the CommandManager, such as around the border. To re-dock an undocked
CommandManager or to change its docking location, drag it onto one of the docking stations
around the screen. Figure 2.4 shows the CommandManager undocked.
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The undocked CommandManager

The small box with the arrows in it in the upper right hand corner of the undocked CommandManager
is the Auto Collapse option. In the condition it is shown, the undocked CommandManager will
not collapse, but if you click it, the arrows go away, and the entire CommandManager acts like a
big fly-out toolbar. This can be very handy because it saves a lot of space on the screen, but at the
same time it requires additional mouse movement to open it up. This is the common trade-off in
this interface — you can trade screen space for additional mouse movement or clicks. This Auto
Collapse option is only available with the undocked CommandManager.

|OTE The PropertyManager is also undockable, and behaves the same way as the
I - CommandManager with the docking stations, Auto Collapse and fly-out behavior.

Mixing CommandManager with toolbars

To put a toolbar inline with the CommandManager, either on the top row or vertically on the left
or right, drag the toolbar to either the right end or the bottom of the CommandManager. A space
on that row or column will open up. The amount of space that opens up depends on tab with the
longest set of icons, even if that tab is not showing. To increase the amount of space available for a
toolbar on the same row as a CommandManager, enter Customize CommandManager mode by
right clicking on a tab and selecting Customize CommandManager. Then cycle through the avail-
able tabs, looking to see which one has the most icons. Remove or rearrange icons from the tab
with the most. This makes more room for toolbars to the right of the CommandManager.

To get the most out of this arrangement, it is best if you turn off the text and the option to use only
icons for large and small buttons. You can turn off the text by clicking the right-mouse button,
selecting CommandManager, and deselecting the Use Large Buttons with Text icon.

35



m SolidWorks Basics

FIGURE 2.5

Tabs and document types

SolidWorks remembers which tabs to show on a per document type basis. This means that

when you are working on a part document, you will have one set of tabs. When you switch to an
assembly document, you will see a different set of tabs. The same goes for drawings. Notice that in
Figure 2.3 you see in the right mouse button menu the options Copy Tab To Assemblies and Copy
Tab To Drawings. This makes it easier to set up customizations that apply for all document types.

Changing the appearance of the CommandManager

For an element of the interface that is supposed to save space, the default settings for the
CommandManager surely take up a lot of it! When many users see the CommandManager for the
first time, they ask how to turn off the text.

You can turn off the text in one of two ways. The easiest way is to right-click in the
CommandManager and deselect Use Large Buttons with Text, as shown in Figure 2.5.

Adding or removing text from the CommandManager buttons

FIGURE 2.6

Another way to remove text from the CommandManager is to remove it only from selected icons.
To do this, first enter the customize mode (Tools = Customize or right-click on a
CommandManager tab and select Customize CommandManager), and then right-click a button in
the CommandManager and change the Show Text setting, as shown in Figure 2.6. The Show Text
option is only available when Use Large Buttons With Text is enabled.

Changing the text setting for individual buttons in the CommandManager
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Notice also that the text by default goes to the right side of the icon, but using the RMB menu you
can put the text beneath the icon. With these options and some patience to go through the entire
interface, you can almost totally customize the appearance and function of your
CommandManager.

The most streamlined and space-efficient way to set up the CommandManager is to turn off the
text. This arrangement is shown in Figure 2.5, in the lower image. Notice that the
CommandManager without text takes up the same amount of height as a normal toolbar, with the
added room for the tabs at the bottom. The text can be useful for new users or features that you do
not commonly use. Also notice that with the text turned off, you have room for more toolbar space
at the end of the CommandManager.

The final setting for the CommandManager appearance is the size of the icons. This is an option that
has changed back and forth from 2007 to 2008 and now again in 2009. With the 2009 release, you
again have control over the size of the icon images in the CommandManager, This setting is found in
the Customize dialog box (Tools=> Customize), and is shown in the upper-right side of Figure 2.7.
The difference between large and small icons is shown in the lower part of the figure.

FIGURE 2.7

Setting large icons

This setting applies to all of the toolbar icons except the Menu Bar and the RMB and Context Bar
icons. The setting does apply to the S shortcut toolbar which I discuss later in this section. Large
icons can be useful on displays with very high resolution, in particular on laptops where the screen
itself may be small but the resolution is very high. All of the screen shots in this book are taken
with the Large Icons option turned on for improved visibility. There is often a small difference
between the appearance of the large and small icons.
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Limitations

The CommandManager in the 2008 release had many limitations, including that it could not be
undocked, and would not allow other toolbars on the same row. The 2009 release fixes these
limitations, but a couple of items still remain.

If you undock the CommandManager, you cannot reorient the tabs horizontally. They remain ver-
tical. Also, you cannot place multiple rows of toolbars on the same row as a CommandManager
using large buttons with text. And you cannot dock the CommandManager to the bottom of the
SolidWorks window. Another minor limitation is that although 2009 allows you to place toolbars
at the right end of the CommandManager, it does not allow you to place them to the left of the
CommandManager like you could in 2007.

These are relatively minor limitations which remain, and they could be resolved between the time
this is printed and the time you read it.

Using toolbars

The point of the CommandManager is to allow you to get away from using regular toolbars, with
the main goal being space savings. Unfortunately, when you save one thing, you usually wind up
giving up something else. In the case of the CommandManager, the thing that you give up is
mouse travel and clicks. You may find yourself clicking frequently back and forth between the
Sketch and Features tabs. For this reason, in my interface setup, I put the Sketch toolbar vertically
on the right, and remove it from the CommandManager. This allows me to see the Sketch and
Features toolbars at the same time, and greatly reduces clicking back and forth between the tabs.

Toolbars may be turned on or off in several ways. To turn them on, right-click in a toolbar area,
and you will be presented with a list of all the toolbars in SolidWorks. You can turn them on or off
from here. Another way to do this is to use the Customize dialog (Tools=> Customize or the
Customize option near the bottom of the RMB toolbar list). Yet another way is through the menus
at View ™ Toolbars.

Heads-up View toolbar

The Heads-up View toolbar is a new interface element in SolidWorks 2008 and is found along the
middle of the top edge of the graphics window. Figure 2.8 shows the default arrangement of the
Heads-up View toolbar, and it is shown in relation to the rest of the interface in Figure 2.1.

FIGURE 2.8

The Heads-up View toolbar

|

This toolbar is limited to only the icons of the View or Standard Views toolbars. You can customize
this toolbar by right-clicking on it and selecting or deselecting the tools you want to have on it.
The only way to turn it off is to remove all of the icons from it. If you have multiple document
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windows or multiple view ports showing, the Heads-up View toolbar will only show in the active
window or view port. This toolbar often overlaps with other interface elements when several win-
dows are tiled or if the active window is not maximized. It can run into the PropertyManager if it is
pulled out of the FeatureManager, as well as the ConfirmationCorner or the Task Pane.

Chapter 3, Working with Sketches, deals with the ConfirmationCorner in more
detail.

e

r rr
CROSS-’FF

Menu Bar Toolbar and Menu

The Menu Bar also has new functions in SolidWorks 2009. The first is the Menu Bar Toolbar. It is
found just to the right of the SolidWorks logo on the title bar of the SolidWorks window. By
default, it contains most of the elements of the Standard toolbar, and it is available even when no
documents are open. It uses mostly flyout toolbar icons, so again it follows the trend of saving
space at the expense of an extra click. This toolbar can be customized in the same way as normal
toolbars in the Customize dialog under the Commands tab. Again, this toolbar cannot be turned
off, but you can remove all of the icons from it.

L ICSTE In the same way that you could run the SolidWorks 2009 interface from just the
‘ - CommandManager without any additional toolbars, you could do the same with
just the Menu Bar Toolbar, customizing it with all flyout toolbars. The main advantages of this
toolbar are that it is visible when no documents are open, and that it makes use of otherwise
wasted space. You might set up the interface for a 12 inch normal aspect display laptop very
differently from that of a desktop unit with a 24 inch wide screen.

There is also a Menu Bar Menu, which is hidden by default. The SolidWorks logo in the upper left
of the SolidWorks window or the small triangle next to the logo serve as a flyout to expand the
main SolidWorks menus. The menus can be pinned in place using the pushpin shown at the right
end of the menus in Figure 2.9. When the menu is pinned, the toolbar moves to the right to
accommodate it.

FIGURE 2.9

The Menu Bar Toolbar and Menu

Notice that on low resolution or non-maximized SolidWorks windows, you can run into some
space problems if the Menu Bar Menu is pinned open. The SolidWorks window in Figure 2.9 is
maximized at 1024 X 768 resolution, which is a common resolution when using digital LCD pro-
jectors or small notebook computers. The changes in the SolidWorks interface need to be exam-
ined with display size in mind. You might consider having different sets of settings for using a
laptop at a docking station with a large monitor, using the laptop with a small monitor, or using
the computer with a low resolution digital projector.
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Flyout toolbar buttons

SolidWorks has implemented flyout toolbars that save space by putting several related icons on a
flyout. For example, the Rectangle tool now has several different ways to make a rectangle, with a
tool for each, and they are all on the rectangle flyout.

You can see all of the available flyouts in the Tools=> Customize menu, on the Commands tab, in
the first listing in the window, Flyouts.

The purpose for flyouts is primarily to save toolbar space when several tools are closely related.
SolidWorks has set up flyouts in two configurations: fly-outs that always maintain the same image
for the front button (such as the Smart Dimension fly-out) and fly-outs that use the last used but-
ton on the front of the fly-out (such as the Rectangle fly-out). You can expand the flyout by click-
ing the arrow associated with the flyout button. You will find three different kinds of flyouts in
SolidWorks: Toolbar flyouts, Add-in flyouts, and Similar function flyouts.

Toolbar flyouts are listed in Tools®> Customize &> Commands, and are listed from 2D to 3D
through the Weldments toolbar. After Weldments in the list the fly-outs are Similar Function fly-
outs. You can change the order of the items in the flyouts by changing the order of the items in the
toolbars. Just display the original toolbar and use Tools = Customize to reorder it to your liking.
These toolbars will always have the same icon on the top. For example, if you use the Reference
Geometry flyout to access the Axis command, the image for the Plane icon will remain on top. The
image on top is considered to be the most commonly used function of that group of tools, and so
remains on top.

Add-in flyouts, such as the eDrawing flyout, are controlled by that add-in and again keep the same
icon always on top.

The flyouts used for tools of similar function are split between using the most recently used tool icon
on top and keeping a consistent icon on top. The only tools that appear to follow the latest icon
method are the Sketch Entities tools. Sketch Tools and other flyouts use a hard-coded top image.

Context toolbars

Context toolbars are toolbars that appear in the graphics window when you right-click or left-click
on something. When you right-click, a context toolbar appears at the top of the RMB menu, and
shows the functions that SolidWorks deems the most commonly used functions. This is a static
list, and does not change as you use the buttons. These functions are removed from the actual RMB
menu, and are replaced with only the toolbar icon in a toolbar above the abbreviated RMB menu,
as Figure 2.10 shows.

An identical toolbar appears when you select (left-click) an item on screen. When this toolbar
appears with a left-click, the rest of the RMB menu does not appear. Tooltips are available if you
do not recognize the icons on the toolbar.

For reference, the icons in the toolbar atop the RMB menu shown in Figure 2.10 are in order from
the upper-left: Edit Feature, Edit Sketch, Suppress, Rollback, Select Other, Create Sketch, Hide
Body, Zoom To Selection, Normal To, and Appearance Callout. Notice that these selections do not
reappear in the main menu.
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Right-click context toolbar

These context toolbars are not editable, but you can turn them off, and put the RMB menus back
to a more familiar configuration. To turn off either right click or left click, or both, context tool-
bars, click Tools= Customize and use the options on the right side of the main Toolbars tab, as
shown in Figure 2.11.

FIGURE 2.11

Context toolbar settings

I personally find that the RMB context bars are distracting because they force you to read icons
and text at the same time, as well as search a two-dimensional list of icons and a one-dimensional
list of text. To me, this is just too confusing. I turn these off so that the RMB menus look like they
always did.
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FIGURE 2.12

However, I do find left click context bars useful for things like Hide Sketch, Edit Feature, Edit
Sketch, Appearance Callout, sketch relations, and so on. When I use the RMB menus, I'm looking
for a more general function. When using the left click context bars, I'm looking for something spe-
cific that I know is there. In Figure 2.11, Show on selection simply refers to the left click toolbar,
and Show in shortcut menu refers to the RMB menu.

The purpose of the context toolbars is to save space by condensing some commands into a toolbar
without text instead of a menu with icons and text. The left and right click toolbars are the same,
but they work differently. The left click context toolbar fades as you move the cursor away from it
and becomes darker as you move the cursor toward it. Once it fades past a certain point, you can-
not get it back, except if you have Ctrl-selected multiple entities. The context toolbar does not
appear until you release the Ctrl key. To get a context menu to show up again after it has faded,
you can just move the cursor back to approximately where the toolbar would have been and press
Ctrl again. This works only for multiple selection menus where Ctrl was used to multi-select. The
functionality is probably a bug, or unintentional in any case, or else it would also work somehow
for single selections.

Shortcut “S” toolbar

The Shortcut toolbar is also known as the “S” toolbar because by default it is accessed by pressing
the S key. This toolbar can be customized for each document type, so it can have different content
for parts, assemblies, and drawings. To customize the S toolbar, right-click on it when it is active
and click the Customize from the menu, as shown in Figure 2.12.

The Shortcut “S” bar
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Many people claim to have customized the S toolbar to such an extent that they have been able to
remove all other toolbars from their interface. This is possibly true if you typically use a limited
number of sketch entities, sketch relations, and feature types, or make extensive use of flyouts on
the S toolbar, but if you tend to work in several corners of the software (say, surfacing, sheet metal,
and plastic parts), you may need some additional toolbar space. It is completely believable to have
access to most of the software’s function with the S toolbar and either the Menu Bar Toolbar or the
CommandManager. CommandManager by far gives you the most flexibility, but it also requires the
most space, and conceivably more setup time as well.

The S key shortcut may conflict with a customization you have done, depending on how your soft-
ware was installed. To change the S toolbar key to another character or to reassign it, follow the
directions for creating and maintaining hotkeys later in this chapter in the section on customiza-
tion. It is referenced as the Shortcut Bar in the Tools® Customize= Keyboard list.
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Tooltips

One way to learn about the individual icons is to use the Tooltips that appear after you hover your
cursor over an icon for a few seconds. Tooltips come in two varieties: large and small. Large
Tooltips show the name of the tool, along with a brief description of what it does. Small Tooltips
show only the tool’s name. To change the Tooltip display from large to small, or to turn off the
Tooltip display altogether, you can use the Tools=> Customize menu option, as shown in the
upper-right corner of Figure 2.11. In addition to the Tooltip balloons, tips also appear in the status
bar at the bottom of the screen when the cursor is over an icon. Figure 2.13 shows a comparison
between large and small Tooltips.

FIGURE 2.13

SolidWorks uses large Tooltips by default, although it can also show small Tooltips.

L ICTE The Tools=> Customize menu option is inactive unless a SolidWorks document is
- open. To access Tools, Customize, first open a SolidWorks part, assembly, or draw-
ing. Tools, Customize is different from the Customize Menu option that is found in all
SolidWorks menus. The Customize Menu option is discussed later in this chapter.

Managing toolbars

After all of that, if you still feel you need to work with standard toolbars, it is easy to move, turn on
and off, and add icons to toolbars. It is important to remember that different document types
retain different toolbar settings; for example, the toolbars that you see with a part open are differ-
ent from the toolbars that you see for drawings.

When you are working on patrts, it is important to have both the Sketch and the Features toolbars
active. When you are working on a drawing, you will never use the Features toolbar, but you will
frequently use the Sketch toolbar. Likewise for assemblies, you may want to display some addi-
tional toolbars and eliminate others. For this reason, when you change from a part document to a
drawing document, you may see your display adjust because the changing toolbars increase or
decrease the amount of space that is required.

neesr o, - ~- Itis best practice to set up the toolbars for each document type so that they take up
BEST PRalTICE the same amount of space —for example, two rows on top and one column to the
right. This way, changing between document types is not so jarring, with the graphics area
resizing for each change.
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FIGURE 2.14

Moving Toolbars

To move a toolbar, you can click with the cursor at the double bar on the left end of the toolbar, as
shown in Figure 2.14. The cursor changes to a four-way arrow, and you can then drag the toolbar
where you want it. Toolbars dock either vertically or horizontally. You can resize undocked toolbars
so that they have rows and columns. This arrangement is typically used with the Selection Filter
toolbar, which is often left undocked and compressed into a block that is three or four columns
wide.

Double bars enable you to move toolbars.

FIGURE 2.15

If the SolidWorks window is not wide enough for the toolbar to fit entirely in the screen, double
arrows like those shown in Figure 2.15 display at the end of the truncated toolbar. When you click
the double arrows, a flyout toolbar appears with the missing icons, as shown in Figure 2.16.

A truncated toolbar showing double arrows

FIGURE 2.16

You can display a truncated toolbar by clicking the double arrows.
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Flyout toolbars

You can use any toolbar as a flyout toolbar. Figure 2.17 shows the list of all flyout toolbars, which
is exactly the same as the list of all toolbars. Flyout toolbars are a nice space-saving feature for tools
that you use infrequently, but frequently enough to want to avoid going through the menus. To
use a toolbar as a flyout, select it from the Flyout Toolbars list and drag it onto an existing toolbar.
It displays with an arrow to the right. Clicking the arrow causes all of the tools to scroll out tempo-
rarily until you click either a toolbar icon or anything else.

To add icons to a flyout toolbar, temporarily show the regular toolbar that corresponds to the
flyout toolbar, and add icons to the regular toolbar. When you are done adding or removing icons,
turn off the regular toolbar; the changes are applied to the flyout.
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The Flyout Toolbars are on the Commands tab in the Customize dialog box

—J—J P If you want to create a separate toolbar, you can commandeer an existing one for
your own purposes. For example, because I do not use the Tools toolbar, I have
removed all of the regular icons from it and replaced them with relevant flyout toolbars, which I
do use extensively. This allows me to consolidate space, and not have unused icons on my tool-
bars.

Full Screen mode

Full Screen mode enables you to quickly toggle the display so that only the graphics window and
the Task pane display; the FeatureManager, menus, toolbars, and status bar are all hidden.
Alternatively, you can hide just the FeatureManager or the toolbars.

In Full Screen mode, you can still access the menus by clicking the cursor along the top border of
the window.

B To toggle to Full Screen mode, press the F11 key.
B To toggle the toolbar display, press the F10 key (see Figure 2.18).
B To toggle the FeatureManager display, press the F9 key.
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FIGURE 2.18

The SolidWorks window with all toolbars hidden using the F10 key

Workflow customization

When you first install and run the SolidWorks software, the SolidWorks Welcome screen shown in
Figure 2.19 offers you the option to customize the interface using one of three preset option pack-
ages. Special menu and toolbar settings are made for Consumer product design, Machine design,
or Mold design. After the software is initially installed, you only see this screen once, but you can
change all of the options in other places, including the Options tab of Tools=> Customize.

The three workflow customizations affect the interface as follows:

B Consumer product design adds the Surfaces toolbar to the CommandManager.
B Machine design adds Sheet Metal and Weldments toolbars to the CommandManager.
B Mold design adds Surfaces and Mold Tools toolbars to the CommandManager.

Similar changes are made to the menus to hide or show menu selections as appropriate. You can
find more information about hiding and showing menu items later in this chapter.

If you want to select a different option after the initial setup, you can go to
Tools= Customize &> Options, where you can specify a different choice. Figure 2.20 shows the
Options tab of the Customize dialog box.
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The Welcome to SolidWorks screen

FIGURE 2.20

The Options tab of the Customize dialog box, where you can select a different workflow customization
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FIGURE 2.21

Menus

Everyone has his or her own style of working. For example, some people like to use menus and
others do not. Some like to use hotkeys and others like the mouse. An example of a tool that does
not have a toolbar equivalent is View = Modify & Section View, which is used to change the active
section view’s settings.

The most frequently used menu items are in the View, Insert, and Tools menus. All of the menus
shown in this section have all of the possible selections turned on. As a result, the View menu in
Figure 2.21 may contain options that are not available on your computer. Customizing menus is
covered later in this chapter. Figure 2.21 also shows the Insert and Tools menus, along with an
image of a menu with the Customize Menu mode activated.

The View menu is used primarily for turning on or off the visibility of entity types such as planes,
sketches, or temporary axes. You can also do this by using hotkeys or by putting extra items on the
View toolbar.

Popular menus
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View Menu Insert Menu Tools Menu Customize Mode
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The Insert menu is used mostly for creating feature types for which you do not have a toolbar icon
on the screen. For example, although the Move Face tool is only on the Mold Tools toolbar, it has
many uses aside from mold design. You can find the Move Face tool at Insert= Face.

The Tools menu is used primarily for sketch entities or tools for which you have no icon on the
screen. Several other commonly used tools, such as Measure, Equations, Customize, and Options,
are also available in this menu.

You can customize menus by adding or omitting items. By using the Customize Menu option at
the bottom of any menu—including shortcut (right mouse button) menus—you can remove items
from any menu by clearing the check boxes next to tools that you do not use. To bring back the
removed items, you can either go back to the Customize Menu or go to Tools=> Customize >
Options and click the Reset to Defaults buttons for menu and shortcut customization.

N Q_r £ Be careful not to confuse this Customize Menu selection with the Customize...
\ - menu selection on the Tools menu. Figure 2.21 shows the Tools menu being
customized.

The Tools=> Customize = Options dialog box, shown in Figure 2.21, contains the Shortcut (right
mouse button) menu and Menu customization options. These options enable you to show all of
the menu items for both types of menus in a single stroke. By default, some items are hidden in
various menus. Keyboard customization is discussed later in this chapter. Keyboard shortcuts are
generally referred to as hotkeys.

CrrE SolidWorks terminology for Shortcut Menus, Alt-key (accelerator keys) shortcuts, the
I\J U .rL.— ugr s ation i< cli H
Shortcut “S” bar, and Shortcuts/Keyboard customization is slightly confusing because
of these overlapping, yet unrelated, terms. For this reason, I will refer to Shortcut Menus as RMB
(right mouse button) menus from here on, because this is the standard terminology among
SolidWorks users. Shortcuts are also generally referred to as hotkeys among users. The Shortcut
Bar will be referred to as the “S” Toolbar, and the Alt shortcuts will be called Alt-keys.

Cursors

SolidWorks cursors are context-sensitive, and change their appearance and function depending
on the situation. Sketching cursors display a pencil and the type of sketch entity that you

are presently sketching. Sketch cursors also display some dimensional information about the
entity that you are sketching, such as its length or radius. Sketch cursor feedback is necessary for
fast and accurate sketching.

OS5 EF To learn more about sketch cursor feedback, see Chapter 3, Working with
22725 gketches.

The Select cursor changes, depending the item over which you move it. Cursor symbols also help
to remind you when selection filters are active. The cursor is frequently available as an OK button.
For example, after selecting edges for a Fillet feature, the RMB functions as an OK button. Figure
2.22 shows various cursors and their significance.

49



m SolidWorks Basics
FIGURE 2.22

Various SolidWorks Cursors

Select
0K sketch Sketch
Select selection plane line

ks

FeatureManager and PropertyManager windows

The FeatureManager window is the panel to the left of the screen that shows an ordered list of features
describing how the part was built. SolidWorks users spend a fair amount of time using the
FeatureManager to edit or inspect models. Figure 2.23 shows the FeatureManager for a simple model.

FIGURE 2.23

The FeatureManager for a simple model

Splitter bar

L Display pane icons

Display pane collapse arrows

FeatureManager filter

PropertyManager tab

FeatureManager collapse arrows

Rollback bar

Using the FeatureManager

There is a splitter bar at the top of the FeatureManager that enables you to split the
FeatureManager window into two windows, so that you can display the FeatureManager and
another window, such as the PropertyManager. Small arrows in the middle of the right separator
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can collapse the FeatureManager to increase screen space. (The F9 key also collapses or opens the
FeatureManager. Refer to Figure 2.23).

Display pane

You can open the Display pane flyout from the FeatureManager by using the double arrows at the
top-right corner. The Display pane helps you to visualize where appearances or hidden bodies
have been applied in a part document and additional functions in an assembly document. The dis-
play pane is helpful when looking for colors that are applied to the model at some level other than
the part level.

Appearances are covered in more detail in Chapter 5, Using Visualization
Techniques.

Rollback bar

The Rollback bar at the bottom of the FeatureManager enables you to see the part in various states
of history. Features can be added while the rollback bar is at any location. The model can also be
saved while rolled back.

FeatureManager Filter

One of the most useful elements of the FeatureManager is the FeatureManager Filter. The Filter
resides at the top of the FeatureManager. If you type text in the filter, SolidWorks will search fea-
ture names, descriptions, comments, tags, and dimension names for text matching the string, and
only show matching features in the window. This also works in assemblies, where you can filter for
part names or document properties. The filter is very useful for quickly finding parts, features,
mates, or anything else that shows up in the part or assembly FeatureManager. I think it is one of
the most useful enhancements in recent releases.

Using the PropertyManager

The PropertyManager is where you go to set most of the feature parameters, and where you edit
properties of selected items such as sketch elements. You can manually switch to the
PropertyManager using the tabs on the top of the Display panel, or allow it to pop up automatically
when your input is needed. The left-most tab in the row of icons is the FeatureManager tab, the
second from the left is the PropertyManager tab, the second from the right is the
ConfigurationManager tab, and the right most tab is the TolAnalyst. Other icons may also appear
in this area for drawings, or if you have add-ins such as PhotoWorks or SolidWorks Simulation
(formerly COSMOS) turned on. The ConfigurationManager tab appears with more detail in
Chapter 10, and the TolAnalyst tab appears again in Chapter 23.

One of the benefits of putting dialog boxes in the PropertyManager is that it saves a lot of space on
the screen. On the other hand, you will often need to make a selection from the FeatureManager at
the same time that the PropertyManager pops up and takes its place. This automatic pop-up
behavior is controlled by a setting in the Tools=> Options = System Options &> General = Auto-
show PropertyManager.
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FIGURE 2.24

My favorite option for dealing with the PropertyManager is to detach it from the FeatureManager
so that you can see them side by side instead of one or the other. The detachable PropertyManager
is new in SolidWorks 2009. To detach it, drag the icon from the tabs out into the graphics area
and release. Once detached, the PropertyManager can be moved to a second monitor, floated
within the SolidWorks window, or docked. To put it back in its place under the FeatureManager,
just drag it back on top of the FeatureManager, allow it to snap into place, and release it.

If you do not like the detachable PropertyManager, you can use either the splitter bars to put the
FeatureManager on top and the PropertyManager beneath, or use the flyout FeatureManager.
When creating or editing a feature, you can access the flyout FeatureManager by double-clicking
the name of the feature at the top of the PropertyManager. The flyout FeatureManager is displayed
just to the right of the regular FeatureManager, in the main graphics window, and is transparent to
allow you to see the model through it. The various ways of combining the FeatureManager and
PropertyManager are shown in Figure 2.24.

The detached PropertyManager, the flyout FeatureManager, and the split FeatureManager
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Detached PropertyManager Flyout FeatureManager Split Feature

Manager

Task pane

By default, the Task pane sits to the right of the SolidWorks screen, although you can undock it
entirely. If you want to keep it open, click the pushpin in the upper-right corner of the pane. The
Task pane is shown in Figure 2.25.
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The Task pane

The Task pane is the home for several panels:

B SolidWorks Resources. These are useful links for templates, tutorials, tech support,
news, GlobalSpec search, Tip-of-the-Day, and other resources.

B Design Library. This includes locally stored libraries, Toolbox, and 3D Content Central.
This tab also contains “SolidWorks Content” which consists of additional library
resources that can be downloaded directly from the Task Pane.

B File Explorer. This is a Windows Explorer-like interface that you can use to browse for
files.

B SolidWorks Search. If you have installed the Windows Desktop Search with SolidWorks
2007 and indexed your files, you can perform searches that include filename and custom
properties.
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B View Palette. This palette allows you to visually select views and drag them onto a
drawing sheet.

B RealView. This allows you to select appearances and scenes for your SolidWorks
documents.

B Custom Properties. New functionality in 2009 enables you to create a custom interface
that goes inside this Task Pane tab that will help you enter custom property data quickly,
easily and accurately.

B Recovered documents. After a crash, auto recovered documents are listed in this special

purpose Task Pane tab.

Status bar

The status bar is a non-intrusive way in which SolidWorks communicates information back to the
user. It is located at the bottom of the screen, and you can enable it from the View menu. Figure
2.26 shows the status bar in action.

The status bar showing a Tooltip for the Sketch Circle tool

[
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The status bar can display the following information, indicators, and icons:

Tags

Progress as parts, assemblies, or drawings load
Tooltips for commands

Measurements

Sketch status for an active sketch

In-context editing

Suspend Automatic Rebuilds

Icons that allow you to turn Quick Tips off or on
Sheet scale for drawings

Cursor position for drawings and sketches

Whether you are editing the sheet, sheet format, or view of a drawing

Tags work like document properties, except that they do not need a property name; they just use a
value. A tag could be considered simply a keyword that you can associate with a part in an assembly
or even a feature in a part. Tags can be searched by SolidWorks Explorer or by the FeatureManager
Filter. You can assign tags by clicking the yellow tag icon on the status bar in the lower right-hand
corner of the SolidWorks window. Figure 2.27 shows a tag being added to a feature.
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Adding a tag to a feature

Quick Tips

Quick Tips appear in the pop-up window in the lower-right corner of the graphics window. They
can change as you work so that they are sensitive to the context in which you are working. They
are a great way for new users or infrequent users to learn or be reminded of the next steps available
to them. You can activate and deactivate Quick Tips using the question mark icon in the lower-
right corner of the SolidWorks window on the status bar. Figure 2.28 shows the Quick Tips
window in action.

FIGURE 2.28

Quick Tips in action
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2D Command Line Emulator

This is a tool specifically for people who are coming to SolidWorks from AutoCAD. As the name
suggests, it adds a command line to the bottom of the SolidWorks window that works like the
AutoCAD command line in most respects. The available commands are somewhat limited com-
pared to those that are available in AutoCAD. This tool only functions in the 2D sketch mode, on a
drawing sheet, or in a drawing view; it does not work in a 3D sketch. The 2D Command Line
Emulator is shown in Figure 2.29.

FIGURE 2.29

The 2D Command Line Emulator in action

Available sketch tools in the 2D Command Line Emulator include Align, Arc, Array, ‘Cal, Chamfer,
Chprop, Circle, ‘Color, Copy, DDcolor, Dim, Dist, Ellipse, Erase, Exit, Extrude, Fillet, ‘Grid, Line,
List, Massprop, Mirror, Move, Offset, ‘Ortho, ‘Osnap, ‘Pan, Plot, Point, Polygon, Qsave, Rectangle,
‘Redraw, ‘Redrawall, Revolve, Rotate, Save, Saveas, ‘Snap, Spline, Trim, U (undo), ‘Units, ‘View,
and ‘Zoom. Commands that are preceded by an apostrophe () can be used as transparent com-
mands, without exiting an active command. Notice that even the cursor changes to crosshairs.

The best way to learn a new software package is to embrace the new way, not to
cling to the old way. Although you may find the 2D Command Line Emulator more
comfortable to work with, you will not achieve the same results as you will with the SolidWorks
default sketching mode. For example, the resulting sketch entities created using the 2D
Command Line Emulator are not constrained in any way, and the endpoints do not even merge.
You can turn off the 2D Command Line Emulator by going to Tools> Add-ins.

LENTE R, AT A
BEST PRACTLCE
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Making the Interface Work for You

As engineers and designers, we all like to tinker with things to optimize efficiency and to apply our
personal stamp. When the SolidWorks software is installed, the interface is functional, but not
optimal. In recent new releases, the new features in SolidWorks tend to use the most radical
options available as the out-of-the-box defaults. In the previous pages, I have discussed managing
and customizing toolbars and menus. In the remainder of this chapter, I discuss more about cus-
tomizing the interface, and suggest some strategies that you might use to help customize your
work environment.

Customizing colors

You need to be aware of a few things before you change all of the standard colors in the
SolidWorks interface to whatever strikes your fancy. The first is that SolidWorks does not auto-
matically alter text color to contrast with your background. As a result, if you set the background
to black, and the text is black, you won’t be able to see the text. This may seem obvious to some
people, but AutoCAD automatically changes text color to contrast with the viewport background,
and so AutoCAD users may take this functionality for granted.

Default selection colors

Between the 2007 and 2008 releases, SolidWorks changed some of the default colors used in the
interface. However, not all users will see these changes immediately. Since the software was ini-
tially released in 1995, the color for selected items has been green. Users have based their color
selections for part colors on this default, generally avoiding the green color so selections could be
seen more easily.

Starting with the 2008 release, the selection color is now blue. But this is only the case if you have
anew computer without a prior installation of SolidWorks on it. If your computer already has an
earlier version of SolidWorks, you will continue with the green selection color even in 2008, but if
you put 2008 or later on a computer that never had a version of SolidWorks, you will get the blue
selection color.

Does it really matter whether the selection color is green or blue? No. What does matter is interface
predictability and consistency. The color default selection color changing from one to another
without any pressing need qualifies as random change, and I don’t believe it positively impacts
software usability. If the color change has a negative effect on your use of the software, be aware
that you can change it back if you like. How to make the changes is described in this section.
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With the introduction of RealView, the selection appears to glow in addition to changing colors.
RealView is hardware driven visualization technology in SolidWorks that has grown in scope over
the course of a couple of releases. RealView is described in more detail in Chapter 5, Using
Visualization Techniques.

All of the interface colors are controlled at Tools= Options=> Colors. The selection color in partic-
ular is set at Selected Item 1, as shown in Figure 2.30.

FIGURE 2.30

Changing interface colors

Notice that you can set a color scheme. I recommend that if you want to change the colors used in
the interface, you save the settings as a color scheme so that the scheme can be re-created easily
later or handed off to another computer. Color schemes are stored in the Windows registry, not as
separate files. To transfer color settings to another computer, you will need to either use the Copy
Settings Wizard or manually copy data from the Windows registry.

Before making changes, you might consider saving your initial settings as a separate scheme so you
can get back to them if you need to.

~. -~ A~ | Making changes to the Windows registry can adversely affect software installation
A -\ and hardware performance. You should not attempt changes to the registry unless
you know exactly what you are doing.
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Background options

Some colors should be avoided for the background, or you should at least make some other
changes if you choose these colors. Black is used with fully defined sketches, dimensions,
FeatureManager text, and annotations. Blue backgrounds can mask the underdefined sketch color.
Bright green backgrounds can cause problems with seeing selected items. Bright red, aside from
being a terrible color to stare at all day, also does not contrast well with some of the red highlights
and error colors.

You might say that whatever color background you select, it makes items or features difficult to
see. For this reason, many users choose a gradient background, which allows you to pick colors
where items are always visible on one half of the screen or the other. Staring at a white screen all
day can be uncomfortable for your eyes, so pick colors that allow you to see everything with “rea-
sonable” contrast, yet are not glaringly bright. Very high contrast is hard on the eyes, and low con-
trast may make it difficult to distinguish items on the screen.

You have to consider what the purpose of the background is. Some people doing presentations
may want the background to be attractive while otherwise staying out of the way. Others may only
need the background to contrast with whatever is in front of it in a way that does not strain your
eyes. For writing a book, the background generally needs to be white to match the page. No one
scheme will suit all needs.

In addition to colors and gradients, you can use an image as the graphics window background.
This gives you a wider range of customization capabilities, and several sample images are already
available in the default settings.

RealView also adds some capabilities with scenes. Scenes can be applied from the RealView tab on
the Task Pane. RealView offers three different types of scenes: Basic, Studio, and Presentation. Of
these, I find the Studio scenes to be the best when I need something of that sort. RealView, along
with scenes, is described in more detail in Chapter 5.

Customization strategies

You can easily customize many aspects of the SolidWorks interface, including:

Toolbars

Menus

Background colors or images
PropertyManager skins

Task pane location

Hotkeys

Macros

Custom application programming
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Whether or not you should customize each of the previous items depends partially on how much
time and energy you have to spend, as well as how much money you are ready to dedicate in the
case of custom programming.

Hotkey approaches

Some of us old-timers prefer to use the keyboard over the mouse. If your hand-eye coordination is
as bad as mine, you may also choose this approach. I can type without looking at the keyboard,
but when I use the mouse, it takes me a few seconds to aim at an icon and hit it accurately. This
means that I customize SolidWorks to use as many hotkeys as possible, and remove icons from the
interface if I have them on a hotkey. Unfortunately, my memory is as bad as my eyesight, and so
remembering 75 hotkey commands is a bit of a problem. I admit to having a printed list of hotkeys
taped to the side of my monitor. While I know that needing to read the list to find a particular hot-
key defeats most of the purpose of using them in the first place, I just accept it as a learning aid.
This is a self-solving problem, because the hotkeys that I use the most are the ones that I learn
most quickly.

I generally do not advocate trying to standardize a hotkey scheme across multiple users, unless the
users all agree to it. The underlying reason for writing a section entitled “Hotkey approaches” is
that everyone remembers things differently in the first place.

Any command that I use more than a few times an hour is worth assigning to a hotkey. I like to
use alliteration when assigning keys to help with my faulty memory. Most-frequently used com-
mands are assigned single-letter hotkeys, and less-frequently used commands are assigned combi-
nations. Thus, Tools Options is linked to O, Measure to M, Select Vertex to Shift+V, and Curve
Projected to Ctrl+] (Ctrl+P is the Windows standard for the Print command). Other people like to
group keys into easy-to-reach combinations, and so the Q, W, A, S, Z, and X keys are often
assigned first for right-handed mouse users.

Organizing hotkeys

Hotkeys are assigned and organized in the Tools®> Customize & Keyboard dialog box, as shown in
Figure 2.31. This interface enables you to see all of the hotkeys (called shortcuts in the list) easily. If
you try to enter an existing hotkey, SolidWorks issues a prompt, telling you that the key is
assigned to another command and what the command is, and asking you if you want to clear the
other instance of the hotkey and make the new one active. You can also print out or copy to the
Clipboard a list of only commands that use hotkeys.

Because the list of commands is so long, a Search function is available, and a drop-down arrow
makes only the commands from a selected menu visible. The list of commands is organized by
menu name, and the menus are listed as they occur in the interface. Fortunately, here on the
Keyboard tab, SolidWorks allows you to sort using the column headers to list the menus, com-
mands, or hotkeys in alphabetical order, simply by clicking the column header. This is a highly
usable interface, one of my favorite interface changes in the last several releases.
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Tools=> Customize &> Keyboard — the hotkey interface

Using the keyboard

Moving between the mouse and the keyboard can be bothersome and time-consuming. In addition
to the hotkey approach, you can use another keyboard method to save time. Many users become
adept at using the Alt-key combinations to invoke menu items. Most menu items in Windows
applications contain a single underlined letter.

To access a top-level menu, you can hold down the Alt key and press the underlined letter for that
menu, and then just press an underlined letter in the menu to access specific commands. This
technique enables you to navigate most of the interface without using the mouse. For example, to
exit SolidWorks, instead of using the mouse to click the red X in the upper-right corner, you could
press Alt+F, X. In Figure 2.32, you can see that the F in File is underlined, as is the X in Exit.

CrrE The SolidWorks documentation terminology becomes further confusing when talk-
HNOTE : :

ing about Alt-keys (accelerator keys). It says that the general class of keys is called
shortcuts, which can be either accelerator keys or keyboard shortcuts. How these are distin-
guished from shortcut menus and shortcut toolbars is not clear. Again, for the purposes in this
book, I refer to the shortcut menus as RMB (right mouse button) menus, accelerator keys as Alt-
keys, and keyboard shortcuts as hotkeys, which is more in line with standard usage than the doc-
umented terminology.
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FIGURE 2.32

Accelerator Keys in the File menu

You may potentially run into conflicts when using Alt-keys. A combination of Alt + another key-
board key is a valid use of a hotkey combination. If you use any Alt hotkey combinations, it is
likely that you have seen a conflict like this. In cases of conflict, the hotkey combination seems to
gain priority over the Alt-key accelerator.

Fewest number of icons

In order to maximize valuable space on the monitor, many SolidWorks users strive to minimize
the number of toolbar icons on the screen, or confine it to two rows of toolbars. You can do this by
using the CommandManager, flyout toolbars, the “S” toolbar, right click toolbars, and hotkeys, and
removing unused icons, as well as the other techniques discussed here.

Having an uncluttered workspace is definitely a plus, but having easy access to commands is the real
purpose of an interface in the first place. You need to strike a balance between too much and not
enough. The more kinds of work you do in SolidWorks, the more tools you will need to have avail-
able. If you only create relatively simple machined parts and drawings, you will need fewer tools
available than someone who does complex plastic part assemblies with rendering and animation.

Device approaches

If you have never used a Spaceball or equivalent view-manipulation device, you should consider it.
They are wonderful devices and do far more than just spin the view. Most of the devices also have
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several programmable buttons that you can link to menu items. They can move drawing views,
parts within assemblies, and even manipulate selected objects in other Office applications and Web
browsers.

Portions of the 2009 edition of this book have been written on a Tablet PC. A tablet might not be
ideal for long periods of SolidWorks usage, but I use it regularly for presentations and even model-
ing when I really want to get the feel of drawing a line by hand, The stylus is not quite as intuitive
as a pencil, but it is less of an impediment to the tactile feel of actual drawings than a clunky
mouse.

Macros

Macros are short snippets of programming code that have a particular function. Most macros are
small and intended for simple tasks that are repeated many times, such as changing selected
dimensions to four decimal places or zooming the screen so that it is sized 1:1 (actual size). Macros
may be recorded, written from scratch, or a combination where you record a particular action to
be used as a starting point and then embellish it manually from there. Recorded macros may not
always record the parts of the action that you want to make into a macro, but you can edit them
manually to include anything that you can program with VISTA (Visual Studio Tools for
Applications), which is included with the base SolidWorks package at no extra cost.

To access macros by using hotkeys, follow these steps:

Make a folder in your SolidWorks installation directory called “macros.”
Copy macros into this folder.

Start (or restart) SolidWorks.

Go to Tools= Customize = Keyboard.

o1l kW=

Scroll to the bottom of the list under the Macros category, and assign hotkeys as
you would for standard SolidWorks commands.

Whether you are skilled at writing or recording macros, or you are just using macros collected
from other people, they can be huge time-savers and offer functionality that you would not other-
wise be able to access. Many of my accumulated macros have been made obsolete by that function-
ality being incorporated directly into SolidWorks.

Saving custom interface settings

Once you have set up your menus and toolbars, worked out all of the custom colors, figured out
your hotkey usage, and connected your macros, you don’t want to lose these settings when you
reinstall the software or move to a different computer. Another user may want to share your set-
tings, or you may want to transfer them to your home computer (for modeling the new deck or the
doghouse, of course). Fortunately, these settings are very portable.

You can use the Copy Settings Wizard to save these settings out to a file. Access the wizard
through Start=> Programs = SolidWorks 2009 &> SolidWorks Tools=> Copy Settings Wizard. This
creates a file with an * sldreg file extension. You can restore settings by double-clicking this file on
a computer that has SolidWorks installed on it.
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FIGURE 2.33

HOUTE

You may need to have administrator access to your computer to apply a SolidWorks
registry file.

The SolidWorks settings are actually Windows registry settings. The file that is saved by the wizard
is just a registry file that has a different extension to prevent it from being applied too easily.
Saved-out Windows registry files have a *.reg file extension, and are integrated into the registry by
simply double-clicking them. If you are not familiar with the Windows registry, you should not
make direct changes, because even small changes can cause serious problems with your operating
system, installed software, or even hardware. The settings that are saved out by the Copy Settings
Wizard are safe to transfer between computers. In order for the Copy Settings Wizard to work, you
need to have Administrator-level access to your computer. The Copy Settings Wizard is shown in
Figure 2.33.

The Copy Settings Wizard

64

Working with multiple document windows

In SolidWorks, as in other areas of life, things can become chaotic. You may sometimes have the
luxury of working on a single part at a time, but more often, you will find yourself with several
documents open at once. This is a common situation for most users. Fortunately, SolidWorks has
several methods for dealing with “information overload,” to help you sort through it all.

Window management

Like most other Windows applications, SolidWorks can arrange the open document windows in
one of several ways that are available through the Window menu (see Figure 2.34):

B Cascade. Most useful for accessing documents that are to be edited one by one.
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W Tile Horizontally. Most useful for wide and short parts.

B Tile Vertically. Most useful for tall, narrow parts, or documents where you want to
compare items in the FeatureManager.

B Arrange Icons. When windows are minimized to icons, this menu selection arranges the
icons neatly, starting in the lower-left corner of the window.

FIGURE 2.34

The Window menu

The images in Figure 2.35 are meant to show the arrangement of the windows, not the content of
the windows. Also remember that you can use the F9 key to close the FeatureManager, the F10
key to remove the toolbars to create extra interface space when arranging several windows in the
graphics window and the F11 key to remove portions of the interface and allow you to work full
screen.

Changing windows

You can use several techniques to change from one window to another. By clicking on the Window
menu, you can view a list of open document windows (refer to Figure 2.34). You can then select
the desired window directly from this menu. If more than a few windows are open, a More
Windows option appears at the end of the list, as shown in Figure 2.36. Clicking on this option
brings up a separate window that enables you to select from the complete list.

When a smaller number of windows are open, a simpler way to change windows is to press
Ctrl+Tab. This is a Windows standard technique that also works in other Office applications.
Ctrl+Tab takes you in one direction in the list of open windows, and Ctrl+Shift+Tab takes you in
the opposite direction through the list. Starting with the 2008 release, Ctrl+Tab brings up the
Open Documents interface (see Figure 2.36). This enables you to visually select the document that
you want to open.

Additionally, the R hotkey by default opens the Recent Documents dialog, similar to the Recent
Documents list in the File menu. This can also be accessed via the File menu if necessary. The
Recent Documents dialog is shown in Figure 2.37.
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FIGURE 2.35

Window Arrangements: Cascade, Tile Horizontally, and Tile Vertically
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FIGURE 2.36

The Open Documents dialog

FIGURE 2.37

The Recent Documents dialog

Tutorial: Getting to Know the Interface

By this point, you really have not learned much about making parts, assemblies, and drawings in
SolidWorks, but you have learned quite a bit about using the interface. In this tutorial, you get
some hands-on practice at manipulating the interface. This tutorial is intended to reinforce the fol-
lowing skills:

B Adding and removing toolbars
B Adding and removing toolbar buttons

B Adding and removing items from drop-down and RMB menus
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Setting up the CommandManager
Setting up hotkeys

Linking a hotkey to a macro

Changing interface colors

Copy the existing settings

Regardless of what your initial settings are, you do not want to lose them. Before you start to make
changes to your system, you should save out the existing settings to a file from which they can be
recovered. You can do this using the Copy Settings Wizard, as shown in Figure 2.38.

FIGURE 2.38

The Copy Settings Wizard

To use the Copy Settings Wizard, follow these steps:

Close SolidWorks.

2. Click Start= Programs = SolidWorks 2009 => SolidWorks 2009 Tools=> Copy
Settings Wizard.

Select Save Settings, and click Next.
Enter a location and a name for the file.

Select the items that you would like to save. For the purposes of this tutorial, make
sure that the following options are selected: Keyboard Shortcuts, Menu Customization,
Toolbar Layout, and All Toolbars.

6. Click Finish. Browse to the location where you saved the file and make sure that it is
there.
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Set all interface items to their default settings

You can set the interface back to the default settings using one of two methods. The first method,
editing the Windows registry, may not be available to all users. It requires Administrator access to
your computer and a good familiarity with Windows.

~LE A Editing the Windows registry can be dangerous if you make a mistake. Do not
e N attempt this method is you have any doubts about what you are doing.

To set SolidWorks back to its default settings, follow these steps:

Close SolidWorks.
Click Start= Run.
Type regedit, and click OK.

0wy =

Browse to HKEY_CURRENT_USER\Software\SolidWorks\SolidWorks 2009 or
the appropriate folder for the version that you are using.

5. To return all settings in SolidWorks back to default, rename the entire SolidWorks
2009 folder to include “(old)” at the end of the filename.

Close the Registry Editor.

The folder is re-created when SolidWorks starts up again, and is populated with
default values. If you need to get the previous folder back, you can delete the new one
and rename the old one to remove the “ (old)” from the name.

The second method, which is less risky but less complete, is to go to the main locations and use
the tools provided to return settings to their defaults. Restart SolidWorks and create a new blank
document (you cannot display the Customize dialog box without a document open). To access the
resets for the interface, do the following:

1. Click Tools=> Options = General = Reset, and go to the bottom-left area of the dia-
log box.

2. Click Tools=> Customize = Toolbars = Reset, and go to the bottom-left area of the
dialog box.

Click Tools=> Customize=>Menus=> Reset All, and go to the right side of the dialog box.

Click Tools= Customize = Keyboard = Reset to Defaults, and go to the upper-right
area of the dialog box.

5. Click Tools=> Customize > Options; there are three Reset to Defaults buttons along
the left side of the dialog box.

Customizing the CommandManager

Now that you have restored the default settings, you can begin customizing the interface with the
CommandManager. To do this, open a part document or create a new one, then RMB click anywhere
on the CommandManager, and deselect the Use Large Buttons with Text option, as shown in Figure
2.39. When you have done this, the check mark should no longer appear in front of the option.
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FIGURE 2.39

Deselect the Use Large Buttons with Text option.
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Next, add some toolbars to CommandManager, as follows:

10.

RMB click the CommandManager tabs, and select Customize CommandManager.

Click (left-click) on the New Tab icon at the right end of the CommandManager
tabs and select Surfaces, Sheet Metal and Annotations. Turn off the Sketch tab by
right clicking it and selecting Hide Tab. The new tab icon is shown in Figure 2.40.

FIGURE 2.40

Adding tabs to the CommandManager

In the Customize dialog, enable the Large Icons option.

Turn the Sketch toolbar on, but not inside the CommandManager, use the Toolbars
tab of the Customize dialog. Dock the Sketch toolbar to the right side of the window.

Turn on the Standard Views toolbar and drag it to the right end of the
CommandManager. Now drag a couple of buttons off of it, such as the bottom, or left,
or back views.

On the Commands tab of the Customize dialog, select the Flyouts entry, and drag
any Standard Toolbar type of flyouts from the Customize dialog to the Menu Bar
Toolbar. Figure 2.41 shows this step in action.

Turn off the Customize dialog, and right-click on the Heads-up View toolbar

Turn off the tools that you will not use on the Heads-up View toolbar, and click out-
side of the menu when you are done.

Run your cursor over the main menu flyout and use the pushpin to pin the menu
open.

Go to Tools=> Customize = Options and click both Show All buttons for Shortcut
Customization and Menu Customizations. This removes the double arrows at the bot-
toms of RMB menus. This setting is shown in Figure 2.42.
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Adding flyouts to the Menu Bar Toolbar

FIGURE 2.42

Removing truncated menus

11. While still in Tools = Customize, change to the Toolbars tab and turn off the
Context Toolbar Settings=> Show On Selection option to disable the left click con-
text toolbars, or disable the Show In Shortcut Menu to put the RMB menus back to
their pre-2008 state (all entries in menu use text).

12. Click and drag the PropertyManager tab (second tab from the left) from the
FeatureManager, and dock it just to the right of the FeatureManager under the
CommandManager tabs. The display should now look like Figure 2.43.
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FIGURE 2.43

The customized SolidWorks interface

The small flyout in the lower-right corner of Figure 2.44 is the remainder of the Sketch toolbar that
does not fit on the screen. This screen shot was taken on a 12-inch monitor with large icons at
1024 x 768 resolution. At such a low resolution, long toolbars do not fit on the screen, and the
remaining icons are activated by the two small arrows at the end of the toolbar.

Customizing menus

If you always do the same types of work, or more importantly, never do certain types of work, then
you might consider customizing some menus to remove items that you never use. Customization
applies to both the main drop-down menus and the context-sensitive RMB menus. To customize a
menu, follow these steps:

1. Click Insert= Customize Menu. Note that Customize Menu is different from
Customize.

2. Turn off the menu items Sketch from Drawing, DXF/DWG, Object, Hyperlink, and
Picture (see Figure 2.44). Click anywhere outside of the list to close it.

Click the Insert menu to ensure that the deselected items have been removed.

RMB click the Right plane in the FeatureManager.
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Customizing the Insert menu

5. Select Customize Menu.
6. Turn off Section View. Click anywhere outside of the list to close it.

7. RMB click the Right plane to verify that Section View has been removed.

Change interface colors

This tutorial does not depend on RealView capabilities, but later work will. To find out if your
computer is RealView capable, check your video card and driver version against the list on the
SolidWorks Web site. On the main page of the site, follow the link for Video Cards.

Before starting this tutorial, make sure the RealView icon is disabled. You can turn off RealView at
View = Display = RealView Graphics.

. e inf i RealVi hi h 5.
ClPOSS-PEF For more information on RealView graphics, see Chapter

Edit the colors used in the interface:

1. Go to Tools= Options= Colors. Make sure the “Plain (Viewport Background color
above)” option is turned on.

2. Change the Viewport Background color, first in the Color Scheme Settings list, to a
light gray color, then click OK and make sure the setting was applied.
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3. Go back to Tools= Options=> Colors, and click the Save As Scheme button, and
save the color scheme as Plain Gray.

4. Now enable the “Gradient” option, and set the top and bottom gradient colors
(second and third in the top list). Click OK and see how you like the gradient display.
Adjust the colors until you are happy with them.

5. Go back to Tools= Options=> Colors and click the Save As Scheme button, and save
the color scheme as Gradient. Figure 2.45 shows the Tools= Options= Colors dialog
box.

FIGURE 2.45

The Colors settings

6. Use the Current Color Scheme drop-down list at the top to change the color
schemes between the newly saved schemes,

Adding hotkeys

For many users, hotkeys are an integral part of the everyday experience of using SolidWorks. You
can easily assign hotkeys and manage the assignments by following these steps:

1. Click Tools= Customize = Keyboard.
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In the Search For text box, type Options.
Click in the Shortcut column, and type O.

Click again in the Search For text box, and type Customize.

g R w N

Click in the text box next to the Tools=> Customize entry and press Ctrl+C. Answer
no to the question of whether you want to reassign the hotkey. Press Ctrl+T instead.

Click OK to exit the Customize dialog box.
Press the O key to bring up Tools Options. Click OK to exit.
Press Ctrl+T to bring up Tools= Customize. Click OK to exit.

° 2N

Press Alt+F, and then press X to exit SolidWorks.

Combining macros with hotkeys
Macros are covered in Chapters 34 and 35, but the following steps show you how to link a macro

to a hotkey:

You can use the macro called rectangle.swp, located on the CD-ROM.

Or e CD-1200]

1. Find your SolidWorks installation directory. By default, this directory is C: \Program
Files\SolidWorks.

2. Create a folder called Macros in the SolidWorks directory and put the rectangle.
SWp macro in it.

Start SolidWorks.

Create a new blank part document.

Press Ctrl+T to access the Customize dialog box.
Click the Keyboard tab.

In the Search For text box, type rectangle.

S NS H W

Click in the Shortcut column next to the listing with the Category of Macros, and
press R.

9. Click OK to exit the Customize dialog box.

10. Press R. The rectangle macro runs and draws a sketch rectangle on the Front plane,
centered on the origin.

11. Press Ctrl+S to access the Windows standard hotkey for the Save command. Name
the part rectangle.sldprt and save it to a workspace directory.

12. Press Alt+F and then X to exit SolidWorks.

The use of Alt-keys and hotkeys is somewhat exaggerated in this tutorial, but it is intended to get
you used to working with them.
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Summary

The SolidWorks interface is very busy and can be daunting. You can access most functions
multiple ways, which can be liberating because it offers options, but it also adds to the confusion
because there is so much to remember. You do not need to know every way to do everything; you
only need to know the best way for you. After using this book to find the various ways of using the
interface, just develop the way that is most comfortable for you and stick with it.

Be aware that every couple of releases, SolidWorks changes the interface, and often, they use the
most radical options available as the new defaults. Keep a copy of your settings file with you so that
you can restore settings or you can take your settings to another computer quickly if you need to.
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Working with Sketches

o far in this book, you have looked mainly at concepts, settings, and

setup, which is necessary but pretty mundane business. However, here

you begin to learn how to control parametric relationships in sketches.
Then in later chapters, you begin to build models, simple at first, but gaining in
complexity and always demonstrating new techniques and features that build
your modeling vocabulary. Beyond this, you will move into putting the parts
together into assemblies, which helps to make the “pretty pictures” look like
something useful. Finally, you use the parts and assemblies to create drawings.

This chapter deals mainly with sketches in parts. However, you will be able
to apply many of the topics I cover here to assemblies. Some related topics,
such as Layout sketches, have functionality that is exclusive to assemblies
and are covered in the assemblies chapter.

Several basic facts about sketches may be helpful before you start. While a

part may have many sketches, only one sketch can be open at a time. This is
due in part to the history-based nature of the software; every entry in the
FeatureManager tree must be edited in the position in which it exists in the tree.

While you can create both 2D and 3D sketches, you will use 2D sketches
most of the time. When referring to a generic sketch, a 2D sketch is always
assumed. You will use 3D sketches in specific situations, and they will be
explicitly called for when needed.

I discuss 3D sketches in detail in Chapter 31.

~eeoop

When you open a sketch, several tools become available, specifically all of
the sketch entities and tools. Conversely, there are several things that you
cannot do until you open a sketch. For example, you cannot apply a Fillet
feature while a sketch is open. Open sketches and selection filters are two
very common sources of frustration for new users. Several indicators exist to
let you know when you are in Sketch mode:
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The title bar of the SolidWorks window displays the text Sketch X of Part Y.
The lower-right corner of the status bar displays the text Editing Sketch X.

The Confirmation Corner displays a sketch icon in the upper-right corner of the graphics
window.

The Sketch toolbar button now displays the text Exit Sketch and is pressed in.
The red sketch Origin displays.
If you are using the grid, it displays only in Sketch mode.

While most users find the sketch grid to be annoying or distracting, when teaching, I've always
used the grid to remind students when they are in Sketch mode. If you find that you forget or
would like a visual cue, the sketch grid is a useful, if less than fashionable, option.

Opening a Sketch

Several methods exist to open new sketches in SolidWorks:

Click a sketch entity toolbar button from the Sketch toolbar; SolidWorks prompts you to
select a sketch plane. When you select the plane, the sketch opens.

Preselect a plane or planar face and then click either a sketch entity button or the Sketch
button.

Use the left-mouse button to click context toolbar — click a face or plane and select the
Sketch icon.

Right-mouse button click a plane or planar face and select Insert Sketch. Planes can be
selected from either the graphics window or the FeatureManager.

You can open existing sketches in several ways:

Right-click a sketch in the FeatureManager or graphics window, and select Edit Sketch.

Select a sketch from the FeatureManager or graphics window, and click the Sketch but-
ton on the Sketch toolbar.

Left-click a sketch or feature and click the Edit Sketch icon from the context toolbar

Double-click a sketch with the Instant 3D tool active.

Identifying Sketch Entities

The first step in creating most SolidWorks parts is a sketch. This will usually be a 2D sketch,
although you can also use 3D sketches. A 2D sketch is simply a collection of 2D lines, arcs, and
other elements that lie together on a plane; it usually also contains relations and/or dimensions
between the entities so that the sketch can automatically adjust to changes because each sketch
entity understands its function.
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SolidWorks sketch entities include many types, some of which you will use all of the time, and
some of which you may not use, even if you spend years working with the software. Here 1 will
identify each entity type so that you see it at least once and know that it is available if you need it
at some point.

The Sketch toolbar

In the following section, I identify the default buttons on the Sketch toolbar first, followed by the
rest of the entities that you can access through Tools = Customize & Commands= Sketch.

Sketch opens and closes sketches. You may notice that the name of the button changes depending
on if the sketch is open or closed. If you preselect a plane or planar face and then click the Sketch
button, SolidWorks opens a new sketch on the plane or face. If you preselect a sketch before click-
ing the Sketch button, SolidWorks opens this sketch. If you preselect an edge or curve feature
before clicking the Sketch button, SolidWorks automatically makes a plane perpendicular to the
nearest end of the curve from the location you picked. If you do not use preselection, and only
click the Sketch tool with nothing selected, SolidWorks prompts you to select a plane or planar
face on which you want to put a new sketch, or an existing sketch to edit.

3D Sketch opens and closes 3D sketches with no preselection required. 3D sketch is covered in
more detail in Chapter 31.

Smart Dimension can create all types of dimensions used in SolidWorks, such as horizontal, verti-
cal, aligned, radial, diameter, angle, and arc length. You can create dimensions in three ways, as
shown in Figure 3.1:

W By selecting a line and placing the dimension
B By selecting the endpoints of the line and placing the dimension
W By selecting a pair of parallel lines and placing the dimension
Selecting the line is the easiest and fastest method. Selecting parallel lines on the ends is not rec-

ommended because if you delete either of the selected lines, the dimension is also deleted,
although sometimes this method is necessary.

You can use the first and second techniques for the angled line shown in Figure 3.1 to create any
of the three dimensions shown. To accomplish this task, drag the cursor while placing the dimen-
sion until the witness lines snap to the orientation you want.

TR To lock the orientation of a dimension while moving the cursor to place the actual
dimension value, click the right-mouse button. To unlock it, just click the right-
mouse button again. The right-mouse button cursor shows a lock or unlock icon when this func-
tionality is available.

In this case, the third technique locks you into the horizontal orientation because of the orientation
of the selected lines.
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FIGURE 3.1

Selection options for linear Smart Dimension

Rebuild/No exit  Increment value

Dimension value Drop-down arrow
Spin wheel Spin arrows
1/
\2
Cancel | Mark for import

0K  Change sense

L ICSTE In some situations you may run into lines that appear to be parallel, but are not
‘ - exactly so. This will cause you to get an angle dimension where you want a linear
dimension. Here, you can select one of the lines and one endpoint. SolidWorks requires paral-
lelism to a high precision, and situations like this can happen if the angular measurement is off in
the second or third decimal place, measuring in degrees. Imported 2D drawings and reverse
engineered 3D models can be particularly susceptible to this type of error.

~a+ ==~ < Whenyouselectlines to establish a dimension instead of endpoints, both of the
A -\ fines gain an implied parallel relati i i
gain an implied parallel relation that prevents them from moving as you might
predict. In the example shown in Figure 3.1, neither of the end lines can be angled unless you
remove the dimension.

Another issue that arises for adding dimensions to lines is that if you delete either of the lines,
the dimension is also deleted. This is not true for the first and second techniques, where as long
as the endpoints remain, the dimension also remains.

You can change Smart Dimension values in several ways. The most direct way is to directly key in
a value such as 4.052. The software assumes document units unless you key in something specific.
You could also key in an expression, even with mixed units, such as 8.045/2+.125 or 25.4+.625
in. Starting in SolidWorks 2009, you can also key in negative dimensions, which functions the
same as the Change Sense button in the Modify box.
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Another way to put a value into the Modify box is to click the down arrow to the right of the value
field, and select either to use an equation to calculate a value or a Link Value. A Link Value is like a
variable name to which you can assign a value. You can link multiple dimension values to that
Link Value. In sheet metal parts, the default Link Value of Thickness is used, so that if you change
the thickness in one feature, it will change for all the sheet metal features.

To the right of the drop-down arrow is a pair of up and down “spin” arrows that allow you to
change the value in the Modify box by a set increment amount. The increment can be set in
Tools= Options & System Options=> Spin Box Increments. You can also store multiple increment
values in the Increment Value icon on the Modify box.

The final way to change the value in the Modify box is by using the wheel underneath the value field.
The wheel uses the default increment value. Holding down Ctrl while using the wheel multiplies the
increment by 10, and holding down Alt while using the wheel divides the increment by 10.

W Radial. You create the dimension by selecting an arc and placing the dimension. If you
want a radial dimension of a complete circle, you must Right-click the dimension after
you create it, select Properties, and deselect the Diameter Dimension option, as shown in
Figure 3.2.

FIGURE 3.2

The Dimension Properties interface
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B Diameter. You can create the dimension by selecting a complete circle and placing the
dimension. If you want a diameter dimension for an arc, use the right-mouse button
menu or Dimension Properties dialog box and select the Diameter Dimension option.

L IOTE Along with the Radial and Diameter dimensions, you may also want to dimension
- between arcs or circles, from tangent or nearest points. To do this, use the Smart
Dimension tool with the Shift key to select the arcs near the tangent points. Alternatively, to
change a dimension from a center-to-center dimension to a max-to-max dimension, you can
drag dimension attachment points to tangent points or use the dimension properties.

B Angle. You can create the angle dimension in one of two ways. If the angle to be driven is
between two straight lines, simply select the two straight lines and place the dimension. If
you are creating an included angle dimension for an arc where there are not necessarily
any straight lines drawn, then with the Smart Dimension tool active, first select the vertex
of the angle, and then the two outlying points, as shown in Figure 3.3.

FIGURE 3.3

Creating an included angle dimension

Click first

Order unimportant

B Arc Length. You can create the dimension by selecting an arc and its endpoints with the
Smart Dimension tool.

\ Line creates straight lines using one of two methods:

B Click-Click. Used for drawing multiple connected end-to-end lines. Click-and-release
the left-mouse button to start the line; each click-and-release ends the previous line and
starts a new one. Double-click, press Esc, or deselect the Line tool to end.

B Click-Drag. Used to draw individual or unconnected lines. Click, drag, and drop. The
first click initiates the line, and the drop ends it.
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Alternate methods for drawing lines include horizontal, vertical, angle, and infinite lines. The inter-
face for these options displays in the PropertyManager, as shown in Figure 3.4.

B Horizontal, Vertical. These settings require you to select a starting point, and an ending
vertical or horizontal position. There does not seem to be any compelling reason for you
to use this instead of the regular line command.

B Angle. Enables you to specify an angle and drag a line at this angle. Again, I can find no
compelling reason to use this tool.

B Infinite Lines. SolidWorks parts have a working space limited to 1000 meters on a side,
centered on the Origin. Infinite lines extend well beyond this, although you cannot draw
or dimension a regular line outside of this box. I have not come across a compelling use
for this feature.

FIGURE 3.4

The Insert Line PropertyManager interface

Crre The Add Dimensions option exists in several sketch entity PropertyManagers. This
J\J\)J—v_- obti . . .. ..
ption adds Smart Dimensions to the newly sketched entities. The option is only
shown in the sketch entity PropertyManager if the setting at Tools=> Options=> Sketch=> Enable
On Screen Numeric Input On Entity Creation is turned on.

The on screen numeric input is not the same as the Input Dimension Value function, and in fact
overrides that option. You can not input dimension values when using the Add Dimensions in
conjunction with click-drag sketching. It appears to be intended for click-click drawing only, so
that you can enter values between clicks.

Corner Rectangle creates a rectangle by clicking one corner and dragging to the diagonal corner.
D This action creates four lines with Horizontal and Vertical sketch relations, as appropriate. The
Corner Rectangle is also available as a flyout icon that also makes available a Centerpoint
Rectangle, a 3 Point Corner Rectangle (rectangle at an angle), and a 3 Point Center Rectangle, as
well as the Parallelogram, Figure 3.5 shows the flyout and all the icons on the flyout, along with
the PropertyManager for the Rectangle, which also allows you to switch types of rectangle easily.
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FIGURE 3.5

The Rectangle flyout with associated icons

Notice also the Add Dimensions box in the PropertyManager. Clicking this box while creating a
rectangle causes the software to add dimensions aligned with the sides of the rectangle. This option
is also available for lines, arcs, and circles.

Note that this option used in conjunction with the Enable On-Screen Numeric Input On Entity
Creation setting, found at Tools= Options = Sketch, can make creating sketch entities to the cor-
rect size immediately much easier.

Circle creates a circle using one of two methods, which are available from either the flyout icon or
@ the Circle PropertyManager:

B Center Creation. Click the center of the circle and drag the radius. The Circle
PropertyManager calls this function center creation.

B Perimeter Creation. To create a circle using this technique, you must select the
Perimeter Creation option from the Circle PropertyManager window after clicking the
Circle tool. There is also a separate Perimeter Creation toolbar button, and a menu selec-
tion for Tools, Sketch Entities, Perimeter Circle. This only creates tangent relations with
other entities in the current sketch, and so if you are building a circle from model edges
or entities in other sketches, you need to apply the relations manually. SolidWorks calls
these functions perimeter creation.

Tangent to Two Entities. Start the circle with the cursor near one line in the sketch.
A Tangent symbol appears by the cursor with a yellow background. Click and drag
the diameter to the second tangent entity, where a similar cursor symbol should
appear. Release the mouse button and Right-click the green check mark icon. This
process is shown in Figure 3.6.

Tangent to Three Entities. Use the same process for Tangent to two entities, but
omit the Right-click of the green check mark icon. After dropping on the second tan-
gent, drag again to the third tangent entity.
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FIGURE 3.6

Creating a perimeter creation circle

Centerpoint Arc creates an arc by clicking the center, dragging the radius, and then clicking and
dragging the included angle of the arc. The first two steps are exactly like the Center-Radius circle.

Tangent Arc creates an arc tangent to an existing sketch entity. Depending on how you move the
cursor away from the end of the existing sketch entity, the arc can be tangent, reverse tangent, or
perpendicular, as shown in Figure 3.7.

Another way to create a tangent arc is to start drawing a line {from the end of another sketch entity,
and while holding the left mouse button, to press the A key, or to return the cursor to the starting

point and drag it out again. This second method can be difficult to master, but it saves time when

compared to any of the techniques for switching sketch tools.

3 Point Arc creates an arc by first establishing endpoints, and then establishing the included arc, as
shown in Figure 3.8. Again, this tool also works using the Click-Click or Click-Drag methods.

Sketch Fillet creates a sketch fillet in one of two ways. You can either select the endpoint where the
sketch entities intersect, or you can select the entities themselves, selecting the portion of the entity
that you want to keep. Figure 3.9 illustrates both techniques. The Sketch Chamfer tool is on the
same flyout as the Sketch Fillet by default, and works much in the same way.
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FIGURE 3.7

Using the Tangent Arc feature

Original line \/ Perpendicular

Reverse tangent Tangent

FIGURE 3.8

Creating a three point arc

v

| N\

Click-Drag Click-Drag

FIGURE 3.9

Creating a sketch fillet

Select lines Select Result
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Sketch Fillets

hile the Sketch Fillet tool is easy to use, applies immediately, and may align with your way of
working in a 2D program, it is not considered best practice to use sketch fillets extensively.
Some reasons for this include:

B Large changes in the size or shape of the rest of the sketch can make the fillets cause the
feature built from the sketch to fail.

B SolidWorks (and other parametric programs as well) often has difficulty solving tangent
arcs in some situations. You may see them flip tangency or go around 270° instead of just
90°. Using a lot of fillets in a sketch can often cause trouble.

B If you want to remove the fillets temporarily, there is no good way to do this if you have
used sketch fillets.

B Sometimes feature order requires that other features, such as draft, come before the fillet.

B Sometimes a 2D fillet simply cannot create the required geometry.

Fillet features are the preferred method for creating rounds and fillets. The same can be said for
chamfers. Still, sometimes you need to use tangent arcs in sketches. You will have to decide for
yourself which way works best for you.

Centerline follows the same methods as regular lines, and is also called a construction line in some
cases. Other construction entities such as construction circles are not available directly, but you
can create them by selecting the For Construction option in the PropertyManager for any entity.

Spline draws a freeform curve. Splines may form either a single closed loop or an open loop. In
pJ either case the spline is not allowed to cross itself. You can draw a spline by clicking each location
where you want to add a control point. Figure 3.10 identifies the elements of a spline. The detail
image shows the structure of a spline handle.

Splines are used mainly for freeform complex shapes in 2D and 3D sketches, although you can also
use them for anything that you would use other sketch elements for. If you need more information
on splines and complex shape modeling, refer to the SolidWorks Surfacing and Complex Shape
Modeling Bible (Wiley, 2008).

Point creates a sketch point. Aside from limited cases of lofting to a point or using a point as a con-
straint sketch in a Fill feature, sketch points are usually used for reference or for the location of the
centerpoint of Hole Wizard features.

You can also use the sketch point as a virtual sharp. If two sketch entities do not actually intersect
because of a fillet or chamfer, selecting the two entities and clicking the Point tool creates a point at
the location where they would intersect if they were extended. This is useful for dimensioning to
the sharp. Virtual sharp display is controlled by a Document Property setting described in more
detail in Appendix B.
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FIGURE 3.10

The structure of a spline and a spline handle
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3D Sketch Plane creates a plane in a 3D Sketch. I discuss 3D Sketches in more detail in Chapter
31. By sketching on planes within a 3D sketch, you get most of the benefits and usage of 2D
sketches, and you do not have to deal with history between sketches. Before committing too much
work to this course, you should look into some of the shortcomings of 3D Planes. The planes are
treated just like another entity in the 3D sketch, which means you can assign sketch relations to
them, but it also means that they can move around within the sketch like sketch entities.

Add Relation displays a PropertyManager window that allows you to apply sketch relations. This
interface appears to be obsolete because it is easier to simply select sketch items and apply relations
via the context toolbar or in the PropertyManager window that appears automatically when you
select them; however, there are some subtle workflow-related reasons for using this tool.
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Two advantages exist to using the Add Relations dialog over simply selecting sketch entities and
adding relations. When the Add Relation PropertyManager is active, you do not need to use the
Ctrl key to select multiple entities. You also do not need to clear a selection before making a new
selection for the next relation. These two reasons sound minor, but if you have a large number of
sketch relations to apply, the workflow goes much more smoothly using this tool than the default
method.

Display/Delete Relations enables you to look through the relations in a sketch, and sort them
according to several categories. From this window, you can delete or suppress relations and replace
entities in relations.

Quick Snaps flyout allows you to quickly filter types of entities that sketch elements will snap to
when you move or create them. To access the tools, click the drop-down arrow to the right of the
toolbar button.

Mirror Entities mirrors selected sketch entities about a single selected centerline, and applies a
Symmetric sketch relation. There is also a Dynamic Mirror function that is described later in this
chapter.

Convert Entities converts edges, curves, and sketch elements from other sketches into entities in
the current sketch. When edges are not parallel to the sketch plane, the Convert Entities feature
projects them into the sketch plane. Some elements may be impossible to convert, such as a helix,
which would produce a projection that overlaps itself. Sketch entities created using Convert
Entities get an On Edge sketch relation.

Offset Entities works like the Convert Entities feature, except that it offsets the sketch to one side
or the other of the projection of the original edge, sketch, or curve. Figure 3.11 shows the interface
for this command.

The options available in the Offset Entities interface are as follows:

B Add Dimensions. Constrains offset sketch entities. Instead of the On Edge relations,
Offset Entities creates an Offset sketch relation that cannot be recreated manually.
Reverse. Changes the direction of the offset.

Select Chain. Selects continuous end-to-end sketch entities.

Bi-directional. Offsets to both sides simultaneously.

Make Base Construction. If you are offsetting sketch entities within the active sketch,
this option converts the original sketch entities to construction sketch geometry.

Cap Ends. Is available only when you have selected the Bi-directional option. Capping
the ends with arcs is an easy way to create a slot from a sketch of the centerline. This
function works with all sketch entities, and so it is not limited to straight slots. Figure
3.12 shows examples of the Cap Ends option.

-=1~ 1 The Offset Entities command may fail if the offset distance is greater than the small-
est radius of curvature, and you are attempting to offset to the inside of the arc.
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FIGURE 3.11

The Offset Entities interface

FIGURE 3.12

The results of using offset entities cap ends

90

In addition to the bi-directional offset with capped ends, SolidWorks also has slot sketch entities
for straight and curved slots, which you can find covered later in this chapter. Composite slots
(made of a combination of straight and curved sections) still require the offset method.

Trim Entities is actually several functions rolled into one, and it is an extremely powerful tool for
editing sketches. Trim Entities allows several methods for trimming, as well as extending and
deleting sketch entities. Figure 3.13 shows the PropertyManager interface for this function.
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The Trim Entities interface

B Power Trim. Trims by dragging a cursor trail over multiple entities. The entities that you
drag the cursor over are trimmed back to the next intersecting sketch entity. Each time
you trim an entity, a red box is left behind that remains until you trim the next entity. 1f
you backtrack with the cursor and touch the red box, this trim is undone. This option is
best used when you need to trim a large number of entities that are easy to hit with a
moving cursor. Figure 3.14 shows the Power Trim feature in action.

You can also use power trim to extend sketch entities along their paths by dragging the
endpoints. Regular dragging can also change the position or orientation of the rest of the
entity, but by using the Power Trim feature, you affect only the length.

FIGURE 3.14

The Power Trim feature in action
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B Corner. Trims or extends two selected entities to their next intersection. When you use
the Corner option to trim, the selected portion of the sketch entities is kept, and anything
on the other side of the corner is discarded. Figure 3.15 shows two ways that the Corner
option can work.

FIGURE 3.15

Using the Corner option

B Trim Away Inside. Trims away selected entities inside a selected boundary. The bound-
ary may consist of a pair of sketch entities or a model face (edges of the face are used as
the boundary). Only entities that cross both selected boundaries (or cross the closed loop
of the face boundary twice) can be trimmed. This option does not trim a closed loop such
as a circle, ellipse, or closed spline.

B Trim Away Outside. Functions exactly like the Trim Away Inside option, except that
sketch entities outside of the boundary are discarded. The Trim Away Inside and Outside
option are illustrated in Figure 3.16.

FIGURE 3.16

Using the Trim Away Inside and Outside options

92



FIGURE 3.17

Working with Sketches

B Trim to Closest. This is the default setting. Clicking on a sketch entity will:
Trim it back to the next entity if there is only one crossing entity.
Trim between two crossing entities if there are more than one.
Delete the entity if there are no crossing entities.

In all cases, the selected section of the entity is removed. The Trim to Closest option can
also extend by dragging one entity to another; if an intersection is possible, the first entity
is extended to the second entity. Figure 3.17 illustrates how the Trim to Closest option
functions.

Using Trim to Closest to extend

Construction Geometry toggles between regular sketch entities and construction entities.
Construction sketch entities are not used to create solid or surface faces directly; they are only used
for reference for example, revolve centerlines, extrude and pattern directions, and so forth. Be
careful with the icon for this function, because it looks almost identical to the No Solve Move icon,
especially as printed here in gray scale.

The Stretch sketch tool is intended for use in sketches where there are enough dimensions to make
a particular change difficult by changing dimensions only. It is similar in purpose and use to the
AutoCAD Stretch function because it was loosely modeled after the AutoCAD functionality. Stretch
allows you to specify a change that will change several dimensions simultaneously. Figure 3.18
shows the initial, intermediate, and final states of the sketch being stretched.

TR The main ideas to remember with the Stretch tool are that it is used to stretch
dimensioned lines, and that you need to select the lines that will lengthen or
shorten as well as the lines that will move. Because if this, selecting entities for Stretch is best
done with the right-to-left window selection, which also selects any items that the selection box
crosses. (Left-to-right window selection only selects items that are completely within the selec-
tion box.)
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FIGURE 3.18

Using the Stretch sketch tool

~. -~ ~ . Figure3.18 shows the X/Y option being used, but if you use the From/To option, be
i aware that it may delete some sketch relations along the way.

The Move, Rotate, Copy and Scale sketch tools operate on selections within a sketch. You can use
these tools with pre- or post-selection methods. These tools delete existing sketch relations when
necessary to accomplish the task. For example, if you want to move a rectangle connected to the
origin, the Move tool will delete the Coincident relation between the sketch endpoint and the
origin. If you want to rotate a rectangle, the Rotate tool will delete all of the horizontal and vertical
relations on the entities being rotated. This operation may result in a completely underdefined
sketch. SolidWorks does not warn you that sketch relations are being deleted.

%4

If you use the Scale tool on a fully defined sketch, SolidWorks will scale the position of the
selected entities, deleting sketch relations if necessary to do so, but no dimensions will be scaled or
deleted.
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FIGURE 3.19
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[ ==1 ~ 1 Becareful when using these sketch tools. They can delete sketch relations without
(7o RN AL

warning.

These sketch tools were originally put in the software to avoid some of the complexities and limita-
tions of the Modify Sketch tool, which can also move, copy, rotate, and scale sketches. Figure 3.19
shows the simple interface for the Move Entities command. Select the entities to move in the upper
box, and the method to move them below.

The Move Entities interface

DY

Select is usually used to turn off the previous command.

Grid/Snap is used to open the Grid/Snap section of Tools® Options=> Document Properties.

Parallelogram can be used to draw a parallelogram (adjacent sides are not perpendicular, but oppo-
site sides are parallel), draw the first side of the parallelogram in the same way as the first side of
the rectangle, then drag the second side; setting the angle as well as the length.

Polygon creates a regular n-sided polygon in the same way as a circle. Click the center and drag the
radius. You need to set the number of sides in the PropertyManager before clicking in the graphics
window.

Ellipse is created by clicking the center, dragging one axis, and then dragging the other axis.

Partial Ellipse is created by clicking the center, dragging one axis, dragging the other axis, and then
clicking and dragging the included angle of the partial ellipse. The Partial Ellipse feature works like
the centerpoint arc.
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FIGURE 3.20

Parabola is created by clicking the location for the Focus, and then dragging the position of the
Apex. You then click and drag the included angle of the parabola, as shown in Figure 3.20. This is
a rarely used sketch entity and is often difficult to control with sketch relations or dimensions.

Drawing a parabola
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Focus Apex Click and drag
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Click and drag

Spline on Surface is used in 3D sketches to draw a freeform spline on any 3D surface. The Spline
on Surface feature can cross face boundaries as long as the faces are at least tangent (ideally curva-
ture continuous) across the edge. Spline on Surface can be used to trim surfaces or create split
lines.

Sketch Text creates editable text in sketches using TrueType fonts installed in your Fonts folder.
Some fonts produce sketches that are unusable for solid features, due to violating sketch rules with
overlapping or zero thickness. You need to be careful which fonts you select, but I have had suc-
cess with a wide variety of fonts I have found on the Internet. Sketch Text may be dissolved into
lines and arcs so that you can edit them manually. Dissolve is available on the right-mouse button
menu. Figure 3.21 points out the key elements of the Sketch Text interface.

Intersection Curve, in 2D sketches, creates sketch entities where the sketch plane intersects
selected faces. In 3D sketches, the Intersection Curve sketch tool creates sketch entities where any
types of selected faces intersect. This can be an extremely useful tool in many situations.
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The Sketch Text interface

Curve for text to follow

Sketch text

Bold, italics, rotate

Justification

Direction and orientation
—Font width

—Spacing

used as an evaluation tool for complex surfaces, but you can also use it to create curves to rebuild
faces. Accepting the results by clicking OK creates a separate 3D sketch for each spline. Figure
3.22 shows the original surface and the results of using face curves on a complex lofted surface.

FIGURE 3.22

Using face curves on a complex surface

g Face Curves applies the underlying U-V isoparameter mesh to a selected face. It is most commonly
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Extend extends a sketch entity up to its next intersection with another sketch entity. This is not to
be confused with the Extend for surface entities.

Split Entities splits a sketch entity into two segments. You can also delete it later to rejoin the entity
back into a single segment. Closed loop entities require at least two split points.

Dynamic Mirror can be used when you preselect a centerline, and Dynamic Mirror is turned on.

& Any new sketch entity that you draw is automatically mirrored to the other side of the centerline.
The ends of the mirror line have hatch marks on them to remind you that you have mirroring
turned on.

Linear Sketch Pattern creates a one- or two-directional pattern of sketch entities. You can define
spacing and angles. Figure 3.23 shows the interface and the results of this function.

FIGURE 3.23

The Linear Sketch Pattern interface

Circular Sketch Pattern creates a circular pattern of sketch entities.
-]
n 3
You should use sketch patterns as little as possible. For much the same reasons that
fillet features are preferred over sketch fillets, pattern features are also preferred
over sketch patterns. Sketch patterns are not as editable or as flexible as feature patterns. They
solve slowly, especially when you pattern a lot of entities. Best practice is to avoid sketch pat-
terns unless there is no alternative.

= ~e A~

BEST PRACTLCE
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Make Path is intended to help create machine-design motion in sketches; in particular, cam type
motion. Although it is helpful, you do not need to make a block of the cam first. You can then
Right-click the block and select Make Path. A tangent relation to a path enables a follower to roll
around the entire perimeter.

Modify Sketch is one of my favorite sketch tools, but it has been falling out of favor in more recent
+J= versions of SolidWorks because of the improvement of tools such as Move Sketch. The Modify
Sketch feature is flexible and powerful, and enables you to move, rotate, and scale the sketch, as
well as mirror about a horizontal or vertical axis or about both axes simultaneously. Figure 3.24
shows the interface, which consists of a dialog box, a special Origin, and a context-sensitive cursor.

FIGURE 3.24

The Modify Sketch interface

Both the left- and right-mouse buttons have special functions, which change when the cursor is
moved over the three knots on the special Origin. The right-mouse button allows you to mirror or
rotate the sketch, and the left mouse button, or LMB, allows you to move the Origin or move the
sketch.

This function has some limitations when you use it with sketches that have external relations.
Certain functions may be disabled, or a warning message may appear, saying that you need to
remove external relations to get a particular function to work correctly.

No Solve Move enables the moving of sketch entities without solving any relations in the sketch. If
you select this option and you move an entity with relations that would otherwise not allow it to
move (such as a collinear relation), then you are prompted with a choice to either delete the exist-
ing relation and continue or to copy the entity without the relation. As mentioned earlier, be care-
ful with the icon for this function, since it looks almost identical to the Construction Geometry
icon, especially as printed here in gray scale.

Sketch Picture is a picture that is placed in the sketch, lies on the sketch plane, and is listed in the
E FeatureManager indented under the sketch. The sketch picture may be suppressed independently
from the rest of the sketch, and when the sketch is hidden, the picture is not visible. You can easily
move, resize, and rotate sketch pictures, as well as apply a transparent background color to them.
Sketch Pictures are usually used for tracing over or as a planar decal without the need for
PhotoWorks. Figure 3.25 shows the controls for manipulating the Sketch Picture feature.

99



m SolidWorks Basics

FIGURE 3.25

The Sketch Picture interface

100

Equation Driven Curve is a sketch spline driven by an equation, as shown in Figure 3.26. This
sketch entity type was added in SolidWorks 2009. You only need to put the right-hand side of the
equation into the box; for example, in an equation such as y = xA2+4*x, you would only enter the
x"2+4*x portion, of course making sure to use standard notation for all math operators. The x1
and x2 values are the low and high limits of the value set, and the Transform simply moves the
function from the 0,0 origin to the location where you need it to go.

Straight Slot and Curved Slot draw slots of a given width and length with full rounds on the ends.
All of the slot sketch entities can be seen in the PropertyManager shown in Figure 3.27. If you
need to draw a composite slot, or a slot with multiple entities, you will need to use the bi-direc-
tional sketch offset with capped ends mentioned earlier.

The Dimensions/Relations toolbar

The Dimensions/Relations toolbar has a few tools that you have already seen, but as the name sug-
gests, it also contains tools that will either help you to create or investigate dimensions and sketch
relations. Figure 3.28 shows the default toolbar, but in the following pages, you look at all of the
available tools that are available through Tools = Customize &> Commands = Dimensions/Relations.
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Equation Driven Curve PropertyManager

FIGURE 3.27

PropertyManager for the slot sketch entities
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FIGURE 3.28

The Dimensions/Relations toolbar

:: B Smart Dimension. Gives the user the ability to dimension the sketch entity as you sketch.

B Horizontal Dimension. Applies a dimension to a sketch entity that drives the horizontal
distance between the endpoints.

B Vertical Dimension. Works like a horizontal dimension but vertically.

B Baseline Dimensions. Creates dimensions only in drawing documents. Baseline
Dimensions are different from most of the dimension tools that you find on the
Dimensions/Relations toolbar in that they can create driven dimensions on view geome-
try, or driving dimensions on sketch geometry in a drawing, but cannot be used on
sketch geometry in parts. Baseline Dimensions start from a single reference; then as you
select additional references, additional dimensions are stacked (see Figure 3.29).

FIGURE 3.29

Baseline Dimensions on a drawing

B Ordinate Dimensions. Driving dimensions where a set of ordinate dimensions originate
from a common zero point. To use these dimensions, simply click a zero location, place
the zero dimension, and then click additional points. The dimensions are placed and are
automatically aligned to the rest of the dimensions.
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L ICTE If a line is not selected as the zero reference entity, the Ordinate Dimension feature
\ - defaults to a Horizontal Ordinate.

You can remove Ordinate Dimensions from the common alignment by Right-clicking the dimen-
sion and selecting Break Alignment. Ordinate Dimensions will jog automatically if SolidWorks
senses that the dimensions are getting too close to one another. You can also jog them manually.
After you create the Ordinate Dimension set, you can add to it by accessing the Add to Ordinate
command through the right-mouse button menu. All of these options for Ordinate Dimensions are
shown in Figure 3.30.

FIGURE 3.30

Options for Ordinate Dimensions

Not all of the listed options are available in the model sketch environment; some are available only
in drawings.

Horizontal and Vertical Ordinate Dimensions have the same function as the regular Ordinate
Dimensions, except that they only drive horizontal and vertical dimensions, respectively.

Chamfer Dimension is another type of dimension that is only driven and only applied in drawing
documents. It works by first selecting the chamfered edge and then selecting the angle reference
edge. It produces dimensions like the one shown in Figure 3.31.

Automatic Relations toggles to enable or disable the automatic creation of sketch relations while
sketching. This toggle is also available through Tools=> Sketch Settings= Automatic Relations.
Automatic relations help you to create intelligent sketches with less manual intervention. Although
using them takes a little practice, it is well worth the effort.

~. -7~ Aswith any automatic function, there are times when automatic relations will do
G things that you do not expect or want. While you are sketching, it is recommended
that you watch the cursor and the relations that it automatically applies.
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FIGURE 3.31

Applying a chamfer dimension

Select first

Select second

While sketching, symbols appear on the cursor to show that a relation will automatically be cre-
ated. These symbols have a yellow background, and will apply horizontal, vertical, coincident, tan-
gent, parallel, and perpendicular relations. Figure 3.32 shows two situations where automatic
relations are applied—a horizontal and a tangent relation.

FIGURE 3.32

Some automatic relations that appear on the cursor

AOTE Although Scan Equal shows up in the list of available tools, it never becomes active,
I - and its functionality has been absorbed into the Fully Define Sketch tool.

Inferencing in Sketch

Although Inferencing and Automatic Relations are often confused, even by experienced
SolidWorks users, these functions are not the same. Inferencing refers to the blue dotted lines that
display in Sketch mode when the cursor aligns with endpoints, centerpoints, or the Origin.
Inferencing does not create sketch relations, with one exception. If the cursor is aligned to one side
of the endpoint of another line, and you draw a horizontal line, then an automatic Coincident rela-
tion is applied between the line and the endpoint. This also holds true if the cursor starts above or
below the point and you draw a vertical line.
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When the cursor displays a small sketch relation symbol with a yellow background, this means
that an automatic relation is going to be applied. If the relation symbol has a white background,
the relation is inferenced, but not applied as an actual sketch relation. The symbols with the blue
(the color may also be green in SolidWorks 2008 or later) background are relations that have been
applied to existing sketch entities. The symbols look the same, regardless of background color. Be
aware that differences in versions and differences in color schemes can cause these colors to be
different on your system.

The following are the symbols for the various inferences, automatic relation cursors, and
applied sketch relations shown in Table 3.1. The difference between the three types is simply the
background colors: white, yellow, and blue, respectively.

TABLE 3.1

Symbols

Along X Along Y Along 7
x, il Z]

At Intersection Coincident Collinear
. of Two Faces . .
. Concentric . Coradial . Equal
. Equal Curvature . Fix . Horizontal
. Intersection - Midpoint . Offset
. On Edge . On Surface . Parallel
- Perpendicular . Pierce . Symmetric

Tangent Vertical Display/Delete

. ﬁ& Relations

Fully Define

@ Sketch

The Fully Define Sketch interface uses sketch relations and dimensions to fully define the active
sketch. It allows you to select what types of sketch relations and dimensions will be used to do
this. Figure 3.33 shows the Fully Define Sketch interface. Be careful of this icon because it looks
almost identical to the Sketch icon.
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FIGURE 3.33

The Fully Define Sketch interface

If you are familiar with older versions, the Fully Define Sketch function was formerly called Auto
Dimension, and has absorbed the functionality of Scan Equal and Add Relations. This function is
very useful when used with imported data. If you do not like the automatic dimensioning scheme,
you can at least take advantage of the automatic sketch relations.

While the Fully Define Sketch function can clearly save you a lot of time dimension-
ing parts on a drawing, it does not necessarily use the best dimensioning practice
for manufacturing drawings. This tool is best used in situations when baseline and ordinate
dimensions are appropriate.

MESTE N AT AT
BEST PRACTLCE

Exploring Sketch Settings

In addition to sketch tools, another important aspect of controlling sketches is sketch settings.
Sketch settings are found in two different locations. The first location is at Tools® Options=>
Sketch. In this chapter, I cover the settings found at the second location, Tools® Sketch Settings.
These settings mainly affect sketch relations.

Cl OSSP EE The sketch settings at Tools=> Options > Sketch are discussed in detail in Appendix

—d-dyu=l Ll g They mainly affect sketch display issues, and have some overlap with Tools >
Sketch Settings. Automatic Relations is covered in depth in the Dimensions/Relations toolbar
section.

Automatic Solve is turned on by default. As you make changes to a sketch by adding relations or
changing dimensions, SolidWorks automatically and immediately updates the sketch to reflect the
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changes. When the Automatic Solve setting is turned off, these changes are deferred until you exit
the sketch or turn the Automatic Solve setting back on. The setting can be useful to prevent
intermediate solutions (for example, when half of the changes are made) that may cause problems
with the sketch, and when you are confident that the outcome will be correct. It is a rarely used
option, and you could probably exist just fine without even knowing this option was there at all.

If you import a large drawing from the DXF or DWG formats, these drawings import as sketch
entities into either a SolidWorks sketch or a drawing. SolidWorks may automatically turn off the
Automatic Solve setting for performance (speed) reasons on files of this type.

Enable Snapping is turned on by default. It enables the cursor to snap to the endpoints of existing
sketch entities to help you make cleaner sketches. When you turn this setting off, Automatic
Relations is also disabled (although the icon for the setting remains depressed, Automatic Relations
are not created). Holding down the Ctrl key while sketching disables snapping. Holding down the
Ctrl key while dragging sketch entities will function like copying sketch geometry. No Solve Move
is discussed in the Sketch toolbar section.

Detach Segment on Drag is turned off by default. When you turn this setting on, the Detach
Segment on Drag feature enables you to pull a single sketch element away from a chain of ele-
ments. For example, if you have a rectangle and you want to detach one of the lines from the rest
of the rectangle, without using this setting, you would have to draw extra geometry and then trim
and delete lines in order to release the endpoints.

T URACTIOLE It is recommended that you leave this setting off. Turn it on only when you need it,
FaAool and then immediately turn it off again. This setting can be hazardous for everyday
use, because it enables you to simply drag sketch elements that may be otherwise fully defined.

Override Dims on Drag is off by default. When you turn this setting on, it enables you to drag fully
defined sketch geometry, and the dimensions will update to match the dragged size. This is
another setting that you should use sparingly. It can be useful for doing concept work, but you
should leave it off when working with production data for obvious reasons.

JOSTE Combining Override Dims on Drag with Instant3D (formerly Move/Size Features)
! - can be very handy for concept work.

Using Sketch Blocks

Sketch blocks are collections of sketch entities that can be treated as a single entity. You can use
sketch blocks in parts, assemblies, and drawings. To create a sketch block, select a group of sketch
entities and click the Make Block button on the Blocks toolbar, or select Tools= Blocks > Make.
Preselection is not necessary, you can also select the entities after you invoke the command.
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Blocks may be internal to a particular document, or they may be saved as an external file. The
externally saved block may be linked to each document where it is used, so that if the block is
changed, it updates in the documents where it is used.
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You can use blocks in conjunction with the Make Path function mentioned earlier in this chapter
to create functional layouts for mechanisms. You can also use blocks in an assembly to build parts
in-context. Refer to Chapter 12 for a more in-depth examination of the assemblies aspects of
blocks in SolidWorks.

The following is a description of the various tools that are available on the Blocks toolbar:

Make Block. Creates a sketch block from selected sketch entities. You can position a
manipulator to denote the insertion point for the block. Blocks may attach at any entity
endpoint, but the insertion point follows the cursor.

Edit Block. Enables you to edit an existing block as if it were a regular sketch.

Insert Block. Allows you to select from a list of open blocks or browse to a location where
blocks are stored. You can edit the insertion point by using the Edit Block function.

Add/Remove. Allows you to add or remove sketch entities from the block without delet-
ing them from the sketch while editing a block.

Rebuild Block. Allows changes to a block to be reflected in any external relations with-
out exiting the block. For example, if you have a block in a sketch, and a sketch line is
coincident to one of the endpoints in the block, you may edit the block such that the ref-
erenced endpoint moves. As a result, the line in the sketch will not move until you either
exit the block or use the Rebuild Block function.

Save Block/Save Sketch As Block. Saves a selected block to an external file (with the
* sldblk extension), or saves the selected sketch as a block.

Explode Block. Removes all of the sketch entities from a block and brings them into the
current sketch.

Belt/Chain. Enables you to make a belt or chain around a set of pulleys. Each pulley
must be a block. After activating the command (by right-clicking on a sketch or block),
you can select each pulley and use the arrow on the pulley to switch the side of the pulley
to which the belt goes. You can also compensate for the thickness of the belt (this is
important when both sides of the belt are in contact with pulleys), and drive the pulley
arrangement using the length of the belt. Figure 3.34 shows the Belt/Chain dialog box.
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The Belt/Chain dialog box

Tutorial: Learning to Use Sketch Relations

While it is useful to read through the definitions and functions of all of the sketch entities, tools,
and relations, using your mouse to create is what this is all about. This tutorial makes sure that you
get to know all of the major functions in SolidWorks sketches. Almost every part that you build
will start with a sketch, so this is a skill worth mastering. Follow these steps to learn about sketch
relations:

1. Open a new part using a template that you set up in the Template tutorial from
Chapter 1. If you do not have this template, there is one provided for you on the
CD-ROM named BibleInchTemplate.prtdot. Copy it to your templates folder and
use it to create a new part. You may also use a SolidWorks default template.

2. Select the Front plane in the FeatureManager, and click the Sketch button on the
Sketch toolbar. Click the Line tool from the Sketch toolbar.

3. Move the cursor near the Origin; the yellow Coincident symbol appears.
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4. Draw a line horizontal from the Origin. Remember that there are two ways to sketch

the line: Click-Click or Click-Drag. Make sure that the line snaps to the horizontal and
that there is a yellow Horizontal relation symbol. The PropertyManager for the line
should show that the line has a Horizontal relation. Also notice that the line is black, but
the free endpoint is blue (after you hit Esc twice to clear the tool, then clear the selec-
tion). This means that the line is fully defined except for its length. You can test this by
dragging the blue endpoint.

Click the Smart Dimension tool on the Sketch toolbar, use it to click the line that
you just drew, and place the dimension. If you are prompted for a dimension, type
1.000. If not, then double-click the dimension; the Modify dialog box appears, enabling
you to change the dimension. The setting to prompt for a dimension is found at
Tools= Options & General, Input Dimension Value.

Draw two more lines to create a right triangle to look like Figure 3.35. If the sketch
relations symbols do not show in the display, turn them on by clicking View &> Sketch
Relations. You may want to set up a hotkey for this, because having sketch relations is
useful, but often gets in the way. Note that the sketch relation symbols may also be green,
depending on how your software is installed.

FIGURE 3.35

Draw a right triangle.

Drag the blue endpoint of the triangle. Dragging endpoints is the most direct way to
change the geometry. Dragging the line directly may also work, but this sometimes pro-
duces odd results. The sketch leaves a ghost when dragging so that you can see where
you started. Note that the setting for leaving a ghost when dragging a sketch is found at
Tools= Options &> Sketch, Ghost Image On Drag,.

Click the Smart Dimension tool, and then click the horizontal line and the angled line.
This produces an angle dimension. Place the angle dimension and give it a value of 30°.

Click the Sketch Fillet tool, set the radius value to 0.10 inches, and click each of the
three endpoints. Where the 1.000-inch dimension connects to the sketch, SolidWorks
has created virtual sharps. Figure 3.36 shows the sketch at this point. You may now want
to turn off the Sketch Relations display because the screen is getting pretty busy. You can
find this setting at View=> Sketch Relations.
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FIGURE 3.36

The resulting sketch after you perform Step 9

Draw a line starting from the midpoint of the angled line. The midpoint should
highlight when you move the cursor close to it. Draw the line perpendicular to the angled
line. A dotted yellow line appears, showing where the perpendicular lies. When you
follow this line, the yellow perpendicular symbol appears on the cursor. Make this line
approximately .25 inches long. Feedback on the cursor also shows the length of the line
as you draw it.

Draw two more lines ending at the endpoint of the sketch fillet, as shown in Figure
3.37. Use the Inferencing lines to line up the second angled line with the end of the arc.

Click the Trim tool from the Sketch toolbar. Make sure that the Trim option is set to
Closest. Click the angled line of the triangle between the two lines sketched in Step 11.
This trims out that section, and makes the sketch a single closed loop. A warning may
appear because you have a Midpoint relation to the line being trimmed, and you no lon-
ger want this relation, but you want the lines to intersect at their endpoints. Select Yes at
the prompt.

FIGURE 3.37

The resulting sketch after you perform Step 11
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13. Click the Smart Dimension tool. Use it to create aligned dimensions on the short line
(.25 inches) and one of the long lines (.125 inches). You may now want to reorganize
some of the dimensions if the display is becoming crowded.

14. At this point, two of the lines should be blue, but it may not be clear why they are
not defined. Select one of the blue lines and drag it. Notice that what changes is the arc
nearest the Origin. This changes in a way that is not useful for this part. To lock this line
where it needs to be, select the blue line nearest the Origin and the centerpoint of the arc
nearest the Origin, and give them a Coincident relation in the PropertyManager. The
result is a fully defined sketch, as shown in Figure 3.38.

15. Save the part with the name Sketch Relations Tutorial.sldprt. Close the
part.

FIGURE 3.38

The resulting sketch after you perform Step 14

Tutorial: Using Blocks and Belts

Sometimes I am amazed at the things that can be done in SolidWorks, even with fairly simple
tools. This is one of those times. If you design machines, then this tutorial will have some extra
meaning for you. If you do not design machines, then these are still valuable tools to have in your
toolbox ready to use in various situations. Follow these steps to learn about using Blocks and Belts.

Open a new part with inches as the units.

2. Draw a sketch on the Front plane as shown in Figure 3.39, with four lines con-
nected to the Origin. Exit the sketch and rename it Layout Sketch, either by clicking
twice on the name of the feature in the FeatureManager or by selecting it and pressing F2.

3. Open a second sketch on the Front plane, and draw a circle centered on the Origin
with a 6-inch diameter.
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The layout sketch

4. Inside the circle, draw a Centerpoint rectangle centered on the Origin.

5. Select two adjacent sides of the rectangle and make an Equal sketch relation
between them (this makes the rectangle into a square).

The CD-ROM for Chapter 2 contains a macro that automatically draws a rectangle
that is centered on the Origin.

On e CD-200Y]

6. Click the Smart Dimension tool, and apply a 1.000-inch dimension to one side of
the square. Turn off the Smart Dimension tool by clicking it again on the toolbar or
pressing Esc.

7. 1If the Blocks toolbar is not active, then activate it and select Make Block. You can
also access this command through Tools=> Block &> Make.

8. Window select the circle and the square by clicking and dragging a box that
includes all of the items in the sketch. The PropertyManager to the left displays a circle
and five lines that are to be made into a block.

b

Expand the Insertion Point panel in the PropertyManager. This causes a blue manipu-
lator Origin to appear in the graphics window. Click this Origin and drag it onto the cen-
ter of the circle. Then click the green check mark icon to exit the Make Block dialog box.
This is shown in Figure 3.40.

10. The items in the block now turn gray. Click anywhere on the block and drag it out of
the way. Then drag the center of the circle and drop it on the part Origin.

11. Click the Insert Block tool on the Blocks toolbar. Place the block on the opposite
sharp corner of the layout sketch.
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FIGURE 3.40

Creating a block

12. Create another block that is identical to the first one, except that it has a diameter
of 3 inches instead of 6 inches. You can do this by selecting the first block, clicking
Edit Block from the toolbar, and copying (window select and Ctrl+C). Then exit the Edit
Block and paste (Ctrl+V) in the regular sketch. Make sure to also change the insertion
point for this second block to the center of the circle.

13. Insert a second instance of this second block, and make sure that both of them have
the center of the circle at the two remaining intersection points of the four-sided
shape of the layout sketch. At this point, your sketch should look like Figure 3.41.

FIGURE 3.41

Block placement
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Click the Belt/Chain tool on the Blocks toolbar. Select the blocks in counterclockwise
order, starting at the Origin. On the last pulley, you will have to click the arrow to get the
belt to go the correct way around the pulley.

Make sure that the Engage Belt option is selected. This allows you to make the pulleys
move in the same way that they would in a real belt-driven mechanism.

Click the Use Belt Thickness option, and assign .25 inches for the thickness. The
belt should be offset from the pulleys.

Click the green check mark icon.

Click and drag one of the corners of the square in a pulley. All of the pulleys should
turn as if this were a real mechanism. The ratios are also observed because the small pul-
leys rotate faster than the large ones.

Save this part as Blocks and Belts Tutorial.sldprt. Exit the part.

Summary

Sketching in SolidWorks is something that you will do almost every time you open the software.
There are a lot of automated functions available that you can allow to do much of the work for
you. You also have a lot of control to make changes manually. Remember that the best way to cre-
ate most sketches is to make use of automatic relations when you can, sketch the approximate
shape that you want to make, then either drag it to pick up automatic relations, add dimensions,
or add relations manually.

The options for creating intelligent relationships that establish your design intent, as well as
SolidWorks’ capabilities in laying out mechanisms, is only limited by your imagination. The more
familiar you become with the tools in your toolbox, the more of a craftsman you can become with
this software.
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Creating Simple Parts,
Assemblies, and Drawings

hen you begin to build a model in SolidWorks, there are a few

things to consider before you start. If you spend some time con-

sidering what you are doing first, then it will benefit you later in
the process. Good modeling practice is based on robust design intent, which
just means that you build a part that can adapt easily to changes. This sec-
tion begins with questions that you need to ask.

Beginning to create simple parts will help you understand techniques used in
more complex modeling projects. Learning on simple tools and then
expanding your skills helps you to understand best practice issues, which
makes you a better contributor to a team environment.

Discovering Design Intent

By asking questions about the part’s function before you start modeling or
designing, you can create a model that will be easier to edit, easier to prop-
erly place into an assembly, easier to detail in drawings, and easier for other
SolidWorks users to understand when someone else has to work on your
models. Sometimes you will be able to find answers for the questions, and
other times not. Whether you are doing the modeling for someone else, or
doing the design and modeling for yourself may make a difference in how
you approach the modeling task.

The purpose of these questions is to help you establish design intent. The
term design intent is a statement of how the part functions and how the
model reacts to modeling changes.
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It may help if you try to put the design intent into words to help you focus on what is important in
the design. An example of a statement of design intent might be: “This part is symmetric about two
planes, is used to support a 1.00" diameter shaft with a constant downward load of 150 pounds
using a bronze bushing, and is bolted to a plate below it.” This does not give you enough informa-
tion to design the part, but it does give you information about two surfaces that are important (a
hole for the bushing and the bottom that touches the mounting plate), as well as some general size
and load requirements. The following questions can help you develop the design intent for your
own projects.

Is the part symmetrical?

Symmetry is an important aspect of design intent. Taking advantage of symmetry can significantly
reduce the time needed to model the part. Symmetry can exist on several levels:

Sketch symmetry

Individual feature symmetry

Whole-part symmetry

Axial symmetry (a revolved part)

“Almost” symmetry (the whole part is symmetrical, except for a few features)

Left and right symmetrical versions of the part

The assembly may be symmetrical

What are the primary or functional features?

This is probably the most important question. Primary or functional features include how the part
mounts or connects to other parts, motion that it needs to accommodate, and additional structure
to support loads.

Often it is a good idea to create a special sketch as the first feature in the part that lays out the
functional features. This could be as simple as a straight line to denote the bottom and a circle to
represent the position and size of a mating part, or as complex as full outlines of parts and features
from all three standard planes. This technique is called a layout sketch, and it is an important tech-
nique in both simple and complex parts. You can use layout sketches for anything from simply
drawing a size-reference bounding box to creating the one point of reference for all sketched
features in the part. You can use multiple layout sketches if a single sketch on one plane is not
sufficient.

In what ways is the part likely to change?

When the marketing department gets out of their meeting at 4:45 pm, what changes do you need
to be prepared for so that you can still be out the door by 5:00 pm? No one expects you to be able
to tell the future, but you do need to model in such a way that your model easily adapts to future
changes. As you gain experience with the software, and you keep this idea in mind, then you will
develop some instincts for the type of modeling that you do.
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What is the manufacturing method?

Modeling for the casting process is very different from modeling for the machining process. When
possible, the process should be evident in your modeling. There are times when you will not know
which process will be used to create the part when you start to create a model. If you are simply mak-
ing an initial concept model, then you may not need to be concerned about the process. In these
cases, it may or may not be possible to reuse your initial data if you need to make a detailed cast part
from your non-process-specific model. Decisions like this are usually based on available time, how
many changes need to be made, and a determination of the risk of making the changes versus not
making the changes, as well as which decision will cost you the most time in the long run.

Sometimes it makes sense to allow someone else to add the manufacturing details. A decision like
this depends on your role in the organization, and your experience with the process compared
with that of other people downstream in the manufacturing process. For example, if you are not
familiar with the Nitrogen Gas Assist process for molding polypropylene, and you are modeling a
part to be made in that process, you might consider either soliciting the help of a tooling engineer
or passing the work on to someone else to add engineering detail.

TURACTICL As engineers, we are typically perfectionists. However, there always needs to be a

I balance between perfection and economy. Achieving both simultaneously is truly a
rare event. Still, you should be aware that problems left by the designer for other downstream
applications to solve (such as machining, mold making, and assembly) also have an impact on
the time and cost of the project.

The best practice in this case is a judgment call. When faced with assembling a model sloppily or
remodeling it perfectly, I usually choose to remodel because doing it the second time is always
faster. Also, if additional changes are required, then you do not need to struggle with the slop-
pily assembled model. You can easily copy sketches from one part to another, while keeping the
old part open as you build the new part. As a result, you may be surprised how quickly things go.

Will there be secondary operations?

When working with any manufacturing process, some secondary processes are generally required.
For example, if you have a cast part, then you may need to machine the rough surface to create a
flat face in some areas. You may also need to ream or tap holes. In plastic parts, you may need to
press in threaded inserts.

There are some special tools in SolidWorks that you can use to document secondary operations:

B A technique called Configurations in SolidWorks allows you to create different versions of
a part. For example, one configuration may have the features for the secondary opera-
tions suppressed (turned off), and showing just the part as cast, while the other configu-
ration shows the part as machined.

Chapter 10 discusses configurations and feature suppression in depth.
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FIGURE 4.1

B A technique called Insert Part allows you to use one SolidWorks part as the starting point
for a second part. For example, the as-cast part has all of the features to make the part,
but it is inserted as the first feature in the as-machined part, which adds the cuts required
by the machining process.

Will there be other versions?

Sometimes there are size-based versions of parts that have to be created or versions based on addi-
tional features. If these are fairly simple, they can also be handled with configurations, but you
need to plan this flexibility in advance.

Creating a Simple Part

In this section, I'll show you how to build the simple part shown in Figure 4.1. While the shape is
simple, the techniques used and discussed here are applicable to a wide variety of real-world parts.

A simple machined part
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Where to start?

When you start creating a new part from a template and are confronted with the blank screen with
only the part Origin showing, the question of where you should begin first comes to mind. Of
course, it depends on the shape and function of your part, but for the time being, you can assume
that you are working with the rectangular part (refer to Figure 4.1).
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The first feature that you create should be positioned relative to the Origin. Whether there is a cor-
ner of a rectangle that is coincident to the Origin, the rectangle is centered on the Origin, or
dimensions are used to stand the rectangle off from the Origin at some distance, you need to lock
the first feature to the Origin.

When working with a simple patrt, the entire part can be described as rectangular or cylindrical. In
these cases, it is easy to know where to start: you simply draw a rectangle or a circle, respectively.
On complex parts, it may not be obvious where to start, and the overall part cannot be said to have
any simple shape. In cases like these, it may be best to select the (or a) prominent feature, mount-
ing location, functional shape, or focus of the mechanism. For example, if you were to design an
automobile, what would you designate as the 0,0,0 Origin? The ground may be a reasonable loca-
tion, or the plane of the centers of the wheels. Much of the automotive industry uses the center of
the end of the crankshaft in the engine as the assembly Origin. That may seem arbitrary, but as
long as everyone working on the vehicle agrees, it is as good a location as any. With that in mind,
it seems logical to start the rectangular part by sketching a rectangle. Select the Top plane, and
sketch a rectangle centered on the part Origin.

Symmetry

The next decision is about part symmetry. This part is not completely symmetrical, and so model-
ing a quarter of it and mirroring the entire model twice is not going to be the most effective tech-
nique. Instead, you should build the complete part around the Origin, and mirror individual
features as appropriate. To start with this type of symmetry, you need to sketch a rectangle cen-
tered on the Origin. The centered rectangle is something that you will create frequently. In
SolidWorks versions prior to 2008, there was no Centerpoint Rectangle sketch entity; you had to
draw a rectangle and manually center it with construction geometry.

Figure 4.2 shows two common techniques for centering a rectangle on the Origin when you have
to do it manually. You can use the sketch relation symbols to identify the relations that have been
applied to this sketch.

FIGURE 4.2

Centered rectangle on the Origin
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TR To make a rectangle work like a square, use an Equal sketch relation on two adja-
cent sides. This only requires a single dimension to drive the size of the square.

Beginning with the rectangle that you sketched in the previous section, apply one horizontal
dimension (4.00 inches) and one vertical dimension (6.00 inches). The sketch is fully defined at
this point because both the size and position of the rectangle have been established.

Leer e, ~- ~- lf youaredimensioning a horizontal line, the best way to do it is to simply select the

BEST PRACTICE line and place the dimension. Selecting the line endpoints can also work, but
selecting the vertical lines on either side of the horizontal lines is not as robust. The problem is
that if you use this third method, deleting either of the vertical lines causes the dimension to also
be deleted. In the first two dimensioning methods, dimensions are not deleted unless you
remove one of the endpoints, which requires deleting two lines: the horizontal line and one of
the vertical lines.

Make it solid

Next, click Extrude from the Features toolbar, or click Insert= Boss/Base = Extruded. In the
Direction 1 panel, select Mid Plane as the end condition. SolidWorks takes the distance that you
entered and extrudes it symmetrically about the sketch plane. Enter 1.00 inch as the distance.

Extrude Feature Options

he Extrude feature is one of the staples of SolidWorks modeling. Depending on the type of mod-
eling that you do, the Extrude feature may be one of your main tools.

The Extrude interface
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From

The From panel establishes where the Extrude feature starts. By default, SolidWorks extrudes from
the sketch plane. Other available options are:

B Surface/Face/Plane. The extrude begins from a surface body, a face of a solid, or a refer-
ence plane.

Extruding from a surface

ClPOSSEF Surface features are discussed in detail in Chapter 27.

B Vertex. The distance from the sketch plane to the selected vertex is treated as an offset
distance.

B Offset. You can enter an explicit offset distance, and you can also change the direction of
the offset.

Direction 1 and Direction 2

Direction 1 and Direction 2 are always separated by 180 degrees. Direction 2 becomes inactive if
you select Mid Plane for the end condition of Direction 1. The arrows that display in the graphics
window show a single arrow for Direction 1 and a double arrow for Direction 2. For the Blind end
condition, which is described next, dragging the arrows determines the distance of the extrude.

Each of the end conditions is affected by the Reverse Direction toggle. This toggle simply
|{%f | changes the default direction by 180 degrees. You need to be careful when using this feature,
~ particularly when using the Up to end conditions, because if the entity that you are extruding
up to is not in the selected direction, then an error results.

Following is a brief description of each of the available end conditions for the Extrude feature:

B Blind. Blind in this case means an explicit distance. The term is usually used in conjunc-
tion with holes of a specific depth, although here it is associated with a boss rather than a
hole.

continued
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continued

Up to Vertex. In effect, Up to Vertex works just like the Blind end condition, except that
the distance is parametrically controlled by a model vertex or sketch point.

Up to Surface. Up to Surface could probably be better named Up to Face, because the
end does not necessarily have to be an actual surface feature. This end condition may
display a warning if the projection of the sketch onto the selected face extends beyond
the boundary of the face. In that case, it is advisable to knit several faces together into a
surface body and to use the Up to Body end condition.

Offset from Surface. By default, Offset from Surface extrudes until it reaches a specified
distance from a selected surface. There are two methods for determining the type of offset
and one to determine direction.

B The default offset method behaves as if the selected surface were offset radially, so that
a surface with a 4-inch radius and a 1-inch offset would give a curvature on the end of
the extrude of a 3-inch radius.

B The second method, called Translate Surface, behaves as if the surface were moved by
the offset distance.

Offset from surface using the default and Translate Surface options
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B Reverse Offset refers to when the offset stops short of the selected face or when it goes
past it.



Creating Simple Parts, Assemblies, and Drawings _

The Reverse Offset option

B Up to Body. The Up to Body end condition is very useful in many situations, especially
when receiving the error message, “The end face cannot terminate the extrusion,” from
the Up to Face end condition.

B Mid Plane. The Mid Plane end condition eliminates the Direction 2 options and divides the
extrude distance equally in both directions, so that if you specify a 1.00-inch Mid Plane,
then SolidWorks extrudes .50 inches in one direction and .50 inches in the other direction.

W Through All. The Through All end condition is available only when there is already solid
geometry existing in the part. When used for an extruded boss (which adds material), it
extrudes to the distance of the farthest point of the solid model in a direction perpendicu-
lar to the sketch plane. When used for a cut, it simply cuts through everything.

W Up to Next. Up to Next extrudes the feature until it runs into a solid face that completely
intercepts the entire sketch profile. If a portion of the sketch hangs over the edge of the
face, the extrude feature will keep going until it runs into a condition that matches that
description, which may be the outer face of the part in the direction of the extrusion.

By default, the Direction of Extrusion is normal to the sketch plane, but you can also select a linear
entity such as an edge or axis as the direction. All of the end-condition options are still available
when you manually define the Direction of Extrusion as something other than the default.

continued
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continued

The Up to Next end condition used with a Cut extrude

You can also assign a draft option to an extrusion as it is created, and you can control the draft
separately for Direction 1 and Direction 2.

BEST PRl When dealing with molded or cast parts, certain types of features, such as draft, fil-

DIVl PXA. lets, and shells, are often the targets of users trying to assign best practices. This is
partially because using draft, fillets, and shells is very much like playing Rock, Paper, Scissors; you
can never really win this game except by luck. Arranging the features in the correct order so that
the model is efficient and achieves the desired results is challenging and resistant to definition by
rules that apply in most situations. It is usually best to apply draft as a separate feature rather than
using it in the definition of the Extrude feature. It is also best to apply draft after most of the model-
ing is done, but before you apply the cosmetic fillets and before using the shell feature.

Thin Feature

The Thin Feature panel is activated by default when you try to extrude an open loop sketch (a sketch
that does not fully enclose an area). The end-condition options remain the same, but what changes
is that the feature applies a thickness to the sketch elements, in the manner of a sheet metal, thin-

walled plastic part, or a rib. The Thin Feature panel of the Extrude PropertyManager, along with a
representative thin feature extrusion.

The Thin Feature panel and a thin feature extrusion
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The Cap Ends option is available only when you specify a Thin Feature to be created from a closed
loop sketch. This creates a hollow, solid body in a single step. You can also use Thin Features with
cuts, and they are very useful for creating slots or grooves.

Contour Selection

SolidWorks works best when the sketches are neat and clean, when nothing overlaps, and when
there are no extra entities on closed loops. However, when you need to use a sketch that does not
meet these criteria, you can use an alternative method called Contour Selection.

Contour Selection enables you to select enclosed areas to for features, regardless of how many nor-
mal sketch rules the rest of the sketch violates.

It is my opinion that this feature was introduced into SolidWorks only to keep up
with other CAD packages, not because it is a great feature. | do not recommend
using Contour Selection on production models. It is useful for creating quick models, but the
selection is too unstable for any data that you may want to rely on in the future. The main
problem is that if the sketch changes, the selected area may also change, or SolidWorks may
lose track of it entirely.

BEST PRACTLCE

Instant 3D

Starting in Solidworks 2008, SolidWorks introduced functionality called Instant 3D. Instant 3D
allows you to drag sketches to create extrusions and to drag model faces to change the size and
location of features. The function largely replaces and expands on the older functionality called
Move/Size Features. Figure 4.3 shows the arrows added by Instant 3D, which are the handles that
you pull on to create a solid from a sketch or edit an existing feature. Notice also that you can
make cut features with Instant 3D. In fact, you can change a boss feature into a cut. I'm sure this is
a neat sales demo trick, but I'm not aware of any practical application of changing a boss into a cut.

One of the attractive things about Instant 3D is that it allows you to make changes to parts quickly
without any consideration for how the part was made. For example, the cylindrical part was made
from a series of extrudes, with a hole cut through it with draft on the cut feature. The flat faces can
be moved, and the cylindrical faces offset. SolidWorks, behind the scenes, figures out which
sketches of which features have to be edited, which saves you time searching the FeatureManager.
As you work through more complex parts, you will see how handy this can be at times. You can
activate or deactivate Instant 3D using the icon on the Features toolbar.

L ICSTE When combined with the sketch setting Override Dims On Drag, Instant 3D can be
A - a powerful concepting tool, even on fully dimensioned sketches.

Instant 3D also offers a tool called Live Section. Live Section allows you to section a part with a

plane, and you can drag the edges of the section regardless of which features the edges belong to.

To activate Live Section, right-click on a plane that intersects the part, and select Live Section.
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FIGURE 4.3

Using Instant 3D and Live Section
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Making the first extrude feature

By centering the sketch on the Origin and extruding by using a Mid Plane end condition, the initial
block is built symmetrically about all three standard planes, with the part Origin at the center. In
many parts, this is a desirable situation. It enables you to create mirrored features using the stan-
dard planes, and also helps you to assemble parts together in an assembly later, when parts must
be centered and do not have a hard face-to-face connection with other parts. Figure 4.4 shows the
initial feature with the standard planes.
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FIGURE 4.4

An initial extruded feature centered on the standard planes

T\J QJ- e When you create a feature from a sketch, SolidWorks hides and absorbs (con-
\ - sumes) the sketch under the feature in the FeatureManager, so you need to click
the plus sign next to the feature to see the sketch in the tree. You can right-click the sketch in
the FeatureManager to show it in the graphics window.

The next modeling step is to create a groove on the back of the part. How is this feature going to
be made? You can use several techniques to create this geometry. List as many techniques as you
can think of, whether or not you know how to use them. Later, I will go through which techniques
work and which do not.

TR One of the secrets to success with SolidWorks, or indeed any tool-based process, is
to know several ways to accomplish any given task. By working through this pro-
cess, you gain problem-solving skills as well as the ability to improvise when the textbook
method fails.

Figure 4.5 shows multiple methods for creating the groove. From the left to the right, the methods
are a thin feature cut, a swept cut, and a nested loop sketch.

Another potential option could include a large pocket being cut out, with a boss adding material
back in the middle. Each one of these is most appropriate in different situations. The thin feature
cut is probably the fastest to create, but also probably the least commonly used technique for a fea-
ture of this type. Most users tend to use the nested loop option (one loop inside another).
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FIGURE 4.5

Methods for creating the groove
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Relative size or direct dimensions?

You can control the size of the rectangle as an offset from the edges of the existing part or you
could drive the dimensions of the rectangle independently. Again, this depends on the type of
changes you anticipate. If the groove will always depend on the size of the part then the decision is
easy. If the groove changes independently from the part, you will need to recreate relations within
the sketch to reflect different design intent. To create a groove, you can create a rectangle by offset-
ting the block shape, and use sketch fillets to round the corners.

Creating the offset

There is one more thing to consider before you create the sketch. What should you use to create
the offset: the actual block edges or the original sketch? The answer to this is a Best Practice type
issue.

5.~ ~- When creating relations that need to adapt to the biggest range of changes to the

PRACTLCE model, it is best to go as far back in the model history as you can to pick up those
relations. In most cases, this means creating relations to sketches rather than to edges of the
model. Model edges can be fickle, with the use of fillets, chamfers, and drafts. The technique of
relating features to driving layout sketches and reference geometry is called horizontal model-
ing, and it helps you create models that do not fail through the widest range of changes.

This best practice tip will become more significant the first time you create a feature built from
model edges, and then make changes that break relations.

To create the offset for your part, follow these steps:

1. Open a sketch on the face of the part. To create the offset, expand the Extrude feature
by clicking the plus icon next to it in the FeatureManager so that you can see the sketch.
Regardless of how it displays here, this sketch appears before the extrude in the part his-
tory. RMB (right mouse button) click the sketch and select Show.
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TR You can view individual sketches and reference geometry entities such as planes
from the RMB menu. The global settings for the visibility of these items are found in
the View menu. You can access these items faster by using the View toolbar, or by linking the
commands to hotkeys.

2. Next, RMB click the sketch in the graphics window and click Select Chain. This
selects any non-construction, end-to-end sketch entities. Click Offset Entities on the
Sketch toolbar. Offset to the inside by .400 inches. Apply .500-inch sketch fillets to each
of the corners.

3. Click Extruded Cut on the Feature toolbar. By default, the extruded cut will cut away
everything inside the closed profile of the sketch. Look down the FeatureManager win-
dow and click the check box on the top bar of the Thin Feature panel. Make the cut
Blind, .100 inch. The Thin Feature type should be set to Mid Plane with a width of .400
inches. The PropertyManager and graphics window should look like Figure 4.6.

FIGURE 4.6

Creating the groove

Sketch techniques

Although the next two features could be more easily and efficiently created by using a cut, I will
create them as two extrudes. The main point here is to show some useful sketch techniques, rather
than optimum efficiency. Begin with the part from the previous section and follow these steps:

1. Open a new sketch on the large face opposite from the groove. Draw a rectangle pick-
ing up the automatic coincident relation to one corner and then dragging across the part
and picking up another coincident to the edge on the opposite side. Figure 4.7 shows the
rectangle before and after this edit.
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If you want to continue using the recommended best practice mentioned earlier of
making relations to sketches rather than model edges, here are a few tips. In some

situations (such as the current one) the sketch plane is offset from the sketch that you want to
make relations to, and so the best bet is to use the Normal To view. The next obstacle is making
sure that automatic relations pick up the sketch rather than the edge, and so you can use the
Selection Filter to only select sketch entities.

2. Delete the Horizontal relation on the line that is not lined up with an edge. This

enables you to drag it to an angle or apply the dimensions shown.
Extrude sketch to a depth of 0.25 inch.

FIGURE 4.7

Edits to a rectangle

Automatic Automatic
coincident relation coincident relation

Delete
horizontal relation

You can delete the Horizontal relation by selecting the icon on the screen. As a reminder,
you can show and hide the sketch relation icons from the View menu. You can check to
ensure that the relations were created to the sketch rather than the model edges by click-
ing the Display/Delete Relations button on the Sketch toolbar, clicking the relation icon
to check, and expanding the Entities panel in the PropertyManager. The Entities box
shows where the relation is attached to, as shown in Figure 4.8. In this case, it is a point
in Sketchl. Without custom programming, there is no way to identify items in a sketch
by name, but you already know which point it is; you just needed to know whether it
was in the sketch or on the model.
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FIGURE 4.8

The Display/Delete Relations dialog box

The second sketch trick involves the use of a setting. Before you try this, go to
Tools= Options = Sketch, and ensure that Prompt To Close Sketch is turned on; then
click OK to close the dialog box.

Open another new sketch on the same face that was used by the last extrusion.
Draw an angled line across the left and bottom sides of the box, with the dimensions
shown in Figure 4.9. In this case, for this technique to work, the endpoints of the line
have to be coincident with the model edges rather than the sketch entities.

This line by itself constitutes an open sketch profile, meaning that it does not enclose an
area, and has unshared endpoints. Ordinarily, this results in a Thin Feature, as described
earlier, but when the endpoints are coincident with model edges that form a closed loop,
and the setting mentioned previously is turned on, SolidWorks automatically gives you
the option of using the model edges to close the sketch. This saves several steps when
compared to selecting, converting, and trimming manually.

Click the Extrude tool on the Features toolbar. Answer Yes to the prompt, and dou-
ble-click the face of the previous extrusion. SolidWorks automatically uses the face that
you double-clicked for an Up to Surface end condition. This is a simple way of linking
the depths of the two extrusions automatically. Again, this entire operation could have
been handled more quickly and efficiently with a cut, but these steps demonstrate an
alternative method, which in some situations may be useful.
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FIGURE 4.9

Using the prompt to close a sketch setting

Hole Wizard

The next features that you will apply are a pair of counterbored holes. SolidWorks has a special
tool that you can use to create common hole types, called the Hole Wizard. The Hole Wizard helps
you to create standard hole types using standard or custom sizes. You can place holes on any face
of a 3D model or constrain them to a single 2D plane or face. A single feature created by the Hole
Wizard may create a single or multiple holes, and a feature that is not constrained to a single plane
can create individual holes originating from multiple faces, non-parallel, and even non-planar faces
(holes may go in different directions). All holes in a single feature that you create by using the Hole
Wizard must be the same type and size. If you want multiple sizes or types, then you must create
multiple features.

To apply counterbored holes to your part, follow these steps:

# 1. Select the face that the groove feature was created on, and click the Hole Wizard

@\ tool on the Features toolbar. Then set the hole to Counterbored, set the type to Socket

Head Cap Screw, the size to one-quarter, and the end condition to Through All, as shown
in Figure 4.10.

2. Next, click to select the Positions tab at the top of the PropertyManager. This is
where you place the centerpoints of the holes using sketch points. It is often useful to
create construction geometry to help line up and place the sketch points.
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FIGURE 4.10

The Hole Wizard Hole Specification interface

When you select a face to create a 2D Hole Wizard hole, SolidWorks always creates
a sketch point at the location where you selected the planar face, and then activates
the Point sketch tool. If you click anywhere in the graphics window with the Point tool active,
you place additional points, which are used to create additional holes. If those points are off of
the solid model, they may cause errors. To exit the Point tool, just press Esc.

~ A
CAC - N

3. Draw two construction lines, horizontally across the part, with Coincident relations
to each side. Select both lines and give them an Equal relation. The point of this step is
to evenly space holes across the part without dimensions or equations.

TR Although several methods exist to make multiple selections, a box or window selec-
tion technique may be useful in this situation. If the box is dragged from left to
right, then only the items completely within the box are selected. If the box is dragged from right
to left, then any item that is at least partially in the box is selected.

TR SolidWorks displays an error if you try to place a sketch point where there is an
existing sketch entity endpoint. If you build construction geometry in a sketch and
want to place a sketch point at the end of a sketch entity, then you have to create the sketch
point to the side where it does not pick up other incompatible automatic sketch relations, and
then drag it onto the endpoint.

4. Place sketch points at the midpoint of each of the construction lines. If there is
another sketch point other than the two that you want to make into actual holes, then
delete the extra points. Dimension one of the lines down from the top of the part, as
shown in Figure 4.11. All of the sketch relation icons display for reference. Click OK to
accept the feature once you are happy with all of the settings, locations, relations, and
dimensions.
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FIGURE 4.11

Placing the centerpoints of holes

Cutting a slot

The Hole Wizard does not specifically allow you to cut slots, nor is there a Slot feature. However,
SolidWorks has Slot sketch entities or you can use one of the following methods to cut a slot:

Use one of the Slot sketch tools. SolidWorks has straight and arc slot options on the
sketch toolbar.

Explicitly drawing the slot. Draw a line, press A to switch to the Tangent Arc tool, draw
the tangent arc, press A to switch back to the Line tool, and so on. Although you can
press the A key to toggle between the line and arc functions, you can also toggle between
a line and a tangent arc by returning the cursor to the line/arc first point.

Rectangle and arcs. Draw a rectangle, place a tangent arc on both ends, and then turn
the ends of the rectangle into construction entities.

Thin Feature cut. As you did earlier with the groove, you can also create a Thin Feature
slot, although you need to follow additional steps to create rounded ends on it.

Offset in Sketch. By drawing a line, and using the Offset with Bi-directional, Make Base
Construction, and Cap Ends settings, it is easy to create a slot from any shape by drawing
only the centerline of the slot.

Library feature. A library feature can be stored and can contain either simple sketches or
more complex sets of combined features. The library feature is a good option for the
counterbored slot used in this example. Library features are discussed in depth in
Chapter 19.
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Hole Wizard: Using 2D versus 3D Sketches

ole Wizard holes use either a 2D or a 3D sketch for the placement of the hole centers. You can

define the centers by simply placing and dimensioning sketch points. The 3D sketch type is
used by default, with the 2D sketch type only being used when you select a planar face prior to
clicking the Hole Wizard tool.

I want to emphasize the importance of preselecting a flat face before starting the
Hole Wizard. If you do not intend to put holes in different directions or on dif-
ferent levels, you should get in the habit of a/ways preselecting a flat face before starting the
Hole Wizard.

BESTE N, AT A
BEST PRACTLCE

Because the 3D placement of holes seems so much more flexible, why would anyone want to use
the 2D placement method? 3D sketches have several limitations with respect to dimensioning and
sketch relations. Recent releases of SolidWorks have added relations such as Midpoint and Equal to
3D sketches, which are an improvement over previous versions, but still do not make the 3D sketch
as usable as a 2D sketch in the end.

Three-dimensional sketches are discussed in Chapters 17 and 31. Chapter 17 also
gives a more detailed description of the Hole Wizard. Chapter 22 has additional
information on the display of threads.

The following image shows a part with various types of holes created by the Hole Wizard, including
counterbored, countersunk, drilled, tapped, and pipe-tapped holes. The part is shown in section
view for clarity; however, the drilled hole is not shown in the figure.

Countersunk Counterbored

Tapped Pipe tap
Holes created by the Hole Wizard

To cut slots in your part, follow these steps:

1. In this case, use the Straight Slot option. Slots are easiest to create with the click-click
method rather than click-drag. Click near where you want the center of one end of the
slot. Click again for the center of the other end; then click a third time for the width/end
radius. The Slot PropertyManager is shown in Figure 4.12.
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L ICTE Using the Add Dimensions option in the Slot PropertyManager can help you size
h - the slot more quickly. This does not require the Enable On Screen Numeric Input
option to be turned on.

2. From this sketch, create an extruded cut that extrudes up to the surface of the
counterbore in the holes. The through hole for the counterbored slot is also a slot, and
so you can use the same technique.

FIGURE 4.12

Creating a slot

3. Open a sketch on the bottom of the previous slot, and draw a straight slot. You can
create a cut using the Through All end condition.

TP Picking up relations automatically may seem difficult at first, but with some prac-
tice, it becomes second nature. When trying to find the center of an arc, the center-
point is usually displayed and is easy to select. However, when making a relation to an edge, the
centerpoint does not display by default. To display it, hold the cursor over the arc edge for a few
seconds; a marker that resembles a plus sign inside a circle will show you where the center is,
thus allowing you to select it with a sketch tool and pick up the automatic relations.

In Figure 4.13, the first centerpoint has already been referenced, and the cursor is trying to find
the centerpoint of the other end of the slot.
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FIGURE 4.13

Applying automatic relations to a circular edge

Fillets and chamfers

As mentioned earlier, it is considered a best practice to avoid using sketch fillets when possible,
using feature fillets instead. Another best practice guideline is to put fillets at the bottom of the
design tree, or at least after all of the functional features. You should not dimension sketches to
model edges created by fillets unless there are no better methods available. There are too many
ways, and reasons, to change sketches to make other features, especially important features, depen-
dent on them. Several chapters could be written just about fillet types, techniques, and strategies in
SolidWorks. Chapter 7 deals with more complex fillet types.

ST PR AT Do not dimension sketches to model edges that are created by fillets. While the
DIVl FNAC.E previous best practice about relations to sketch entities instead of model edges was
a mild warning, you must heed this one more carefully.

To add fillets and chamfers to your part, follow these steps:

1. Initiate a Fillet feature, and select the four short edges on the part. Set the radius
value to .600 inches. Click OK to accept the Fillet feature.

TR When selecting edges around a four-sided part, the first three edges are usually vis-
ible and the fourth edge is not. You can select invisible edges by expanding the
Fillet Options panel of the Fillet PropertyManager, and selecting the Select Through Faces
option. When you have a complex part with a lot of hidden edges, this setting can be bother-
some, but in simple cases like this, it is useful. Figure 4.14 shows this option in action.

2. Apply chamfers to the edges of the angled slot through the part, as indicated in
Figure 4.15. Make the chamfers .050 inches by 45 degrees.

Chamfers observe many of the same best practices as fillets.
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FIGURE 4.14

Selecting an edge through model faces

TP Feature order is important with features like chamfers and fillets because of how
they both tend to propagate around tangent edges. Although you can turn this set-
ting off for both types of feature, it is best to get the correct geometry by applying the features in
order.

~~ 1, TheFillet Xpert, which helps you to manage large numbers of overlapping fillets
by automatically sorting through feature order issues, is discussed in detail in
Chapter 27.

3. Select the four edges that are indicated for fillets in Figure 4.15. Apply .050-inch-
radius fillets.

4. Apply a last set of .050-inch chamfers to the back side of the counterbores and slot.
The finished part is simple, but you have learned many useful techniques along the way. In the rest

of this chapter, you will put the part together with other parts to form an assembly and then create
a quick 2D drawing of the part and the assembly to document the design.
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FIGURE 4.15

Edges for Fillet and Chamfer features

Chamfer edges  Fillet edges Select to chamfer

Tutorial: Creating a Simple Assembly

Up to this point, you have been learning about how to create geometry, or parts. Assemblies
involve organizing that geometrical data to represent real products or parts of products. Assemblies
can be complex or simple. They can be structured in a single level or use many subassemblies.
Assemblies can be static or allow Dynamic Assembly Motion. Relationships in the assembly can
also drive part geometry.

This part of this chapter serves as an introduction to some of the basic functions and main features
of assemblies. Because all of the geometry creation is done in the part document, most of what goes
on in the assembly document has to do with organizing that geometry in space.

ClOSS.EF Chapters 12 to 16 discuss various aspects of assemblies in greater detail.

The following pages describe common techniques that are used in assemblies. The
part created earlier in this chapter is assembled with some additional parts that have already been
created. The main point here is to give you a basic understanding of the assembly functions that
exist and how they work, before exploring various aspects of the software in greater detail in Part
11. To create a simple assembly, follow these steps:

This tutorial uses parts called Chapter4Frame.sldprt and Chapter4Screw.sldprt from

the s
Orlthe CD-1201) the CD-ROM,, in the material for Chapter 4.
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1. From the CD-ROM, open the part named Chapter5Frame.sldprt. With the part
open, click the Make Assembly From Part/Assembly button on flyout toolbar under the
New button in the title bar. If you have not made a custom template for assemblies, use
the default assembly template that installed with SolidWorks. Move the cursor to the
assembly Origin, where the cursor changes to indicate that the part Origin will be lined
up with the assembly Origin. If the Origin is not visible on the screen, use the View>
Origins menu selection to turn it on.

The first part that you insert into an assembly has a Fixed constraint applied to it. This
constraint is indicated by the (f) in front of the name of the part in the FeatureManager.
Figure 4.16 shows the placement preview and cursor from step 1, as well as the
FeatureManager after the part has been added.

FIGURE 4.16

Placing a part in a new assembly

The Frame part is a weldment. Information important to Weldments is discussed in

COyoo nee
R e an ki) detail in Chapters 31, and 26. Weldments are multi-body parts.

2. Open the part that you created in the previous tutorial. If you do not have it, then
you can open a prebuilt copy from the CD-ROM materials for Chapter 4. Once you open
the part, change to the assembly window.

TP You can press Ctrl+Tab to change between open documents, and Alt+Tab to
change between open applications. These are Windows conventions that are not
exclusive to SolidWorks.
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3. From the assembly menus, click Insert=> Component = Existing Part/Assembly. This
displays the PropertyManager, as shown in Figure 4.17. Select the machined part from
the selection box and click in an open space in the graphics window to place it.

Newly placed parts in the assembly (except for the very first part) are completely unde-
fined in terms of position or location. Instead of the (f) symbol, for Fixed, the newly
placed part displays a (-) symbol, which means Underdefined. You can change a Fixed
part to underdefined by selecting Float in the RMB menu. Figure 4.17 also shows the
FeatureManager with the new part in it. It is a little confusing that (f) stands for Fixed
when the opposite condition, Float, also starts with an f.

FIGURE 4.17

The Insert Component interface

Parts in an assembly are positioned relative to one another with mates. Mates are in
many ways similar to sketch relations.

MNOTE

4. Click the Mate button from the Assembly toolbar. The mate options that are not
% grayed out are available with the current selection. For example, in Figure 4.18, the cor-
responding faces of the weldment and the machined part are selected, and these faces can
be mated coincident, parallel, perpendicular, at a distance, or at an angle.

TR You can move a part in an assembly by clicking the part and dragging it with the
LMB (left mouse button). It follows whatever mates you have applied to it. To rotate
a part that does not have any mates applied to it, drag the part with the RMB. The MMB still
rotates the view.
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FIGURE 4.18

Mate options

5. Select the Coincident mate, and then the faces as shown in the figure. If the
machined part is turned as it is in Figure 4.18 (so that it interferes with the welded frame
if the selected surfaces touch), then click the Flip Mate Alignment button on the popup
toolbar or toggle the Mate Alignment buttons in the PropertyManager. Close the popup
toolbar by clicking the green check mark icon.

rer o, r,, ~1- ~= Incontrast to sketch relations, most assembly mates have alignment orientation.
BEST PRACTICE Flat faces can be coincident in one of two orientations separated by 180 degrees.
The same is true of concentric relations, as well as others. SolidWorks orients a part to the clos-
est orientation that works. This means that it is often best to preposition parts to make it easier
for the software. This usually involves some combination of rotating the view and rotating the
part.

6. Select the top angled face of the angled frame member and the corresponding flat
face of the machined part. Figure 4.19 shows which faces to select. Make these faces
coincident. In this case, the parts are already in the correct orientation, and so there is no
need to preposition them. Click the green check mark icon to accept the mate.

7. One more mate is required to fully define the position of the machined part. Drag
the part and verify that it slides up and down the angled weldment member. Find the
two tapped holes in the weldment and slide the machined part so that the holes appear in
the counterbored slot. Ideally the holes should be symmetrical with the part, but the slot
was created to allow room for adjustment.
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FIGURE 4.19

Selecting mating faces

Expand the machined part in the FeatureManager and select its Front plane. From
the View menu, turn on the display of temporary axes, and Ctrl-select the temporary axes
in the centers of the threaded holes in the frame, as shown in Figure 4.20. Select the
Symmetric mate on the Advanced Mates panel. Turn off the display of temporary axes
when the mate is complete.

Through the menus or Assembly toolbar, click Insert Component, and use the
Browse button to find the existing Chapter4Screw.sldprt part on the CD-ROM,
or on your hard drive if you have copied it there.

Notice that this part behaves differently in certain situations. For example, when the
cursor is over empty space, it is attached to the centroid of the part, but when the cursor
is over a flat or cylindrical face, the part snaps to that face. This is because the part uses a
Mate Reference, enabling planar and cylindrical faces to automatically get Coincident
and/or Concentric mates when the part is dropped on them.

Make sure that the Push Pin feature is activated in the Insert Component
PropertyManager, and then drop the part at the bottom of each counterbored hole.
The part automatically gets Concentric and Coincident mates. Figure 4.21 illustrates the
location where you should drop the part. Click OK to accept the part placement.

You need to place two more screws in the assembly, but these ones cannot be auto-
matically mated; you need to do this manually. Copy two instances of the screws. To
copy a screw, Ctrl-drag the part either from the graphics window or from the
FeatureManager and drop it into the graphics window.

Position the part and the view so that you can see the cylindrical body of the screw
and the cylindrical face of the threaded hole in the C-channel. With the Mate function
active, select both faces and click OK. Repeat the process for the other screw and hole.
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FIGURE 4.20

Creating a Symmetric mate

Temporary axes

FIGURE 4.21

Using a Mate Reference

14. Now click the underside of the screw head and the counterbored surface of the slot,
make sure that they will be coincident, and click OK. Repeat the process for the other
screw.
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15. Save and close the assembly.

This is a quick overview of the basic assemblies’ functionality, which is expanded on in later chapters.

Tutorial: Making a Simple Drawing

If you are coming to SolidWorks from a dedicated 2D software, you will be creating drawings very
differently from what you may be used to. In 2D design software, you draw each view individually,
and when a change occurs, you have to go back through the views and ensure that each view is
updated appropriately. In 2D, views are sometimes created sparingly because they are difficult to
create and to update. This includes view types such as Isometric views, complex sections, and
views projected at non-orthogonal angles.

In SolidWorks, drawing views are almost free, being simply projected from the 3D model. Updates
are made in the model, and all views update automatically from there. You can handle dimensions
in a couple of ways, either using the dimensions that you used to create the model, or placing new
dimensions on the drawing (best practice for modeling is not necessarily the same as best practice
for manufacturing drawings). To make a simple drawing, follow these steps:

1. Press the New button from the Standard toolbar, or click File=> New. From the New
SolidWorks Document window, select the Drawing template. The template contains
all of the document-specific settings.

2. After selecting the drawing template, the Sheet Format/Size dialog box displays, as
shown in Figure 4.22. Select the D-Landscape sheet size, as well as the format that
automatically associates with that sheet size, and click OK. If the Model View
PropertyManager appears, click the red X icon to exit.

3. Before creating any views on the drawing, set up some fields in the format to be
filled out automatically when you bring the part into the drawing. RMB click
anywhere on the drawing sheet (on the paper), and select Edit Sheet Format.

4. Zoom in to the lower right-hand corner of the drawing. Notice that there are several
variables with the format $PRPSHEET:{Description}. These are annotations that are
linked to custom properties. Some of them have properties with values (such as the Scale
note), and some of the properties do not have values (such as the Description).

5. Add an annotation in the Drawn row, in the Date column. You can add annotations
by clicking Insert &> Annotations &> Note, or by activating the Annotations toolbar in the
CommandManager and clicking the Note button. Type today’s date as the text of the
note.

~aE A If you are using a SolidWorks default template and a circle appears around your
et note, then use the Text Format PropertyManager that appears when you are creat-
ing a note, expand the Border panel, and change the Circle option to None.
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FIGURE 4.22

The Sheet Format/Size dialog box

Paper size
Use this for Border and
custom size paper associated text

Turn this off if you
want a blank drawing sheet

Add another note, this time to the Name column. Do not type anything in the note,
but use the Link to Properties button in the Note PropertyManager to create a link to a
custom property. In the Link to Property dialog box, click the Model in View Specified
option in Sheet Properties. Type user in the drop-down text box below the option. This
now accesses a custom property in a part or assembly that is put onto this drawing and
called “user,” and will put the value where the note is placed.

To return to Edit Sheet mode (out of Edit Format mode), select Edit Sheet from the
RMB menu. A little text reminder message appears in the lower-right corner on the sta-
tus bar to indicate whether you are editing the Sheet or the Format.

From the Drawings toolbar, select the Standard 3 View button, or through the
menus, click Insert=> Drawing View=> Standard 3 View. If the
Chapter4SimpleMachinedPart document does not appear in the list box in the
PropertyManager, then use the Browse button to select it. When you click the OK button,
the three drawing views are created.

Drawing views can be sized individually or for each sheet. The Sheet Properties dia-
log box in Figure 4.23 shows the sheet scale. If this is changed, all of the views on the
sheet that use the sheet scale are updated. If you select a view and activate the Drawing
View PropertyManager, you can use the Scale panel to toggle from Use Sheet Scale to Use
Custom Scale.
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~+ =71~ Inthe United States, drawings are traditionally made and understood using the

AN Third Angle Projection, which is the ANSI (American National Standards Institute)
standard. In Europe, drawings typically use First Angle Projection, which is the ISO (International
Organization for Standardization) standard. If you are not careful about making and reading your
drawings, then you could make a serious mistake. There are times when in the United States, the
SolidWorks software will install with ISO standard templates, which will project views using First
Angle Projection. When using a template that you are unfamiliar with, it is a good idea to check
the projection method. To do this, RMB click the drawing sheet and select Sheet Properties. The
Type of Projection setting appears in the top middle of the dialog box, as shown in Figure 4.23.
This dialog box looks similar to the Sheet Format/Size dialog box, but it has some additional
options, including the projection type.

FIGURE 4.23

First-angle versus third-angle projections

rm 10. To create an Isometric view, activate the Drawings toolbar in the

0 CommandManager, and click the Projected View button. Then select one of the exist-
ing views, and move the cursor at a 45-degree angle. If you cannot place the view where
you would like it to go, then press the Ctrl key to break the alignment, and place the
view where you want it.

11. You can change the appearance of the drawing view in several ways.

View = Display = Tangent Edges with Font uses phantom line type for any edge
between tangent faces.

View = Display &> Tangent Edges Removed completely removes any tangent edges.
This is not recommended, especially for parts with a lot of filleted edges, because it
generally displays just the outline of the part.
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Shaded or Wireframe modes can be used on drawings, accessed from the View toolbar.

Perspective views must be saved in the model as a named view and placed in the
drawing using the view name.

RealView drawing views are not available on a drawing except by capturing a screen
shot from the model and placing this screen shot in a drawing. The same applies to
PhotoWorks renderings.

12. Look at the custom properties that you created in the title block. The date is there

because you entered a specific value for it, but the Name field is not filled in. This is
because there is no User property in the part. RMB click the part in one of the views and
select Open Part. In the part window, click File = Properties, and in the Property Name
column, type the property name user, with a value of your initials, or however your com-
pany identifies people on drawings. The Properties dialog box, also called Summary
Information, is shown in part in Figure 4.24.

FIGURE 4.24

The Custom Properties entry table

~~ r,=r~ When used in models and formats, Custom Properties are an extremely powerful

DY-ILET

combination, especially when you want to automatically fill in data in the format, in

a BOM, or a PDM (Product Data Management) product. These topics are discussed in more
detail in Chapters 20 and 24.

13.

When you flip back to the drawing (using Ctrl+Tab), the Name column now con-
tains the value of your initials.

Click the Section View button on the Drawings toolbar. This activates the Line com-
mand so that you can draw a section line in a view. When sketching, a line can go either
on the Sheet or in a view. This is similar to the distinction between the Sheet and the
Format. To make a section view, the section line sketch must be in the view. You will
know that you are sketching in a view when a pink border appears around the view. You
may also use Lock View Focus from the RMB menu to manually lock view focus.
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15. Bring the cursor down to the circular edge of the slot to activate the center point of
the arc. Once the center point is active, you can use the dotted inference lines to ensure
that you are lined up with the center. Another option is to manually create sketch rela-
tions. Turning on temporary axes displays center marks in the centers of arcs and circles.
Figure 4.25 shows the technique with the inference lines being used. Draw the section
line through the slot, and then place the section view.

FIGURE 4.25

Creating a section view

16. As mentioned earlier, you can use two fundamentally different methods for dimen-
sioning drawings:

Model Items imports the dimensions used to build the SolidWorks model and uses
them on the drawing. These dimensions are bi-directionally associative, meaning that
changing them on the drawing updates the model, and changing them on the model
updates them in the drawing. On the surface of things, this sounds too good to be
true, and it is. The potential problems are that you might not model things the way
you would dimension them for the shop. You have to answer several questions for
yourself such as do the leader lines go to the right locations or can they be moved and
the dimensions usually come in in such a way that they require quite a bit of moving
them around.
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Reference (driven) Dimensions can be applied to the drawing view directly. These
are only associative in one direction, meaning that they measure what is there, but
they do not drive the size or position of the geometry. All changes must be made from
the model. Again, on the face of things, this appears to be redundant and a waste of
time, but in my personal estimation, by the time you finish rearranging dimensions,
checking to ensure that you have everything you need, and hiding the extraneous
dimensions, you are usually far better off using reference dimensions.

BEST DR ACTLCL Users have strong opinions on both sides of this issue. The best thing for you to do
DLV AL A~Z s to use both methods and decide for yourself.

17. 1f you choose to use the Model Items approach, you can do this by clicking
Insert=> Model Items. Then specify whether the dimensions should come from the
entire model or just a selected feature. You also need to ask whether the dimensions
should come into all views or just the selected one, and whether you want just a certain
type of dimension, annotation, or reference geometry.

18. Once the dimensions are brought in, you need to move some of them from one view
to another, which you can do by Shift-dragging the dimension from the old location
to the new location. Ctrl-dragging predictably copies the dimension. You can move
views by dragging an edge in the view.

Sheet versus Sheet Format

ith new and even experienced users, there is some confusion around the Sheet versus Sheet

Format issue. Part of the confusion is due to SolidWorks terminology. SolidWorks names the
two items Sheet and Sheet Format. In this book, | simply use the terms Sheet and Format, to avoid
linking the two items with a common first name. It would be better yet if Format were changed to
Border or Title Block so that the name more closely matched the function. (The confusion goes
deeper for longtime users because there was a time around SolidWorks 98 when templates as we
know them did not exist, and what is now called the Format was called the Template, which is why
templates have the file extension *.slddrt [DRawing Template]).

In a SolidWorks drawing, you are either editing the sheet or the format. When editing the sheet, you
can perform actions such as view, move, and create views, but you cannot select, move, or edit the
lines and text of the drawing border. When editing the format, you can edit the lines and text that
make up the drawing border, but the drawing views disappear.

Often, users save a template that already uses a format, and save themselves some time by selecting
everything all at once when they first select the drawing template for a new drawing.

While you cannot change templates after you create a document, you can swap formats, and change
sheet sizes.
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Summary

Part I, “SolidWorks Basics,” has laid the foundation for the more detailed information that will fol-
low. In the chapters in Part I, I have tried to give recommendations and answer questions that help
you to develop an intuition for how SolidWorks software operates, which is the most crucial kind

of knowledge when troubleshooting a modeling or editing problem.

This chapter has glossed over many of the important details in order to give you a quick overview
of the basic functionality in SolidWorks for the three main data types: Parts, Assemblies, and
Drawings. Later chapters expand on this information significantly.
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Techniques

n SolidWorks software, visualizing geometry is very important. In fact,

visualization of 3D data is part of the overall mission of the software.

Consequently, the visualization tools are very powerful. I remember first
running SolidWorks and all of the things I could do to actually see how parts
in an assembly fit together. When I used AutoCAD, the visualization was all
in my head. I had to imagine what the 3D looked like given the 2D views.
SolidWorks takes it so much further than just being able to see things in 3D;
you can look at some parts of an assembly in wireframe while others are
transparent and others are opaque. You can see a part with a reflective
appearance. You can create section views in parts and assemblies to visualize
internal details.

I hope that this chapter fills in some important capabilities in your
SolidWorks toolbox and at the same time provides some of the awe and
wonder that we sometimes get to experience while using incredible 3D tools
to do actual work. I will start with the simple and pass through to some
more advanced visualizations tools and techniques. If I sound a little enthu-
siastic about this topic, it is because visualization is the part of this software
that really brings my imagination to life. It can be the source of real inspira-
tion and allows me to communicate geometrical ideas with other people.

Manipulating the View

One of the most important skills in SolidWorks is manipulating the view.
This is something users do more frequently than any other function in
SolidWorks, and so learning to do it efficiently and effectively is very impor-
tant, whether you look at it as rotating the model or rotating the point of
view around the model. The easiest way to rotate the part is to hold down
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the middle mouse button (MMB) or the scroll wheel, and move the mouse. If your mouse does not
have a middle button or a scroll wheel that can be used as a middle mouse button, then you can
use the Rotate View icon on the View toolbar or the Heads-up View toolbar.

TP Some mouse drivers change the middle button or scroll-wheel settings to do other
things. Often, you can disable the special settings for a particular application if you
want SolidWorks to work correctly and still use the other functionality. For example, the most
common problem with mouse drivers is that when the model gets close to the sides of the
graphics window and the scroll bars engage, the middle mouse button suddenly changes its
function. If this happens to you, you should change the function of the middle mouse button to
Middle Mouse Button from its present setting.

Arrow keys

The arrow keys enable you to rotate to the following views:

Arrow. Rotate 15 degrees. To customize this setting, use Tools= Options= View.
Shift-arrow. Rotate 90 degrees

Alt-arrow. Rotate in a plane flat to the screen

Ctrl-arrow. Pan

Middle mouse button

The middle mouse (MMB) button or scroll wheel has several uses in view manipulation:

B MMB alone. Rotate

Click or hover on edge, face, or vertex with MMB, and then drag MMB. Rotate
around selected entity.

Ctr-MMB. Pan
Shift-MMB. Zoom
Double-click MMB. Zoom to fit

Scroll with wheel. Zoom in or out. To reverse direction of the zoom setting, use
Tools= Options= View.

B Alt-MMB. Rotate in a plane flat to the screen

Using the View toolbars

The View toolbar, shown as the top image in Figure 5.1, contains the tools that you need to
manipulate the view in SolidWorks. Not all of the available tools are on the toolbar by default, but
I have added them here for this image. To customize your own View toolbar, you must use
Tools= Customize and change to the Commands tab. Then select the View toolbar, and either
drag items from the Customize dialog to the View Toolbar to add them, or from the View Toolbar
into the empty graphics area to remove them. You can use these tools with part and assembly
models but not drawings.
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The Heads-up View toolbar is also shown in Figure 5.1. This toolbar was added to SolidWorks
with the 2008 release. You can customize this toolbar by right-clicking on it. An interface will
appear that enables you to select the items you want displayed on the toolbar. To finish, click out-
side of the interface, in the graphics window. You cannot add items that are not on the list that
pops up. You cannot turn the Heads-up View toolbar off, but you can remove all of the toolbar
buttons from it. All of these items from both the View and Heads-up View toolbars are also avail-
able on the View menu.

FIGURE 5.1

The View toolbar

Scrollbars and splitters

An option exists to add scrollbars and view pane splitters to the graphics window. SolidWorks
2007 had these interface elements, but they were removed in the 2008 release and then added
back when SolidWorks discovered that users do indeed use them. This option is located at
Tools= Options = Display/Selection. This selection will be grayed out if any SolidWorks docu-
ments are open (so you must close all SolidWorks documents to change it). When you zoom in
such that the part/assembly/drawing is partially off the screen, the scrollbars will activate, allowing
you to scroll up and down as well as left and right to pan the view.

The splitters enable you to split the main graphics window into multiple view ports. The options
are two ports horizontally, two ports vertically, or four view ports. The splitter bars are located at
the intersection of the scrollbars in the lower right-hand corner of the graphics window. Of course,
you can also use the icons on the Standard Views toolbar for splitting the view into two vertical
ports, two horizontal ports, or four ports.

Once a viewport has been split, you can remove the split either with the toolbar icons or by dou-
ble-clicking the split border. If the view has been split into four, you can set it back to a single
viewport by double-clicking the intersection of the horizontal and vertical port borders.

Figure 5.2 shows the scrollbars the splitters and the Standard Views toolbar with all of the view
port tools. Notice the cursor in the lower right over one of the splitters.
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FIGURE 5.2

Scrollbars and splitters

Using the Magnifying Glass

A new visualization aid introduced in SolidWorks 2009 is the Magnifying Glass. You can invoke it
by pressing G, and dismiss it when you select something or when you press Esc. You can change
the hotkey it is associated with by going to Tools= Customize &> Keyboard. Magnifying Glass is

listed in the Other category. The Magnifying Glass is intended to magnify a small area of the view
to enable you to make a selection.

The magnified area follows your cursor as it moves, and you can zoom in and out by scrolling the
MMB. Ctrl-dragging keeps the magnifying glass centered on the cursor. Pressing Alt creates a sec-
tion view parallel to the view, and scrolling with Alt pressed moves the section plane further away
or closer. Figure 5.3 shows the magnifying glass in operation, cutting a section view through a
part.

FIGURE 5.3

Using the magnifying glass

L ICTE The intended purpose of the magnifying glass is to select small items. You may use
: - it to inspect things, but remember it will disappear as soon as you select something.
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Clicking the Triad axes

The Triad is the multicolored coordinate axes in the lower-left corner of the SolidWorks graphics
window. You generally use it passively, to see how the view is oriented, and to get X, Y, Z reference
directions for features that need it.

However SolidWorks 2009 adds functionality that allows you to make active use the Triad instead
of just passive use. When you click on any axis, the view orients such that you are looking straight
down that axis of the part. Clicking on the same axis a second time rotates the view 180 degrees.
When you are in a named view, a little box in the lower-left corner shows the name of the view.
This includes standard named views and custom named views. Anything that shows up in the
View Orientation box (accessed by spacebar) displays a name in the corner. Figure 5.4 shows the
Triad and the named view box in the lower-left corner.

FIGURE 5.4

The Triad and named view box

By Shift-clicking an axis of the triad, the view is rotated 90 degrees from the original orientation.
Alt-clicking rotates the view around the clicked axis by the view rotation increment set in
Tools= Options= View, which is 15 degrees by default. Using Ctrl in conjunction with any of
these causes the view to rotate in the opposite direction. So if Shift-click makes the view rotate
against the right hand rule about the clicked axis, Ctrl+Shift-click makes the view rotate with the
right hand rule.

Using the View Tools

B Zoom To Fit. Resizes the graphics window to include everything that is shown in the
model. You can also access this command by pressing the F key, or double MMB clicking.

B Zoom To Area. When you drag the diagonal of a rectangle in the display area, the dis-
play resizes to fit it. The border size around the fit area is fixed, and cannot be adjusted.

B  Zoom In/Out. Drag the mouse up or down to zoom in or out, respectively. You can also
access this command by holding down the Shift key and dragging up or down with the
MMB. The hotkey Z or Shift+Z works for Zoom Out and Zoom In respectively. The per-
centage of the zoom is a fixed amount, and cannot be adjusted.
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Zoom To Selection. Resizes the screen to fit the selection. You can also access this com-
mand from the right mouse button, or RMB, on the FeatureManager. For example, if you
select a sketch from the FeatureManager, right-click and select Zoom to Selection, the
view positions the sketch in the middle of the screen and resizes the sketch to match the
display. The view does not rotate with Zoom to Selection.

There is a reciprocal function that enables you to find an item in the tree from
graphics window geometry. If you right-click a face of the model, then you can

select Go To Feature in Tree, which highlights the parent feature.

Rotate View. Enables you to orbit around the part or assembly using the left mouse but-
ton (LMB). You can also access this command by using the MMB without the Toolbar
icon.

Pan. Scrolls the view flat to the screen by dragging the mouse. You can also access this
command by holding down the Ctrl key and dragging the MMB without using the
Toolbar icon, or with Ctrl+Arrow.

3D Drawing View. Enables you to rotate the model within a drawing view to make
selections that would otherwise be difficult or impossible. This is of no use in part and
assembly models.

Standard Views flyout toolbar. The Standard Views toolbar will be discussed later in
this chapter. The flyout enables you to access all of the Standard Views tools. This button
is also called the View Orientation flyout, depending on where you see it.

Wireframe. Displays the model edges without the shaded faces. No edges are hidden.

Hidden Lines Visible (HLV). Displays the model edges without the shaded faces. Edges
that would be hidden are displayed in a font.

Hidden Lines Removed (HLR). Displays the model edges without the shaded faces.
Edges that are hidden by the part are removed from the display.

Shaded with Edges. The model is displayed with shading, and edges are shown using
HLR. Edges can either be all a single color that you set in Tools=> Options= Colors
(typically black), or they can match the shaded color of the part.

Tools= Options = Document Properties=> Colors is where you find the document spe-
cific setting to use the same color for shaded and wireframe display, which becomes very
useful in an assembly when all of the parts shown in wireframe are the same color as they
are when they are shaded, instead of all being black.

Shaded. The model is displayed with shading, and edges are not shown.

Shadows in Shaded Mode. When the model is displayed shaded, a shadow displays
“under” the part. Regardless of how you rotate the model, when Shadows are initially
turned on, the shadow always starts out parallel to the standard plane that is closest to
the bottom of the monitor. As you rotate the model, the shadow moves with it. If
Shadows are turned off and then back on again, they again display parallel to the stan-
dard plane that is closest to the bottom of the monitor.
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B Section View. Sections the display of the model. Figure 5.5 shows the Section View
command at work. You can use up to three section planes at once. Solid and surface
models as well as assemblies can be sectioned. You can use the spin boxes, enter numbers
manually, or drag the arrows that are attached to the section planes to move the section
through the model. Section planes can also be rotated by dragging the border of the
plane.

FIGURE 5.5

The Section View tool

Clicking the check mark icon in the Section View PropertyManager enables you to con-
tinue working with the sectioned model, although you may not be able to reference edges
or faces that are created by the section view. It is only a displayed section; the actual
geometry is not cut.

Section Views can be saved to either the View Orientation box or to the Annotation View
folder, which allows section views to be reused on the drawing. Annotation Views are
described in more detail in Chapter 22.

B RealView. Creates a more realistic reflective or textured display for advanced material
selections. This feature does not work with all graphics hardware, so check the
SolidWorks Web site to see if it supports your hardware. An entire section of this chapter
is devoted to the various tools available with RealView graphics.
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B Appearances. Appearances allows you to apply colors, textures and materials to faces,
e bodies, features, parts and components. This functionality replaces the old colors and
textures interfaces.The following toolbar buttons are not on the View toolbar by default,
but you can add them if you want:

B Camera View. Views the model through a Camera. You can use Cameras for:
Viewing the model from a particular point of view.

Creating renderings with perspective and depth-of-field (focus) blur; this feature is
only available when PhotoWorks is added in.

Animating the position and target of the point of view in an animation; this feature is
only available when Animator is added in.

Camera Views

Cameras are created through the RMB menu on the Lights and Cameras folder in the
FeatureManager, as shown in Figure 5.6. When you add a Camera, an interface displays in the
PropertyManager, as shown in Figure 5.7.

FIGURE 5.6

Adding a new Camera

In this interface, you can position the Camera object by dragging the triad, and you can resize the
Field of View box by dragging the border. In the graphics window, you can use the left panel to
target and position the Camera, while the right panel shows the view through the Camera.

The Depth of Field panel of the Camera PropertyManager is not shown, because it requires that
PhotoWorks be added in. Depth of field can make objects outside of the focus area slightly out-of-
focus, which can greatly add to the realism of renders.
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Camera options and interface

Triad Field of View box

There are three methods to switch the graphics window to the Camera view:

B Through the View Orientation dialog box (accessed through the spacebar)
B Through the View Orientation popup (in the lower-left area of the graphics window)

B Through the RMB menu on the Camera in the Lights and Cameras folder in the
FeatureManager

When you switch the view to the Camera view, the regular Rotate View command does not func-
tion. Rotating the view means moving the Camera. You can move the Camera by editing the
Camera properties and reposition the Camera by dragging the triad, or by using the Turn Camera
tool to rotate the view while looking through the Camera

B Turn Camera. Allows you to rotate the view when looking through the Camera without
editing the Camera properties. You must be looking through the camera and it must be
unlocked for this to work. Dragging with the MMB does the same thing if the camera is
unlocked.

B Draft Quality HLR/HLV. Toggles between low-quality (draft) and high-quality edge HLR
or HLV display. This affects display speed for complex parts or large assemblies. When in
draft-quality mode, edge display may be inaccurate.

B Perspective. Displays the model in perspective view without using a Camera. If you want
to create a perspective view on a drawing, you must create a custom view in the View
Orientation dialog box with Perspective turned on. Perspective can be adjusted through
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View> Modify = Perspective by adjusting the relative distance from the model to the
point of view. Relative distance is measured by the size of the bounding box of the model,
and so if the model fits into a box roughly 12 inches on a side, and the perspective is set
to 1.1, then the point of view is roughly 13 inches from the model. For more accurate
perspective, you can use a Camera.

Curvature. A geometrical analysis tool that applies a color gradient to the part, based on
the local curvature. You can also apply curvature display to individual surfaces through
the RMB menu. With some hardware, curvature display can take more time to generate
for complex models.

Settings in Tools => Options=> Performance can greatly affect rebuild speed if curva-
ture display data is regenerated for each part rebuild. You should leave this setting

at the default setting, which is Only On Demand.

Zebra Stripes. Another geometrical analysis tool that helps you to visualize the quality of
transitions between faces across edges. Zebra Stripes simulates putting a perfectly reflec-
tive part in a room that is either cubic or spherical and where the walls are painted with
black-and-white stripes. In high-end shape design, surface quality is measured qualita-
tively by using light reflections from the surface. Reflecting stripes makes it easier to visu-
alize when an edge is not smooth.

The three cases that Zebra Stripes can help you identify are as follows (see Figure 5.8):

Contact. Surfaces intersect at an edge, but are not tangent across the edge. This condition
exists when stripes do not line up on either side of the edge.

Tangency. Surfaces are tangent across an edge, but have different radius of curvature on
either side of the edge (non-curvature continuous). This condition exists when stripes
line up across an edge but the stripe is not tangent across the edge.

Curvature Continuity. Surfaces on either side of an edge are tangent and match in
radius of curvature. Zebra Stripes are smooth and tangent across the edge.

In Figure 5.8, the Zebra Stripes in example A do not match across the edge labeled A at all. This is
clearly the non-tangent, contact-only case. Example B shows that the stripes match in position
going across the indicated edge, but they change direction immediately. This is the tangent case.
Example C shows the stripes flowing smoothly across the edge. This is the curvature continuous

case.

You can use the remaining icons in the View toolbar to toggle the display of various types of
entities from reference geometry to sketches.

TIP

Consider using hotkeys to toggle the display of my favorite items to hide and show.
I use T for Temporary Axes, P for Planes, R for Origins, and so on.
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Zebra Stripes

View Orientation

You can activate the View Orientation box by pressing the spacebar. View Orientation, shown in
Figure 5.9, keeps all named views, saved section views, and standard views. Tools in the box also
enable you to update standard views to the current view or to reset standard views to their
defaults. Be aware of another toolbar button on the View toolbar that has the name View
Orientation.

FIGURE 5.9

The View Orientation dialog box

The Standard Views flyout is called either Standard Views or View Orientation, depending on
where you see it. The View Orientation dialog box contains the following controls:

B Push Pin. Keeps the dialog box active.
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B New View. Creates a new custom-named view.

B Update Standard Views. Sets the current view to be the new Front view; all other views
% update relative to this change. This also updates any associated drawing views, but does
not move any geometry or change plane orientation.

B Reset Standard Views. Resets the standard views so that the Front view looks normal to
@ the Front plane (Planel, XY plane).

B Previous View (undo view change). You can access this tool using the default hotkey
Shift+Ctrl+Z.

View Orientation can also be manipulated from two other locations: the Standard Views toolbar,
which is discussed later in this chapter, and the spacebar View Orientation popup, shown in
Figure 5.10. This function allows you to select the orientation or the arrangement of viewports.
The popup also displays any existing Cameras, which are described earlier in this section.

FIGURE 5.10

The View Orientation popup

The Standard Views toolbar

[ have already mentioned the Standard Views flyout on the View toolbar, but here I will describe the
tools that it contains in detail. Figure 5.11 shows the Standard Views toolbar in its default configuration.
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FIGURE 5.11

The Standard Views toolbar

By default, the Standard Views toolbar contains the View Orientation button, a tool from the View
toolbar. The View Orientation button is discussed in detail earlier in this section.

Normal To has three modes of operation:

B First Mode. Click a plane, planar face, or 2D sketch. When you click Normal To, the
view reorients normal to the selected plane, face, or sketch, and zooms to fit the model in
the view. This method is shown in Figure 5.12.

FIGURE 5.12

The result of using Normal To on the end rib angled face

Selected face

B Second Mode. Click Normal To a second time. The view rotates 180° to display the
opposite direction.

B Third Mode. After making the first selection, Ctrl-select another planar entity. The view
is normal to the first selection and the second selection is rotated to the top. This method
is shown in Figure 5.13.
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FIGURE 5.14

FIGURE 5.13

Using Normal To with Second Selection to define the top

First selection

Second selection

Annotation views

Annotation views enable you to group annotations that were made in the 3D model into views that
will be used on the drawing. They can be displayed under the Annotations folder in the
FeatureManager for parts and assemblies. Annotation views can be created either automatically,
when 3D annotations are added, or manually. An Unassigned Items annotation view acts as a
catchall for annotations that are not assigned to any particular views. In the 3D model, you can use
the views to reorient the model and display annotations. As mentioned earlier, annotation views
can also capture a model section view to be shown in a drawing view. The Annotation views are
shown for the Chapter5SampleCasting part in Figure 5.14.

Annotations views for Chapter5SampleCasting.sldprt
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Understanding RealView

RealView is a hardware-driven set of visualization tools that help make the SolidWorks display
look more realistic, adding reflections, reflected backgrounds, and shadows. RealView is intended
to help the user to apply advanced effects to 3D models. The fact that RealView is hardware-driven
means that not all video cards that are certified to work with SolidWorks also work with RealView.
You need to check on the SolidWorks Web site to see what level of RealView your graphics card
supports. A link to the video card testing site should be available from the SolidWorks home page,
www.solidworks.com.

The SolidWorks 2008 version made a big change in the implementation of RealView, and the
hardware support changed greatly with that release as well. Hardware that worked well for
RealView in SolidWorks 2007 may not work for all of the RealView features in 2008.

In some situations, you can use RealView instead of PhotoWorks. In these cases, RealView acts as a
real-time renderer. The main advantages that PhotoWorks holds over RealView are improved
antialiasing control, improved shadow control, indirect illumination, global illumination, caustics,
and effects such as depth of field from a camera.

You can even use RealView as a diagnostic tool for smooth joints between surfaces because
RealView appearances apply a reflective surface to a part and then also apply a reflective back-
ground. This is essentially what the Zebra Stripes functionality is doing, but Zebra stripes applies a
specific reflective background to make examining curvature continuity across edges more straight-
forward.

You can turn RealView on or off by using the golden globe icon shown by default on the Heads-up
View toolbar. If this icon is grayed out, then your system is not equipped with an appropriate
RealView-capable graphics card. Generally, you need an nVidia 500 series or higher to get
RealView capabilities. NVS series cards are not 3D cards and will not enable RealView. Some ATI
FireGL cards may also work.

RealView basic components

RealView consists of:

B Appearances. Controls colors, textures, reflectivity, optical properties
B Scenes. Controls the background image and reflectivity image
If you are familiar with previous versions of SolidWorks, Appearances in the 2009 release com-

pletely take the place of the Colors functionality, even if you do not have RealView-capable video
card.

Figure 5.15 shows the contents of the RealView tab in the Task Pane, as well as the callout that
appears when you drop an appearance onto a part. The callout enables you to select if you want
the appearance applied to the face, body, part, or assembly level.
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FIGURE 5.15

Using the Appearances tab on the Task Pane to apply appearances
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Applying appearances

Appearances starting in the 2009 release encompass colors and textures. Another way of saying
that is that colors and textures have been rolled into appearances for 2009. To apply an appear-
ance, use the Task Pane at the right of the graphics window, and click the Appearances tab. Figure
5.15 shows this. Then select an appearance from the list, and drag it onto the part where you
would like to apply it. You can do this either in the part window or in the assembly window. A
small popup will appear and present you with options for what to apply the appearance to, which
is either the face, feature, body, or part.

If you are familiar with SolidWorks 2008 or prior, the way you work with color in SolidWorks
20009 is different. The Color icon is no longer the main means of changing the color of a part.
Starting with the 2009 release, you use appearances. Appearances also enable you to change colors.
To change the color of an applied appearance, use the Appearance Callout icon on the RMB menu,
select the level you want to apply the color to (face, body, feature, part), and then select the color
from the Appearance PropertyManager. Figure 5.16 shows the Appearance PropertyManager.

Appearance overrides

One of the things that confuse many users about applying an appearance is that it can be applied
on many levels, and may override or be overridden by other appearances. This means that in a
part, an appearance may be applied to a face, a feature, a body, or the entire part. There is a spe-
cific hierarchy to this system of overrides: part, body, feature, face, component, and automatic
color changes.



Using Visualization Techniques

The Appearance PropertyManager

When you apply an appearance at the level of the part (the name of the part shows in the Color
and Optics PropertyManager), any other entity color will override it. You can assign Solid or
Surface bodies an appearance that overrides the part appearance. Some color changes are auto-
matic; for example, when you are editing parts in the context of an assembly, they can temporarily
change colors or become transparent, which overrides everything else.

For complex surfaces, surface transition quality is often measured by reflections, and so setting up
a reflective model can be key to finding shape imperfections. In lieu of reflective RealView materi-

als, using lights with specularity can help you evaluate curved surfaces, although it is generally not
useful for flat faces.

Other entity colors

You can color other entities in addition to the 3D shaded model. Curve entities (such as a helix or
projected curve) can be colored in addition to sketches with the Edit Sketch Or Curve Color tool.

You can only view sketch colors when the sketch is closed and shown, because when the sketch is
open, the entity colors have special significance indicating the sketch status.

CrrE The Edit Sketch Or Curve Color works for sketches and limited curve features. It
MNOTE . :
works for all curve features except for projected curves. Also, preselection does not
work with this tool.
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FIGURE 5.17

The Display pane

The Display pane {lies out from the right side of the FeatureManager and displays a quick list of
which entities have colors, materials, or textures assigned. It also shows hidden parts or bodies for
assemblies and multibody parts. The Display pane is shown in Figure 5.17. You may notice that it
does not display colors for faces, and it does not enable you to change anything from the Display
pane; it just keeps and displays the record of where the color or optical properties were assigned. I
revisit the Display pane in Chapter 12 to show you how it is used in assemblies.

The Display pane in action
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Automatic colors

The settings found at Tools= Options = Document Properties= Colors can be used to automati-
cally color certain types of features with specific colors. For example, all Shell features can be col-
ored red as they are created.

Using Display States

One of the most commonly used and powerful visualization aids available in SolidWorks is the
Display States functionality (see Figure 5.18). Display States is simply the ability to show parts
shaded, shaded with edges, wireframe, HLR (hidden lines removed), or HLG (hidden lines in

gray).
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Display States in an assembly

CPOSS.PEF Chapter 14 deals with Display States in more detail.
—llJyy=1lC

Using Edge Settings

Earlier in this chapter I discussed the Shaded with Edges display style. Some people think that this
makes the parts look “cartoony.” I agree, especially when the default black edges are used, but the
display improves when the edge color matches the shaded part color. In any case, sometimes this
method is necessary to see the breaks between faces, especially fillets.

Taking this one step further, you can also make use of the tangent edge settings. These settings are
found in the View > Display menu. The settings are:

B Tangent Edges Visible. Tangent edges are displayed as solid lines, just like all other
edges

B Tangent Edges as Phantom. Displays tangent edges in a phantom line font

B Tangent Edges Removed. Displays only non-tangent edges

The tangent edges removed setting leaves parts looking like a silhouette. I prefer the phantom set-
ting because 1 can easily distinguish between edges that will actually look like edges on the actual
part, and edges that only serve to break up faces on the model. The tangent edges visible setting
conveys no additional information, and is the default setting. Figure 5.19 shows a sample part with
all three settings.
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FIGURE 5.19

Samples of the tangent edge settings
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Tutorial: Visualization Techniques

Visualization is a key factor when working with SolidWorks software. Whether it is for a presenta-
tion of your design to customers or management or simply checking the design, it is important to
be able to see the model in various ways. This tutorial guides you through using several tools and
techniques.

1. If the part named Chapter5Sample.sldprt is not already opened, then open it
from the CD-ROM. If it is open and changes have been made to it, then click
File @ Reload = OK.



Using Visualization Techniques

2. Practice using some of the controls for rotating and zooming the part. In addition to
the View toolbar buttons, you should also use Z and Shift+Z (Zoom Out and In, respec-
tively), the arrow keys, and the Ctrl-, Shift-, and Alt-arrow combinations.

3. Use the MMB to select a straight edge on the part, and then drag with the MMB.
This rotates the part about the selected entity. Also apply this technique when selecting a
vertex and a flat face.

4. Select the name of the part at the top of the FeatureManager.
Click the Appearance button from the Standard toolbar.

6. Click the color you want in the Favorite panel. The model should change color. If you
click and drag the cursor over the colors, the model changes color as you drag over each
new color. You can also drag appearances from the Task Pane. Figure 5.20 shows inter-
faces for both methods.

7. 1f the Color panel is not expanded, click the double arrows to the right to expand it.
Select the colors you want from the continuous color map. Again, click and drag the cur-
sor to watch the part change color continuously.

8. Create a swatch. In the Favorite panel, select the Create New Swatch button and
call the new swatch color file BibleColors.

9. Select a color from the Color Properties continuous map; the Add Selected Color
button becomes active. Clicking the button adds the color to the swatch palette. You
can add several colors to the palette to use as favorites later on.

TR You will be able to access these colors again later by selecting BibleColors from
the drop-down list in the Favorite panel. You can transfer the colors to other com-
puters or SolidWorks installations by copying the file BibleColors.slddclr from the
<SolidWorks installation directory>\lang\english folder (or the equivalent file for
your installed language).

10. In the Appearance panel, move the Transparency slider to the right, and watch the
part become transparent.

11. To prevent the Appearance window from closing after every change, click the push-
pin at the top of the window.

12. Click the green check mark icon to accept the changes; note that with the push-pin
icon selected, the window remains available.

13. Expand the flyout FeatureManager in the upper-left corner of the graphics window,
as shown in Figure 5.21, so that all of the features in the part are visible.

14. Select the features Extrudel, Fillet7, and Fillet6 from the FeatureManager so that
they are displayed in the Selection list of the Appearances window. Select a color
from the BibleColors swatch palette that you have just created.

15. Click the check mark icon to accept the changes and clear the Selection list.

16. Select the inside face of the large cylindrical hole through the part, and assign a sep-
arate color to the face.
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FIGURE 5.20

The Color and Optics interface elements
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FIGURE 5.21

The Flyout FeatureManager

Click the check mark icon to accept the changes, and click the red X icon to exit the
command.

Expand the Display pane (upper-right area of the FeatureManager). You should see
color and transparency symbols for the overall part, and color symbols for three features.
There is no indication of the face color that is applied.

Remove the colors. Open the Appearances window again, re-select the three features
(Extrudel, Fillet7, and Fillet6), and click the Remove Color button below the Selection
list. Do the same with the colored face. Return the part transparency to fully opaque.

Click the check mark icon to accept the changes.

Change the edge display to Shaded (without edges). Then change to a Wireframe
mode. Finally, change back to Shaded With Edges.

Now select View = Display = Tangent Edges as Phantom. Figure 5.22 shows the dif-
ference between Tangent Edges Visible, as Phantom, and Removed settings.
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FIGURE 5.22

Tangent Edge display settings for a shaded model

TR Using the Tangent Edges as Phantom setting is a quick and easy way to look at a
model to determine whether or not face transitions are tangent. It does not help to
distinguish between tangency and curvature continuity; you need to use Zebra Stripes for that.

23. Switch back to Shaded display.

24. 1If you do not have a RealView-capable computer, then skip this step. Ensure that the
RealView button in the View toolbar is depressed. RMB click the Material folder in the
FeatureManager. Select Edit Material, and then select Steel, AISI 304. Rotate the part.
Notice that the finish is semi-reflective. Click the check mark icon to accept the change.

25. Turn the part over, select the bottom face, and apply an Appearance from the Task
Pane. In the top panel, expand Appearances, Metals, Steel, and then select Wrought
Steel. Apply the appearance just to the bottom face. The rest of the part should retain
the semi-reflective surface, as shown in Figure 5.23. Click the check mark icon to accept
the change.
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FIGURE 5.23

Applying a material to a part

Click the Section View button on the View toolbar. Drag the arrows in the middle of
the section plane back and forth with the cursor to move the section dynamically through
the part, as shown in Figure 5.24.

FIGURE 5.24

A section view

Click the check box next to the Section 2 panel name, and create a second section
that is perpendicular to the first.

Click the green check mark icon to accept the section. Notice that while in the Section
View PropertyManager, the RealView material does not display, but once you close the
dialog box, RealView returns.
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Summary

Visualization is a key function of the SolidWorks software. It can either be an end to itself if you
are showing a design to a vendor or client, or it can be a means to an end if you are using visualiza-
tion techniques to analyze or evaluate the model. In both cases, SolidWorks presents you with a
list of tools to accomplish the task. The tools range from the analytical to the cosmetic, and some

of the tools have multiple uses.
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he chapters of Part II take you beyond the basic model-

I ing tools to start taking advantage of the parametric IN THIS PART
options within SolidWorks. Chapter 6 acquaints you Chapter 6

with the entire breadth of sketching tools and techniques avail- Getting More from

able in SolidWorks. Chapter 7 assists you in finding the right Your Sketches

tool for the right job. Chapter 8 debunks some myths about pat-

terning and mirroring and helps you establish good design prac-

tices. The equations in Chapter 9 are, of course, one of the

quintessential strengths of parametric modeling tools. Chapter Chapter 8

10 introduces the concept of Configurations, which will help Patterning and Mirroring

you model variable driven models more quickly and efficiently.

Chapter 11 sums it all up with what I consider to be the most

important information in the book (editing), and helps you

decide if your model is “good enough” through evaluation. Chapter 10
Working with Part
Configurations

Chapter 7
Selecting Features

Chapter 9
Using Equations

Chapter 11
Editing and Evaluation
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Sketches

revious chapters have described the basic tools for sketching. This

chapter takes you to the next level, preparing you to be able to use

more advanced tools, editing and manipulating sketches, and work-
ing with sketch text, sketch pictures, and sketch colors. At the end of this
chapter, with a little practice to help the information sink in, you should feel
like you master the topic of sketching, and you should be able to handle
almost any problem that is thrown at you.

Editing Sketch Relations

When I was teaching SolidWorks reseller classes, I frequently told my
classes, “Delete is not an edit option.” In time, you will find that this is good
advice, even if you don’t agree with it now. There are times to use the Delete
command, but you should use it only when it is really necessary. In my own
work, I sometimes go to extreme lengths to avoid deleting sketch entities,
often just to stay in practice, but also because deleting sketch entities, or
even features in a part, increases the likelihood that sketch or mate relation-
ships will be broken.

The main reason for avoiding Delete in a sketch is that when you are editing
a sketch that has other features that are dependent on it, the dependent fea-
tures may lose their references, or go dangling. Because of this, even when
you can use the Delete command instead of editing, it is still a good practice
to edit instead. Deleting relations is not as critical as deleting sketch entities,
unless the relations are referenced by equations or design tables.
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beer o, ~- ~- Before deleting sketch entities, try to understand what types of relationships the

BEST PRACTLCE change will affect downstream. Be sure to consider other sketch relationships
within the current part, mates and in-context relations in the assembly, and things of this nature.
In fact, it is best to have all of this in mind when you are creating relationships to begin with. Try
to make relations to the most stable entities available, which usually means sketches and refer-
ence geometry entities as high up in the tree as possible.

Display/Delete Relations

Display/Delete Relations is your primary tool when dealing with sketch relations. It is particularly
ﬁ'& useful to sort relations by the various categories that are shown in Figure 6.1.

FIGURE 6.1

The Display/Delete Relations PropertyManager

Sketch relations in the Display/Delete Relations dialog box can be divided into the following categories:

B All in this sketch. Shows all of the relations in the active sketch.

B Dangling. Shows only the dangling relations. Dangling relations appear in a brownish-
green or olive color, and represent relations that have lost one of the entities that drives the
relation. You can repair dangling relations by selecting the entity with the dangling relation,
and then dragging the red dot onto the entity to which it should have the relation.

B Overdefining/Not Solved. Overdefined relations are any set of conflicting or redundant
instructions that are given to a sketch entity, and appear in red. For example, if a line
is collinear with an edge and also vertical, but the edge itself is not vertical, then both the
collinear and vertical relations appear in red.

The Not Solved condition often accompanies Overdefined. Not Solved typically refers to
a dimension or relation that cannot be applied because of the conflict. The lower-right
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corner of the screen and the status bar show flags warning that the sketch is overdefined,
as shown in Figure 6.2.

When an overdefined situation exists, all of the relations and dimensions in a sketch may
often become overdefined. This can look like a daunting task to repair, when the entire
problem is caused by a single relation. Do not automatically delete everything. Instead,
try deleting or suppressing the last dimension or relation that was added, or a single rela-
tion that looks suspect. It is also a good idea to delete red relations before deleting yellow
ones. Yellow simply means conflict, while red means a condition that cannot be applied.
You can suppress a dimension by setting it to Driven in the right-mouse button menu,
and you can suppress relations in the Display/Delete Relations PropertyManager.

FIGURE 6.2

An overdefined sketch

B External. External relations connect with an entity outside the active sketch. This
includes the part Origin, or any model edges. The term external relations is also
sometimes meant to signify any relations outside of the part.

B Defined in Context. Any relation between features in one part in an assembly and
another part is considered an in-context relation.

B Locked. External relations (outside the part) may be locked or broken to increase speed
and to lock out parametric changes. There is no advantage of breaking relations rather
than locking them. Both are ignored, but locked relations can be unlocked; broken
relations can only be deleted.

W Broken. See Locked.
B Selected Entities. Sketch relations are shown only for the selected sketch entities.

CC)ITEE In-context design, also called top-down, as well as locked and broken relations, is
12Uyy-1lr : -
covered in detail in Chapter 16.

~. 1 1-r 1~ | Some of the relations listed in the Display/Delete Relations dialog box may be col-

A N ored to signify the state of the relation. Unfortunately, colored relations are typi-
cally placed at the top of the list to attract attention, but when you select them, they are always
gray, and so the advantage of color-coding is defeated. The only way around this is to selecta
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FIGURE 6.3

relation other than the first one in the list. If there is only one relation in the list, you cannot see
the state color.

Also be aware that the field backgrounds for the relation symbols are different depending on
your installation of the software. If you install SolidWorks 2008 or later on a computer that has
never had a version of SolidWorks on it before, you will get the new 2008 default colors. If you
install SolidWorks 2008 on a computer that has had SolidWorks 2007 on it, you will get the old
SolidWorks 2007 colors. The colors affected by this difference include the select highlight color,
dynamic highlight, and sketch relation symbol background colors.

A setting in Tool=> Options controls the display of errors. You can select Tools= Options &> Featur
eManager to find an option called Display Warnings, where you can choose Always, Never, and All
but Top Level. When a sketch contains sketch relations with errors, they display as warning signs
on the sketch, and will propagate to the top level of a part or assembly if you have chosen the
Always option.

SketchXpert

The SketchXpert, shown in Figure 6.3, can help you to diagnose and repair complex sketch rela-
tion problems. The Diagnose button at the top creates several possible solutions that you can tog-
gle through using the forward and backward arrow buttons in the Results panel. The Manual
Repair button displays all of the relations with errors in a window and allows you to delete them
manually.

By selecting the option at the very bottom of the dialog box, you can make the SketchXpert display
any time that a sketch error occurs. To display the SketchXpert manually instead of automatically,
you can access it by right-clicking in a sketch.

The SketchXpert dialog box
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Copying and Moving Sketch Entities

SolidWorks offers several different tools to help you move sketch entities around in a sketch. In
SolidWorks, it is usually recommended to keep the sketch as simple as you can, and to create pat-
terns using feature patterns rather than sketch patterns. The following section discusses the main
tools for moving and copying sketch entities.

Move entities

Move entities enables you to move selected sketch entities by either selecting From and To points,
or by typing in XY coordinates for the move. When the Keep Relations option is off, this tool auto-
matically detaches sketch segments whose endpoints are merged, as shown in Figure 6.4. If Keep
Relations is on, SolidWorks moves the entities and tries to maintain the sketch relations and
merged points. All of these tools have a pushpin icon in the interface, which allows you to use
them many times when the pushpin icon is pushed in; they are deactivated after one use if the
pushpin icon is not pushed in.

FIGURE 6.4

Using the Move tool

Rotate entities

Rotate entities rotates selected entities in a sketch in the same way that Move entities works. You
can drag the angle or type it in manually. The green check mark icon is on the right-mouse button,
as shown in the cursor display in Figure 6.5.

%5

The Keep Relations option does not actually keep any relations — it deletes the Horizontal and
Vertical relations in the sketch, as shown in Figure 6.5 — but it does keep the merged endpoints,
as shown in the right-most image of Figure 6.5. This can be useful, especially considering how
many sketch relations it would take to make a sketch move like this naturally.
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FIGURE 6.5

Using the Rotate tool

FIGURE 6.6

Copy entities

The Copy Entities tool works exactly like the Move Entities tool, except that it copies instead of
moving.

Scale entities

Scale entities is one of those functions probably best left alone. This is because the results appear
erratic and unpredictable, particularly if there are dimensions on the sketch. This tool works on a
selection of entities, particularly on an isolated selection that is not connected to other entities in
the sketch. The PropertyManager for the Scale Entities tool is shown in Figure 6.6.

The Scale PropertyManager
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Modify Sketch

I’ The Modify Sketch tool has been available in SolidWorks for a long time, but it has been super-

+]- seded by some of the newer tools mentioned previously. However, it still has some unique func-
tionality that is not covered by any other sketch tool. Modify sketch works on the entire sketch
rather than on selections from the sketch, and it works best if there are no external relations
between sketch entities and anything outside the sketch. It can also work on a sketch without the
sketch being active. While most feature and tool interfaces have been moved to the
PropertyManager, Modify sketch still uses a dialog box that floats in the graphics window, as
shown in Figure 6.7.

FIGURE 6.7

The Modify Sketch dialog box

Scale about

The scaling function in the Modify Sketch tool enables you to scale about either the part Origin or
the Moveable Origin. The Moveable Origin is the black origin symbol with knobs on the ends of
the axes and at the intersection. The Moveable Origin can be moved and even snapped to entities
that are internal or external to the sketch.

Translate

The Translate function of the Modify Sketch tool enables you to click and drag to move the entire
sketch, or to select a point and move it to a specific set of coordinates that you type in. If the
sketch is dragged onto an external entity and picks up an automatic relation, then a message may
appear that you can now use Modify sketch only for rotating the sketch because there is an exter-
nal relation.

Rotate

The Rotate function of the Modify Sketch tool enables you to position the Moveable Origin to act
as the center of rotation, and to either type in a rotation angle or drag with the right-mouse button
to rotate, as indicated by the cursor.
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FIGURE 6.8

Mirroring

When you place the cursor over the knobs on the Moveable Origin, the cursor symbols change to
indicate the functionality of the right-mouse button. These cursors are shown in action in Figure
6.8. The cursors enable mirroring about X, Y, or both simultaneously.

The Modify Sketch tool cursors
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MNOTE

The Modify Sketch tool is still one of my favorite sketch editing tools to use because
it is straightforward and doesn’t do anything unexpected. It was also an original
SolidWorks development, not a tool meant to duplicate existing AutoCAD functionality like
some of the previously mentioned sketch tools.

The one thing about Modify Sketch that many people find unsettling is that the red sketch origin
moves and rotates along with the rest of the sketch. Once you make peace with the fact that you
can’t use the red sketch origin for much anyway, this becomes unimportant.

Copy and paste

Probably the simplest way to copy sketch entities in a sketch is to select the entities and use Ctrl+C
and Ctrl+V or one of the many other methods available for this purpose (such as the right-mouse
button menu, the Edit menu, and Ctrl+dragging).

In addition to copying selected entities within an active sketch, you can also select a sketch from
the FeatureManager and copy or paste it to a selected plane or planar face. This creates a new
sketch feature in the FeatureManager that has no relation to the original, although it does maintain
internal dimensions and relations. (External relations are not copied with the sketch.) This is par-
ticularly useful when setting up certain types of lofts that use several profiles that can be created
from a single copied profile. Copying and pasting is a fast and effective method of putting sketches
on planes.

Simple drag

If a selected set of sketch entities has no external relations, then you can select it as a group and
move it without distorting or resizing the sketch. For best results with this, avoid dragging end
points.
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Derived sketch

A derived sketch is a parametrically linked copy. The original parent and derived sketches do not
need to have any geometrical relation to one another, but when the parent sketch is changed, the
dependent derived copy is updated to stay in sync.

To create a derived sketch, you can select a plane or planar face, Ctrl-select the sketch of which
you want to make the parametric copy, and then click Insert=> Derived Sketch.

When you create a derived sketch, you cannot change its shape; it works like a block of a fixed
shape driven by the parent. However, you can change the position and orientation of the derived
sketch. Figure 6.9 shows a derived sketch and its parent. Modify Sketch is a great tool to use for
manipulating derived sketches that don’t have any relations to things outside the sketch, especially
for mirroring or rotating.

FIGURE 6.9

A derived sketch and its parent

Original sketch Derived sketch

Using Sketch Pictures

Sketch pictures are images that are placed in a sketch on a sketch plane. You can size and rotate
the images, give them a transparent background, trace over them, and suppress them. They display
as a child of the sketch. Image types that you can use as sketch pictures are BMP, GIF, JPEG, TIFF,
PNG, PSD and WME.
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To bring a picture into a sketch, the sketch must first be active. Click Sketch Picture on the Sketch
toolbar (it is not there by default, and so you may need to drag it onto the Sketch toolbar from the
Tools= Customize & Commands dialog box). You can also access this command through the
menus at Tools= Sketch Tools&> Sketch Picture. You cannot use sketch pictures in assembly
sketches, but they can be shown in a part sketch in an assembly.

To change the size of a sketch picture, you can double-click it and drag one of the handles around
the outside of the image. When the picture comes into the sketch, it is usually too big, having been
sized at a ratio of 1 pixel to 1 mm. To size a picture accurately, you should include a ruler or an
object of a known size in the image. If you cannot do this, the next best thing is to guess the size.
Draw a line in your sketch and dimension it to approximately the size of something that is recog-
nizable in the image, and then move the image by clicking and dragging it to lay the dimensioned
sketch entity as close over the object in the image as possible.

You can rotate and mirror images, as well, using the Sketch Picture PropertyManager. Images are
opaque, and you cannot see the model through them, but at the same time, you also cannot see the
images through the model. They are like a flat piece of paper that is pasted to the model or hang-
ing in space.

You can add transparency to images, either by selecting a color or by using the built-in transpar-
ency in the image file. When you select a color to be transparent, you will also need to turn up
both the Matching Tolerance and the Transparency value sliders, which are by default set to their
minimum values.

~. ==~ | Startingin 2007 and as late as early releases of SolidWorks 2009, if a Sketch Picture
e N has had transparency applied to it, and you double-click the picture, SolidWorks
automatically bumps you into the eyedropper mode, which is selecting a color to be transparent.
A single extra click in this mode can make a mess of your Sketch Picture transparency settings by
changing the selected transparency color.

Sketch pictures cannot be shown on a drawing associatively. The only way to do this is to capture
an image of the sketch picture that is being shown in the model, and putting this image in the
drawing. PhotoWorks does not use sketch pictures, either, and PhotoWorks Decals are a separate
item altogether.

TP Although the most common use for the sketch picture is as a tracing guide, you can
use it for a wide variety of other purposes. For example, any sort of logo, decal, or
display that is on a flat surface can be shown as a sketch picture.

- t,~ . - ~ - Bestpractice for using sketch pictures is to put them into a separate sketch near or

BEST PRACTICE at the top of the FeatureManager. Even though you can have sketch entities in a
Sketch Picture sketch, I prefer to keep them in separate sketches. This is because when you use
the sketch entities for an extrude or a loft guide curve, this sketch will be consumed under that
feature, which means that the image becomes buried somewhere in your model, rather than
being easily accessible at the top of the FeatureManager.
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Three views

When building a model from images, it is often helpful to have three or more images from orthog-
onal views, similar to re-creating a part from a 2D drawing. If you have a left and a right view, it
may be a good idea to put them on planes that are slightly separated so that the images are not
exactly on top of one another, which makes them both hard to see. Putting them on slightly offset
planes means that one will be clearly visible from one direction, and the other visible from the
other direction.

Each sketch picture must be in a separate sketch. Figure 6.10 demonstrates the use of multiple

sketch pictures to trace the outline of a vehicle, with the partially complete model shown with the
images.

FIGURE 6.10

Using multiple sketch pictures

Additionally, you can put multiple sketch pictures inside a single sketch if you want to do that.
Both images show up in the FeatureManager, and both can be displayed at the same time, although
you may have difficulty if you want to put them on top of one another.

Perspective

When taking digital photographs to be used as sketch pictures in SolidWorks, you have to con-
sider the effects of perspective on the image. Perspective can make it difficult to size items in the
foreground or background. You should be aware of this, as well as that objects at different dis-
tances from the camera will appear at distorted sizes. If you are taking the pictures that will be
used as sketch pictures, you can minimize the effects of perspective by standing farther away from
the object and using zoom on the camera if possible.
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FIGURE 6.11

Sharp edges

When you are drawing a sketch of an object, you are usually drawing theoretically sharp corners of
the model. Real parts usually have rounded corners, and so you may have to use your imagination
to project where the 3D surfaces would intersect at an edge minus the fillets.

When you are reverse-modeling a part from images, you are not using an exact science. It is
better than not being able to put pictures into the sketch, but there is nothing about it that can be
considered precise.

Auto Trace

Auto Trace is an add-in that you can turn on via the Tools®> Add-ins menu. Auto Trace is intended
to trace between areas of contrast in Sketch Pictures, creating sketch entities. To use Auto Trace,
make sure the add-in is activated. Activating the Auto Trace add-in activates a set of arrows at the
top of the Sketch Picture PropertyManager. There is nothing to identify the functionality with the
Auto Trace name. Figure 6.11 shows the Sketch Picture and Auto Trace PropertyManagers. The
sliders for the Auto Trace functionality do not point out which end is high and which is low.

Sketch Picture and Auto Trace PropertyManagers
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Auto Trace prefers solid blocks of black and white in the Sketch Pictures. To achieve this, you may
need to use image processing software and reduce your picture to a two color (black and white)
bitmap, TIF, or PNG image. Even if this pre-processing gives perfect results, don’t expect much
from Auto Trace.

I can’t imagine a situation in which I would either use this myself or recommend anyone else to
use it. In all cases, including idealized demonstration images or those in which traced images
would be of the most benefit to the user such as logos with complex curvature, I believe it would
be faster and more accurate to just do the tracing manually, even it means using splines.

Using Sketch Text

Sketch text uses TrueType fonts to create text inside a SolidWorks sketch. This means that any
TrueType font that you have can be converted to text in solid geometry; this includes Wingdings
and symbol fonts. Keep in mind that some characters in certain fonts do not convert cleanly into
SolidWorks sketches. Sketch text still has to follow the rules for sketching and creating features
such as closed contours, as well as not mixing open and closed contours.

You can make sketch text follow a sketch curve; to space it evenly along the curve, you can control
character width and spacing, as well as overall size by specifying points or actual dimensions.
Sketch text can also be justified right, left, centered and evenly, as well as reversed, rotated, and
flipped upside down. Figure 6.12 shows the Sketch Text PropertyManager and some of the possi-
ble uses of sketch text.

The icons in the Sketch Text PropertyManager are fairly self-explanatory, other than the Rotated
Text option, which rotates individual letters, and not the whole string of text.

You can use the Sketch Text tool multiple times in a single sketch to make pieces of text with dif-
ferent properties. Each string of text has a placement point located at the lower left of the text. This
point can be given sketch relations or dimensions to locate the text.

If the text overlaps in places, as shown in Figure 6.12, you can correct this in a couple of ways.
First, you can extrude it with the Merge option turned off so that each letter is created as a separate
solid body. You can also explode sketch text so that it becomes simply lines and arcs in a sketch,
which you can edit the same as any other sketch. You could also adjust the Width Factor and
Spacing settings.
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Examples of sketch text

Using Colors and Line Styles with Sketches

Custom colors and line styles are usually associated with drawings, not sketches; in fact, they are
most valuable when used for drawings. In sketches, this functionality is little known or used, but is
still of value in certain situations.

Color Display mode

In drawings, you can use the Color Display Mode button to switch sketch entities on the drawing
h_ between displaying the assigned line or layer color and displaying the sketch status color. It has
exactly the same effect here in part and assembly sketches.

When you press the button, the sketch state colors are used. When the button is not pressed, any
custom colors that you have applied to the sketch entities will display. If the button is not pressed
and you have not applied colors to the entities, then the default sketch state colors are used.

You can use sketch colors for emphasis, to make selected sketch entities stand out, or to make
sketches with various functions immediately distinguishable. Color Display mode only has an
effect on an active sketch. Once a sketch is closed, it returns to the gray default color for inactive
sketch entities.
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Line color

Line color enables you to assign color to entities in an active sketch. Whether the assigned color or
the default sketch status colors are used is determined by the Color Display Mode tool.

Edit sketch or curve color

You can use the Edit Sketch Or Curve Color tool to assign color to an entire sketch. The color that
you assign to sketches in this way displays only when the sketch is inactive, instead of the default
gray color. They also follow the toggle state of the Color Display Mode button. For example, if the
Color Display Mode button is depressed, then inactive sketches display as gray. When the Color
Display Mode button is not pressed, then inactive sketches display in any color that you have
assigned by using the Edit Color tool.

Line thickness and line style

The Line Thickness and Line Style tools function independently from the Color Display Mode
button, but they are still used only when the sketch is active. As soon as a sketch that contains
entities with edited thickness and style is closed, the display goes back to the normal line weight
and font.

To assign a thickness or a style, you can select the sketch entities to be changed, press the button,
and select the thickness or style. Although a single sketch entity may have only a single thickness
or style, you can use multiple thicknesses or styles within a single sketch. Figure 6.13 shows a
sketch with the thickness and style edited.

0SS EE Line thickness and line styles are covered in more detail in the discussion of
A3 Jo=lREr drawings in Chapter 20.

O

FIGURE 6.13

A sketch with edited line thickness and line style
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Using Other Sketch Tools

SolidWorks has a lot of functionality that crosses between multiple topics. The following tools
could be placed in other sections of the book, but I have placed them here because they will help
you work with and control 2D sketches in SolidWorks. Almost everybody who opens the
SolidWorks software at one time or another has to use a sketch, so these tools could be applied by
a wide swath of users.

RapidSketch

As the name suggests, RapidSketch is meant to help you rapidly create a number of sketches on
different planes. As you move a sketch cursor over flat faces of a model, the faces highlight to indi-
cate that you can start a new sketch there.

The workflow with this tool is that you start in one sketch, with an active sketch tool, move the
cursor over another plane or face without exiting the first sketch, and start sketching the entity on
the new plane.

The only real down side of using RapidSketch is that if you sketch on a particular plane or face
where other planes or faces might be visible in the background, SolidWorks might interpret certain
selections as trying to change sketch planes. To get back to a previous sketch, deactivate the cur-
rent sketch tool (for example by using Esc) and double-click the previous sketch you want to get
back to. To move to a later sketch, use the normal sketch exiting techniques.

Sensors

You can add Sensors in the SolidWorks FeatureManager for parts and assemblies by right-clicking
on the Sensors folder and selecting Add Sensor. You can find the Sensors folder at the top of the
FeatureManager. If you cannot find the Sensors folder, go to Tools® Options=> FeatureManager,
and make sure the Sensor folder is set to Show.

Figure 6.14 shows the Sensor PropertyManager. You can create sensors for measurements, simulation
data, or mass properties. The reason I have included Sensors in this chapter is because of the mea-
surements, which allow you to select a dimension, and set a range of values or criteria for which you
want to be notified. The dimension can be a driving (black) sketch dimension, or a driven (gray)
dimension on a sketch, or even a driven dimension placed directly on solid geometry.

The second image shows what happens when a sensor finds a condition that you asked it to notify
you about.

In addition to turning Sensor alarms on or off, you can also suppress Sensors when no longer
needed or to improve performance.

Sensors are a great way to keep an eye on particular values such as wall thickness or clearance
between parts. Any value you want to monitor but don’t drive directly can be monitored with a
Sensor.
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The Sensor PropertyManager

Meta data for sketches

Meta data in SolidWorks is non-geometrical text information. Meta data is particularly helpful as
keywords in searches, and also in PDM applications. If you don’t make use of meta data within
your CAD documents, it can be easy to forget that it is there at all.

The sources for storing meta data in SolidWorks files are:

Sketch and feature names
Sketch and feature comments (access comments via the right-mouse button menu)
Custom Properties

Design Binder documents

Tags for features (located on Status Bar in the lower-right corner)

Meta data searches can be particularly useful in large assemblies or parts with long lists of features
that you need to access for various reasons. You can conduct searches for meta data through the
FeatureManager Filter at the top of the FeatureManager. The Advanced Search function in assem-
blies can also search meta data sources. SolidWorks Explorer is a good first level data management
solution that can search, display and edit meta data and previews. Windows Explorer can also
search properties and tags.
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Construction geometry

In SolidWorks, the only construction geometry that can be created directly is the construction line.
All other sketch entities can be converted to construction geometry by selecting the Construction
Geometry option within the sketch entity’s PropertyManager or by using the Construction
Geometry toggle toolbar button.

SolidWorks terminology is inconsistent, because it sometimes refers to construction lines as center-
lines. The two are really the same thing. Centerlines are used for revolved sketches and mirroring,
but there is no difference between a centerline and a construction line in SolidWorks.

Construction geometry is useful for many different types of situations. I use it frequently for refer-
ence sketch data. You can make sketch relations to construction geometry, and can use it for layout
sketches or many other purposes limited mainly by your needs and imagination.

Tutorial: Editing and Copying

This tutorial guides you through some common sketch relation editing scenarios and using some of
the Copy, Move, and Derive tools. Follow these steps to learn about editing and copying sketches:

1. Open the part named Chapter6 Tutoriall.sldprt from the CD-ROM. This part
has several error flags on sketches. In cases where there are many errors, it is best to roll
the part back and go through the errors one by one.

2. Drag the rollback bar from just after the last fillet feature to just after Extrude3. If
Extrude3 is expanded so that you can see Sketch3 under it, then drop the rollback bar to
after Sketch3. If a warning message appears, telling you that Sketch3 will be temporarily
unabsorbed, then select Cancel and try the rollback again. Figure 6.15 shows before and
after views for the rollback.

3. Edit Sketch3 and turn off the Sketch Relations display (View = Sketch Relations).
Relations with errors will still be displayed. Click Display/Delete Relations on the toolbar
(the Eyeglasses tool), and set it to All in This Sketch. Notice that all of the relations con-
flict, but only one is unsolvable: the Equal Radius relation. This appears to be a mistake
because the two arcs cannot be equal.

Delete the Equal Radius relation. The sketch is still not fixed.

Click the green check mark icon to close the Display/Delete Relations
PropertyManager.

Right-click the graphics window and select SketchXpert. Then click Diagnose.

Using the double arrows in the Results panel, toggle through the available solu-
tions. All of the solutions except one remove sketch relations. Accept the one solution
that removes the dimension. Some versions of SolidWorks may not have any solutions
that remove the dimension. If this happens to you, use the Manual Repair option, and
delete the dimension. When you are done, click the green check mark icon to exit the
SketchXpert. The sketch no longer shows errors in the graphics window, but it still does
in the FeatureManager.
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FIGURE 6.15
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Rolling the part back to Extrude3

Rollback bar Rollback cursor

Model in rolled back state

Close the sketch. Notice that the error flag does not disappear until the sketch has been
repaired and closed.

Use the rollback bar to roll forward to after Extrude2 and Sketch2. Figure 6.16
shows the tooltip message that appears if you place the cursor over the feature with the
error. With time, you will begin to recognize the error messages by a single keyword or
even by the shape of the message text. This message tells you that there is a dangling rela-
tion — a relation that has lost one of the entities.

Edit the sketch. (See Figure 6.17). If you show the Sketch Relation icons again, the
errors will be easier to identify. When you use Display/Delete Relations (Tools=>
Relations= Display/Delete Relations), the first two Coincident relations appear to be
dangling. Clicking the relation in the Relations panel of the Display/Delete Relations
PropertyManager shows that one point was connected to a line and the other point was
connected to a point.

Click the name of the dangling entity in the Entities panel of the PropertyManager;
then click the vertex indicated in Figure 6.17 in the Replace box at the bottom.
When you have fixed the errors, exit the sketch and confirm that the flag is no longer on
Sketch2.

An easier way to repair the dangling relation is to click on the dangling sketch point
once. It will turn red. Next drag the point onto an entity that you want to reattach the
relation to.

Drag the rollback bar to just before CutExtrudel. Edit 3DSketchl. This sketch is
overdefined. If the Sketch Relations are not on at this point, then turn them on again.
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FIGURE 6.16

The Error tooltip

Because this is a task that you will perform many times, this is a good opportunity to
set up a hotkey for this function. As a reminder, to set up a hotkey, go to

Tools = Customize > Keyboard, and in the Search box, type relations. In the Shortcut column for
this command, select a hotkey to use.

13.

14.
15.

16.

17.

18.

19.

Double-click one of the relation icons; the Display/Delete Relations
PropertyManager appears. Notice that one of the sketch relations is a Fixed relation.
Remove the Fixed relation, and exit the sketch.

Right-click anywhere in the FeatureManager and select Roll To End.

Click CutExtrudel in the FeatureManager so that you can see it in the graphics win-
dow, and then click a blank space to deselect the feature.

Ctrl-drag any face of the cut feature, and drop it onto another flat face. The Ctrl-drag
function copies the feature and the sketch, but the external dimensions and relations
become detached. This will only work if Instant3D is turned off.

Click Dangle in response to the prompt. This means that you will have to reattach
some dangling dimensions rather than re-creating them. Edit the newly created sketch,
which now has an error on it.

Two of the dimensions that went to external edges now have the olive dangling
color. Select one of the dimensions; a red handle displays. Drag the red handle and
attach it to a model edge. Do this for both dimensions. The dimensions update to reflect
their new locations. Exit the sketch and verify that the error flag has disappeared.

Expand CutExtrudel, and select Sketch5 under it. Ctrl-select a flat face on the model
other than the one that Sketch5 is on. In the menu, select Insert= Derived Sketch. You
are put into a sketch editing the derived sketch.
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FIGURE 6.17

Fixing dangling errors

Two points with
dangling relations

/

Drag this point Drag this point
to this corner to this edge

The sketch is blue, and so you should be able to resize it, right? No, it doesn’t work
that way. You can test this by dragging the large circle; it only repositions the sketch as a
unit.

Dimension the center of the large circle to the edges of the model.

Drag the smaller circle, and notice that it swivels around the larger circle. Create an
angle dimension between the construction line between the circle centers and one of the
model edges. Notice that the sketch is now fully defined.

Exit the sketch, and look at the name of the derived sketch in the FeatureManager.
The term derived appears after the name, and the sketch appears as fully defined.

Right-click the sketch and select Underive Sketch. Notice that the sketch is now
underdefined. The Underive command removes the associative link between the two
sketches.
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Tutorial: Controlling Pictures, Text,
Colors, and Styles

This tutorial guides you through some of the miscellaneous functions in sketches, and shows you
what they are used for and how they are used. Follow these steps to learn how to control these
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items:

1.

Open a new part using a template with inches as units. Open a sketch on the Front
plane, and draw a construction line starting from the origin 12 inches down (negative Y)
away from the Origin.

Insert a sketch picture in this sketch. Use Sketch Picture 1.tif from the
CD-ROM for Chapter 6.

Resize the image so that the endpoints of the construction line are near the centers
of the holes on the ends of the part. To move the image, just double-click it first, and
then drag it. To resize it, drag the corners.

In the Transparency panel of the Sketch Picture PropertyManager, select the
Eyedropper tool and click in the white background of the image. Make sure that the
color field next to the Eyedropper tool changes to white.

Slide the Transparency and Matching Tolerance sliders all the way to the right, or
type 1.00 in the number boxes.

Close the sketch, and rename it Sketch Image Front View.

Put the image Sketch Picture 2.tif, also from the CD-ROM, on the Right plane, and
resize it to fit with the first image. Center it symmetrically about the Origin. Also set
the transparency to the same setting as the first image.

Open a new sketch, also on the Front plane, and draw two circles to match the fea-
tures on the ends. Extrude them using a Mid Plane extrusion to match the image in the
other direction (about 2.5 inches), as shown in Figure 6.18.

FIGURE 6.18

Using sketch pictures
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9. Open another new sketch on the Front plane and draw the tangent lines to form the
web in the middle of the part. Close the sketch to make a solid extrusion. Extrude this
part .5 inches Mid Plane.

10. Open a new sketch on the face of the large flat web that you created in the previous
step, and offset the arc edge of the larger circular boss by 2.1 inches.

11. Change the arc to a construction arc and drag its endpoints to approximately the
position shown in Figure 6.19. The endpoints of the arc are blue after you drag them.
Give them a Horizontal relation, and then dimension them.

FIGURE 6.19

Creating an offset arc

12. Click Tools=> Sketch Entities = Text to initiate the creation of sketch text.
13. Select the construction arc to go into the Curves window.
14. In the Text window, type SolidWorks. Select the Full Justify option.

15. Deselect the Use Document Font option, click the Font button, and then set the
Units to .50 inches. Click the Bold button to make the text thicker. Click OK to exit the

dialog box. Click the green check mark icon to exit the sketch text, and then exit the
sketch.

16. Extrude the text to a depth of .050 inches with 3 degrees of draft. The part at this
point resembles Figure 6.20.

IVTANIGE Sketch Text is a real performance killer. The more text that you use, the longer it
RMANCE takes to extrude. Draft on the extrusion adds to the time required.
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17.

18.

19.

20.

21.

FIGURE 6.20

Creating extruded text

Select the flat face on the other side of the part from where you just extruded the
text, and open a sketch.

Select the face and click the Offset button to make a set of sketch entities offset to
the inside of the face by .50 inches. Remember that you may have to reverse the offset
to get it to work properly.

Turn on the Line Format toolbar (right-click any toolbar other than the
CommandManager and select Line Format).

Select all of the sketch lines, and change their color using the Line Color tool.
Change the line thickness and the line style using the appropriate tools. The sketch now
looks something like Figure 6.21.

When you click the Color Display Mode tool, the colors return to regular sketch
colors. When you exit the sketch, the line weight and style also return to normal.

FIGURE 6.21

Using line thickness and line style
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Tutorial: Using Meta Data

If you integrate the use of meta data into your company’s modeling process, your SolidWorks
models can be a resource for much more than just geometrical data. In this tutorial, discover the
hidden treasure of extra information stored as meta data in this model.

1. Open the part from the CD-ROM called Chapter 6 - Dial Cover.sldprt.

2. Check the Custom Properties in this file by going to File = Properties. Notice the
Thickness and Process properties in particular. All of the meta data entry interfaces are
shown in Figure 6.22.

FIGURE 6.22

Meta data entry interfaces

Add a Custom Property with the Property Name Material, type Text, and value ABS.

Check the Comments in this part. Notice that a Comments folder exists near the top of
the FeatureManager. Inside it is a list of the features for which I have written comments.

5. Add a Comment by right-clicking on the VarFillet3 feature, selecting Comment fly-
out arrow, clicking the Add Comment option, clicking the Date/Time Stamp button,
and adding a comment that uses the word Blend.

6. Check the Tags for the part by clicking the small yellow tag in the lower right-hand
corner of the Status Bar, then click on any feature, and double-click in the Tags
interface box.

Add a Tag by selecting the Cut-Extrudel feature and adding the tag pilar.
Right-click on any item in the FeatureManager and select Go To from the options.

Type 37 in the box and click the Find Next button. The FeatureManager should high-
light a feature near the bottom of the tree named Fillet37.

10. Left-click on Fillet37 in the Feature Manager and select the Zoom To Selection tool.
Zoom to Selection is a magnifying glass with an equal sign in it. The display zooms and
pans to a fillet on one end of the part.

11. Right-click on a face of Fillet37 on the model and select Go To Feature (In Tree),
which will select and scroll if necessary the FeatureManager to show Fillet37. This
sequence of tools shows the importance and interdependence of feature names and the
actual geometry.
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12. Enter the word Thickness in the filter at the top of the FeatureManager. Figure 6.23
shows the result. Notice how quickly the results appear. Notice also that the meta data
item that caused the feature to show in the list can be shown in a tooltip by hovering the
mouse over the feature.

FIGURE 6.23

Using the FeatureManager Filter to search for meta data

13. Click the X at the right end of the filter to restore the FeatureManager to its original
state, and type the word Pilar instead. Now filter for “Thermoform.”

Summary

Many tools that are available in sketches are not commonly shown in the most popular sources of
information, including official training manuals. The difference between a good CAD tool and a
great communication tool can be some of these minor functions that just make life a little easier, or
the presentation or editing of data a little better. When you explore the capabilities of SolidWorks,
it usually rewards you with functionality that is not immediately obvious.
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henever I do a woodworking project, the most frustrating part of

the job is to envision a result, but not be able to accomplish it

because I do not have the tools to get it done; worse yet is to
actually have the tools but either not understand how to use them or not
even realize that [ have them. Getting the job done is so much more satisfy-
ing when you use the right tools and get the job done right — not just so
that it looks right, but so that it really is right.

[ see users run into the same issues with SolidWorks. SolidWorks offers so
many "tools in the toolbox” that it is sometimes difficult to select the best
one, especially if it is for a function that you do not use frequently.

This chapter helps you to understand how each feature functions and offers
situations when they are best applied or avoided.

Identifying When to
Use Which Tool

[ am always trying to think of alternate ways of doing things. It is important
to have a backup plan, or sometimes multiple backup plans, in case a feature
doesn’t perform exactly the way you want it to. As you progress into more
complex features, you may find that the more complex features are not as
well behaved as the simple features. You may not be able to get away with
just doing blind extrudes and cuts with simple chamfers and fillets for the
rest of your career. And even if you could, who would want to?
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As an exercise, [ often try to see how many different ways a particular shape might be modeled,
and how each modeling method relates to manufacturing methods, costs, editability, efficiency,
and so on. You may also want to try this approach for fun or for education.

This chapter helps you identify which features to use in which situations, and in some cases which
features to avoid. As SolidWorks grows more and more complex, and the feature count increases
with every release, understanding how the features work and how to select the best tool for the job
becomes ever more important. If you are only familiar with the standard half-dozen or so features
that most users use, your options are limited. Sometimes simple features truly are the correct ones
to use, but using them because they are the only things you know is not always the best choice.

Extrude

Extruded features can be grouped into several categories, with extruded Boss and Cut features at
the highest level. With the use of Instant3D, extruded bosses can be transformed into cuts. It is
unclear what advantage this has in real world modeling, but options are options. As a result the
names of newly created extrude features are simply Extrudel where they used to be Extrude-Bossl
or Extrude-Cutl.

The “Base” part of the Extruded Boss/Base is a holdover from when SolidWorks did not allow mul-
tibody parts, and the first feature in a part had special significance that it no longer has. This is also
seen in the menus at Insert &> Boss/Base. The Base feature was the first solid feature in the
FeatureManager, and you could not change it without deleting the rest of the features. The intro-
duction of multibody support in SolidWorks has removed this limitation.

~ Multibody parts are covered in detail in Chapter 26.

e
1ZET

-

Solid Feature

In this case, the term solid feature is used as an opposite of thin feature. This is the simple type of
feature that you create by default when you extrude a closed loop sketch. A closed loop sketch
fully encloses an area without gaps or overlaps at the sketch entity endpoints. Figure 7.1 shows a
closed loop sketch creating an extruded solid feature. This is the default type of geometry for
closed loop sketches.

Thin Feature

The Thin Feature option is available in several features, but is most commonly used with Extruded
Boss features. Thin features are created by default when you use an open loop sketch, but you can
also select the Thin Feature option for closed loop sketches. Thin features are commonly used for
ribs, thin walls, hollow bosses, and many other types of features that are common to plastic parts,
castings, or sheet metal.

Even experienced users tend to forget that thin features are not just for bosses, but can also be used
for cuts. For example, you can easily create grooves and slots with thin feature cuts.
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A closed loop sketch and an extruded solid feature

Figure 7.2 shows the Thin Feature panel in the Extruded Boss PropertyManager. In addition to the
default options that are available for the Extrude feature, the Thin feature adds a thickness dimension,
as well as three options to direct the thickness relative to the sketch: One-Direction, Mid-Plane, and
Two-Direction. The Two-Direction option requires two dimensions, as shown in Figure 7.2.

FIGURE 7.2

The Thin Feature interface

Thin feature sketches are typically simpler than closed loop sketches, which usually means that
they are more robust through changes. You can create the simplest cube from a single sketch line
and a thin feature extrude. However, because they are more specialized in some respects, they are
not as flexible when the design intent changes. For example, if a part is going to change from a
constant width to a tapered or stepped shape, thin features do not handle this kind of change.
Figure 7.3 shows different types of geometry that are typically created from thin features.
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FIGURE 7.3

Different types of geometry created from thin features
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Sketch types

I have already mentioned several sketch types, including closed loop and open loop. Closed loop
sketches make solid features by default, but you can also use them to make thin features. Open
loop sketches make thin features by default, and you cannot use them to make solid features.

Sketch contours

Sketch Contour is an option that is used in other competing CAD packages and that SolidWorks
has adopted, probably more to match features in the competing software than to create a better
way of doing things. In my opinion, using sketch contours promotes sloppy work, although in
some cases, they act as valid time savers.

In general, sketch contours enable you to select enclosed areas where the sketch entities themselves
actually cross or otherwise violate the usual sketch rules. One of these conditions is the self-inter-
secting contour.
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BEST DPEACTL L SolidWorks works best with well-disciplined sketches that follow the rules. As a
e result, if you plan to use sketch contours, then you should make sure that it is not
simply because you are unwilling to clean up a messy sketch.

When you define features by selecting sketch contours, they are more likely to fail if the selec-
tion changes when the selected contour’s bounded area changes in some way. It is best practice
to use the normal closed loop sketch when you are defining features. Contour selection is best
suited to “fast and dirty” conceptual models, which are used in very limited situations for pro-
duction models.

As shown in Figure 7.4, there are several types of contour selection.

FIGURE 7.4

Types of contour selection

3D sketch

You can make extrusions from 3D sketches, even 3D sketches that are not planar. While not neces-
sarily the best way to do extrudes, this is a method that you can use when needed. You can estab-
lish direction for an extrusion by selecting a plane (normal direction), axis, sketch line, or model
edge.

When you make an extrusion from a 3D sketch, the direction of extrusion cannot be assumed or
inferred from anything — it must be explicitly identified. Extrusion direction from a 2D sketch is
always perpendicular to the sketch plane unless otherwise specified.
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Non-planar sketches become somewhat problematic when you are creating the final extruded fea-
ture. The biggest problem is how you cap the ends. Figure 7.5 shows a non-planar 3D sketch that
is being extruded. Notice that the end faces are, by necessity, not planar, and are capped by an
unpredictable method, probably a simple Fill surface. This is a problem only if your part is going
to use these faces in the end; if it does not, then there may be no issue with using this technique. If
you would like to examine this part, it is included on the CD-ROM as Chapter 7 Extrude 3D
Sketch.sldprt.

Extruding a non-planar 3D sketch

cro
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If you need to have ends with a specific shape, and you still want to extrude from a non-planar 3D
sketch, then you should use an extruded surface feature rather than an extruded solid feature.

One big advantage of using a 3D sketch to extrude from is that you can include profiles on many
different levels, although they must all have the same end condition. So if you have several pockets
in a plate, you can draw the profile for each pocket at the bottom of the pocket, and extrude all the
profiles Through All, and they will all be cut to different depths.

3D sketches also have an advantage when all the profiles of a single loft or boundary are made in a
single 3D sketch. This enables you to drag the profiles and watch the loft update in real time.

coobcE Surfacing features are covered in detail in Chapter 27. Chapter 4 contains additional
VIR ET details on extrude end conditions, thin features, directions, and the From options.
Chapter 31 also has more information on 3D sketches.
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Instant 3D

Instant 3D is a function that was added in SolidWorks 2008, and largely replaces the Move/Size
Features function. Instant 3D is not a complete replacement of Move/Size Features — it has some
limitations that the older function does not have — but it also adds new functionality that did not
exist before. This topic follows the Extrude feature because one of the functions of Instant 3D is to
help you create extruded bosses and cuts quickly.

Instant 3D also allows you to edit other types of features and sketches by simply dragging handles
in the graphics window, instead of editing numbers in a dialog box.

Creating extrudes with Instant 3D

Instant 3D allows you to select a sketch or a sketch contour and drag the Instant 3D arrow to cre-
ate either a blind extruded boss or cut. The workflow when using this function requires that the
sketch must be closed. Instant 3D cannot create a thin feature, and any sketch or contour that it
uses must be a closed loop. Sketches must also be shown (not hidden) in order to be used with
Instant 3D.

Crre Even though the words “Instant 3D” suggest that you should be able to instantly
MNOTE :
create 3D geometry from a sketch that you may have just created, you do have to
close the sketch first to get instant functionality.

Figure 7.6 shows Instant 3D arrows for extruding a solid and the ruler to establish blind extrusion
depth. These extrusions were done from a single sketch with three concentric circles, using con-
tour selection.

Even after you create an extruded boss, you can use Instant 3D to drag it in the other direction to
make an extruded cut. When you do this, the symbol on the feature changes, but the name does not.

Prior to SolidWorks 2008, SolidWorks automatically assigned the name Boss-Extrudel to an
extruded boss. In SolidWorks 2008 and later, the default is simply Extrudel. If your second fea-
ture is a cut, SolidWorks names that feature Extrude2. So in the automatic naming conventions,
SolidWorks no longer distinguishes between bosses and cuts.

If you have a sketch that requires contour selection — for example, the three concentric circles
used in Figure 7.6, after the first feature is created from the sketch — SolidWorks automatically
hides the sketch, and to continue with Instant 3D functionality using additional contours selected
from that sketch, you will have to show the sketch again. This interrupts the workflow and makes
using this functionality less fluid than it might otherwise be. I only mention it here so that you are
aware of what is happening when the sketch disappears and the Instant 3D functionality disap-
pears with it.

215



m Building Intelligence into Your Parts

Creating features with Instant 3D

Notice the boss extrude symbol next to the hand in Figure 7.6. This enables you to switch the type
of feature you are creating with Instant 3D. If geometry already exists in the part, and you drag a
new feature into the existing solid, SolidWorks assumes you want to make a cut. But maybe what
you are really trying to make is a boss that comes out the other side of the part. These heads-up
display icons enable you to do this. Options include boss, cut, and draft. The draft option enables
you to add draft to a feature created with Instant 3D.

While Instant 3D can only create extruded bosses and cuts, it can edit revolves. If you create a
revolved feature revolving the sketch say 270°, the face created at the angle can be edited by
Instant 3D dragging.
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Editing geometry with Instant 3D

Instant 3D enables you to edit 2D sketches and solid geometry. You can also edit some additional
feature types using Instant 3D such as offset reference planes. It can neither create nor edit surface
geometry or 3D sketches in some situations. To edit solid geometry, click on a face, and an arrow
appears. Drag the arrow, and SolidWorks automatically changes either the sketch or the feature
end condition used to create that face. If a dimensioned sketch was used to create that face,
SolidWorks will not allow you to use the Instant 3D arrow to move or resize the face. An option
exists that enables Instant 3D changes to override sketch dimensions at Tools=> Sketch

Settings=> Override Dims On Drag.

~L A Be careful with the Override Dims On Drag option. If you accidentally drag a fully

e defined sketch, this setting enables SolidWorks to completely resize the sketch. For
working conceptually, it can be a great aid, but for final production models, you may do better
to turn this off.

Instant 3D offers different editing options depending on how a sketch is selected.

B A sketch is selected from the graphics window. The pull arrow appears, enabling you
to create an extruded boss or cut.

B A sketch is selected from the FeatureManager. If the sketch has relations to anything
outside of the sketch, the sketch is highlighted with no special functionality available. If
no external relations exist, a box with stretch handles enable scaling the sketch, and a set
of axes with a wing enables you to move the sketch in X or Y or X and Y. Figure 7.7
shows this situation.

FIGURE 7.7

Sketch scaling and moving options with Instant 3D

When Instant 3D is activated, double-clicking a sketch in either the FeatureManager or on a sketch
element in the graphics window opens that sketch. While you are in a sketch, if you double-click
with the Select cursor in blank space in the graphics window, you close the sketch. This only
works for 2D sketches; 3D sketches can be opened, but not closed this way.
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Revolve

Like all other features, revolve features have some rules that you must observe when choosing
sketches that can be used to create a revolve:

B Draw only half of the revolve profile (draw the section to one side of the centerline).
W The profile must not cross the centerline.

B The profile must not touch the centerline at a single point. It can touch along a line, but
not at a point. Revolving a sketch that touched the centerline at a single point would cre-
ate a point of zero thickness in the part.

You can use any type of line or model edge for the centerline, not just the centerline/construction
line type.

End conditions
There are three Revolve end conditions:

B One-Direction. The revolve angle is driven in a single direction.
B Two-Direction. The revolve angle can be driven in two independent directions.

B Mid-Plane. The revolve angle is divided equally in opposite directions.

There is no equivalent for Up to Vertex, Up to Next, Up to Surface, or Up to Body with the Revolve
feature.

Contour selection

Like extrude features, revolve features can also use contour selection; as with the extrude features,
I recommend that you avoid using contours for production work.

Loft

Many users struggle when faced with the option to create a loft or a sweep. Some overlap exists
between the two features, but as you gain some experience, it becomes easier to choose between
them. Generally, if you can create the cross-section of the feature by manipulating dimensions of a
single sketch, then a sweep might be the best feature. If the cross-section changes character or
severely changes shape, then a loft may be best. If you need a very definite shape at both ends and/
or in the middle, then a loft is a better choice because it allows you to explicitly define the cross-
section at a point. However, if the outline is more important than the cross-section, then you
should choose a sweep. If the path between ends is important, choose a sweep. If the ends them-
selves are more important and you just want to blend from one end to the other, then the loft is
the better choice.
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Both types of features are extremely powerful, but the sweep has a tendency to be fussier about
details, setup, and rules, while the loft can be surprisingly flexible. I am not trying to dissuade you
from using sweeps, because they are useful in many situations. However, in my own personal
modeling, I probably use about ten lofts for every sweep. For example, while you would use a loft
or combination of loft features to create a complex laundry detergent bottle, you would use the
sweep to create a raised border around the label area.

Lofts are an example of interpolated geometry. That is to say that the loft is outlined by creating sev-
eral loft sections and guide curves, and then the software interpolates the face geometry in between
the sections. A good example of this is to put a circle on one plane and a rectangle on an offset
plane and then loft them together. This arrangement is shown in Figure 7.8. The transition
between shapes is the defining characteristic of a loft, and is also the reason for choosing a loft
instead of another feature type. Lofts can create both Boss features and Cut features.

FIGURE 7.8

A simple loft

The two-profile loft with default end conditions always creates a straight transition, which is
shown in the image to the left. A two-point spline with no end tangency creates a straight line in
exactly the same way. By applying end conditions to either or both of the loft profiles, the loft’s
shape is made more interesting, as seen in the image to the right in Figure 7.8. Again, the same
thing happens when applying end tangency conditions to a two-point spline: it goes from being a
straight line to being more curvaceous, with continuously variable curvature. The Loft
PropertyManager interface is shown in Figure 7.9.
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FIGURE 7.9
The Loft PropertyManager
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Entities that you can use in a loft

For solid lofts, you can select faces, closed loop 2D or 3D sketches, and surface bodies. You can
use sketch points as a profile on the end of a loft that comes to a point or rounded end. For surface
lofts, you can use open sketches and edges in addition to the entities that are used by solid lofts.

Some special functionality becomes available to you if you put all the profiles and guide curves
together in a single 3D sketch. In order to select profiles made in this way, you must use the
SelectionManager, which is discussed later in this chapter.

The Sketch Tools panel of the Loft PropertyManager enables you to drag sketch entities of any pro-
file made in this way while you are editing or creating the Loft feature, without needing to exit and
edit a sketch.

~ . While this sort of functionality may be attractive for a lot of reasons, it may not be
the best way. Unless you are dealing with the simplest of geometry and sketch rela-
tions, 3D sketches — and more specifically 3D sketch planes — are simply not up to the task. The
specific problem is sketch relations. I discuss 3D sketches in more detail in Chapter 31.

The similarities between lofts and splines

The words loft and spline come from the shipbuilding trade. The word spline is actually defined as
the slats of wood that cover the ship, and the spars of the hull very much resemble loft sections.
With the splines or slats bending at each spar, it is easy to see how the modern CAD analogy came
to be.

Lofts and splines are also governed by similar mathematics. You have seen how the two-point
spline and two-profile loft both create a straight-line transition. Next, a third profile is added to the
loft and a third point to the spline, which demonstrates how the math that governs splines and
lofts is also related to bending in elastic materials. Figure 7.10 shows how lofts and splines react
geometrically in the same way that bending a flexible steel rod would react (except that the spline
and the loft do not have a fixed length).
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FIGURE 7.10

Splines, lofts, and bending

Three-point spline, no end conditions

N

/
End tangency changed Notice slight bulge,

) ) ~ justlike a real rod in bending
Reacts like a pinned joint

With this bit of background, it is time to move forward and talk about a few of the major aspects
of Loft features in SolidWorks. It is probably possible to write a separate book that only discusses
modeling lofts and other complex shapes. This has in fact been done. The SolidWorks Surfacing
and Complex Shape Modeling Bible (Wiley, 2008) covers a wide range of surfacing topics with
examples in far greater detail. In this single chapter, I do not have the space to cover the topic
exhaustively, but coverage of the major concepts will be enough to point you in the right direction.

The need for surfaces

In this chapter, I deal exclusively with solid modeling techniques because they are the baseline that
SolidWorks users use most frequently. Surfaces make it easier to discuss complex shape concepts
because surfaces are generally created one face at a time, rather than by using the method with
solid modeling that creates as many faces as necessary to enclose a volume.

From the very beginning, the SolidWorks modeling culture has made things easier for users by
taking care of many of the details in the background. This is because solids are built through auto-
mated surface techniques. Surface modeling in itself can be tedious work because of all the manual
detail that you must add. Solid modeling as we know it is simply an evolutionary step that adds
automation to surface modeling. The automation maintains a closed solid boundary around the
volume.

Because surfaces are the underlying building blocks from which solids are made, it would make
sense to teach surfaces first, and then solids. However, the majority of SolidWorks users never use
surfacing, and do not see a need for it, and so surface functions are generally given a lower priority.
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Refer to Chapter 27 for surfacing information.
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Loft end constraints

Loft end conditions control the tangency direction and weighting at the ends of the loft. Some of
the end constraints depend upon the loft starting or ending from other geometry. The optional
constraints include the following:

None

The direction of the loft is not set by the None end constraint, but the curvature of the lofted faces
at the ends is zero. This is the default end constraint for two-section lofts.

Default

The Default end constraint is not available for two-section lofts, only for lofts with three or more
sections. This end constraint applies curvature to the end of the loft so that it approximates a
parabola being formed through the first and last loft profiles.

The SolidWorks help file makes a special point to explain the difference between the None and
Default end constraints, but the Default help makes it look as if it works with only two profiles,
when in fact it does not.

Tangent to Face

The Tangent to Face end constraint is self-explanatory. This end constraint may fail or cause
unwanted ripples or puckers in the part if profiles that are adjacent to one another or touch at an
edge are lofted together. The Tangency to Face option includes a setting for tangent length. This is
not a literal length dimension, but a relative weighting, on a scale from 0.1 to 10. The small arrow
to the left of the setting identifies the direction of the tangency. Usually, the default setting is cor-
rect, but there are times when SolidWorks misidentifies the intended tangency direction, and you
may need to correct it manually.

The Next Face option is available only when lofting from an end face where the tangency could go
in one of two perpendicular directions. This is shown in Figure 7.11.

Apply to All refers to applying the Tangent Length value to all the tangency-weighting arrows for the
selected profile. When you select Apply to All, only one arrow displays. When you deselect it, one
arrow should display for each vertex in the profile, and you can adjust each arrow individually.

Curvature to Face

The difference between tangency and curvature is that tangency is only concerned with the direc-
tion of curvature immediately at the edge between the two surfaces. Curvature must be tangent
and match the radius of curvature on either side of the edge between surfaces. This is often given
many names, including curvature continuity, c2, and others. Lofted surfaces do not usually have a
constant radius; because they are like splines, they are constantly changing in local radius.
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Direction Vector

The Direction Vector end constraint forces the loft to be tangent to a direction that you define by
selecting an axis, edge, or sketch entity. The angle setting makes the loft deviate from the direction
vector, as shown in Figure 7.11. The curved arrows to the left identify the direction in which the
angle deviation is going.

FIGURE 7.11

Examples of end constraints

None Default Both ends set to
Normal to Profile

Tangent to Face Tangency to Face Tangent to Face
with Other Face option

7

Direction vector

223



m Building Intelligence into Your Parts

r

224

BEST F

Isoparameter U-V lines

The mesh or grid shown in the previous images appears automatically for certain types of features,
including lofts. The grid represents isoparameter lines, also known as NURBS mesh or U-V lines.
This mesh shows the underlying structure of the faces being created by the feature. If the mesh is
highly distorted and appears to overlap in places, then it is likely that the feature will fail.

You can show or hide the mesh through the right-mouse menu when editing or creating a Loft fea-
ture, unless the SelectionManager is active. In this case, you can see only SelectionManager com-
mands in the right-mouse button menu. In addition, planar faces do not mesh, only faces with
some curvature.

Guide curves

Guide curves help to constrain the outline of a loft between loft profiles. Although it is best to try
to achieve the shape you want by using appropriately shaped and placed loft profiles, this is not
always possible. The most appropriate use of guide curves for solid lofts is at places where the loft
is going to create a hard edge, which is usually at the corners of loft profile sketches. Guide curves
often (but not always) break up what would otherwise be a smooth surface, and you should avoid
them in these situations, if possible.

Do not try to push the shape of the loft too extremely with guide curves. Use guide
curves mainly for tweaking and fine-tuning rather than coarse adjustments. Use loft
sections and end constraints to get most of the overall shape correct. Pushing too hard with a
guide curve can cause the shape to kink unnaturally.

VN askiNalls
NACL _\_.t

Although guide curves can be longer than the loft, they can not be shorter. The guide curve applies
to the entire loft. If you need to apply the guide curve only to a portion of the loft, then split the
loft into two lofts, one that uses the guide curve, and the other that does not. The guide curve must
intersect all profiles in a loft.

If you have more than one guide curve, the order in which they are listed in the box is important.
The first guide curve helps to position the intermediate profiles of the loft. It may be difficult or
impossible to visualize the effects of guide-curve order before it happens, but remember that it
does make a difference, and depending on the difference between the curves, the difference may or
may not be subtle.

Guide curves are also used in sweeps, which I address later in this chapter. Figure 7.12 shows a
model that is lofted using guide curves. The image to the left shows the sketches that are used to
make the part. There are two sketches with points; you can use points as loft profiles. The image in
the middle shows the Loft feature without guide curves, and the one to the right is the part with
guide curves. If you would like to examine how this part is built, you can find it on the CD-ROM
with the filename Chapter 7 Guide Curves.sldprt.
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A loft with and without guide curves

Loft profiles
Middle profile

Centerline lofts

The Centerline panel of the Loft PropertyManager is used to set up a Centerline loft. You can

use the Centerline of a loft in roughly the same way that you use a sweep path. In fact, the
Centerline loft resembles a sweep feature where you can specify the shape of some of the
intermediate profiles. Centerline lofts can also create intermediate profiles. You may prefer to use
a centerline loft instead of either a sweep or a regular loft because the profile may change in ways
that the Sweep feature cannot handle, and the loft may need some guidance regarding the order
of the profiles or how to smooth the shape between the profiles.

I cover sweep features later in this chapter. If you are creating a centerline loft, then you may want
to examine the sweep functionality as well.

You can use centerlines simultaneously with guide curves. While guide curves must touch the
profile, there is no such requirement for a centerline; in fact, the centerline works best if it does not
touch any of the profiles.

The slider in the Centerline Parameters panel enables you to specify how many intermediate
sections to create between sketched profiles.
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SelectionManager

The SelectionManager simplifies the selection of entities from complex sketches that are not
necessarily the clean, closed loop sketches that SolidWorks works with most effectively.

The SelectionManager has been implemented in a limited number of features. Selection options in
the SelectionManager include the following:

0 & (¥ (X (€]
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OK. Accepts the selection. This feature is also available on the right-mouse button menu.

Cancel. Quits the SelectionManager

Clear All. Clears the current selection set

Push Pin. Keeps the SmartSelection window available, even when it is not required for
sketch entity selections
Select Closed Loop. You can select two different types of loops with this tool:

A parametric closed loop in a 2D or 3D sketch

A parametric loop of edges around a surface

Select Open Loop. Selects a chain (end-to-end sketch entities)

Select Group. Selects entities individually. If you click the Propagate symbol, all tangent
edges are selected.

Select Region. Works like the Contour Selection described earlier in this chapter.

Standard Selection. Disables special functions of the SelectionManager. This feature
works like a regular selection tool.

Auto OK Selections. Becomes enabled when you use the Push Pin. This feature works
for closed and open loop selection.

Loft options

You can choose from the following Loft options, as shown in Figure 7.13:

FIGURE 7.13

Loft options
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B Merge tangent faces. Model faces that are tangent are merged into a single face. This is
done behind the scenes by converting profiles into splines, which make approximations
but are smoother than sketches with individual tangent line and arc entities.

B Close loft. A closed loop is made of the loft. At least three loft profiles must exist in order
to use this option. Figure 7.14 shows a loft where the Close Loft option is used, and the
loft sections are shown. This model is on the CD-ROM with the filename Chapter 7 —
Closed Loft.sldprt.

FIGURE 7.14

A closed loft

W Show preview. This turns the preview of the Loft feature on or off, if the feature is not
going to fail. All of the following loft preview options are system options, and remain on
until you turn them off.

Transparent/Opaque Preview is available from the right-mouse button menu when
you edit a loft, if the SelectionManager is not active.

Mesh Preview is also available on the same right-mouse button menu.

Zebra Stripe Preview is also available on the same right-mouse button menu, and is
covered in more depth in Chapter 11.

B Merge result. Merges the resulting solid body with any other solid bodies that it may
contact.
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FIGURE 7.15

Sweep

The Sweep feature uses more than one sketch. A sweep is made from a profile (cross-section) and a
path, and can create a boss or a cut feature. If you want, you can also use guide curves. Sweeps can
run the gamut from simple to complex. Typical simple sweeps are used to create wire, tubing, or
hose. More complex sweeps are used for creating objects such as bottles, involutes, and cork-
screws.

The main criteria for selecting a sweep to create a feature are that you must be able to identify a
cross-section and a path. The profile (cross-section) can change along the path, but the overall
shape must remain basically the same. The profile is typically perpendicular to the path, although
this is not a requirement.

Simple sweep

An example of a simple sweep is shown in Figure 7.15. The paper clip uses a circle as the profile,
and the coiled lines and arcs as the path.

A simple sweep feature

Profile or cross-section
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Sweep path

Simple sweeps such as that shown in Figure 7.15 essentially set up SolidWorks to create geometry
from simpler features such as Extrude and Revolve. If you look at the faces, you can see that they
are created from straight lines and arcs, which lend themselves well to extrudes and revolves.
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Sweep with guide curves

More complex sweeps begin to control the size, orientation, and position of the cross-section as it
travels through the sweep. When you use a guide curve, several analogies can be used to visualize
how the sweep works. The cross-section/profile is solved at several intermediate positions along
the path. If the guide curve does not follow the path, the difference between the two is made up by
adjusting the profile. Consider the following example. In this case, the profile is an ellipse, the path
is a straight line, and there are guide curves that give the feature its outer shape. Figure 7.16 shows
all these elements and the finished feature.

FIGURE 7.16

A sweep with two guide curves

O |t CL-2 O The part shown in Figure 7.16 is on the CD-ROM with the filename Chapter?7
Bottle.sldprt.
The sweep with guide curves does not create extrudes and revolves, although you can use simple
lines and arcs with this feature. The changes in the cross-section are created from a more complex
feature type, namely a loft. The PropertyManager for the Sweep function includes an option for
Show Sections, which in this case creates almost 200 intermediate cross-sections. These sections
are used to create a loft. You can think of complex sweeps as an automated setup for an even more
complex loft. It is helpful to envision features such as this when you are troubleshooting or setting
up more complex sweeps. If you open the part mentioned previously from the CD-ROM, you can
edit the Sweep feature to examine the sections for yourself.

229



m Building Intelligence into Your Parts

FIGURE 7.17

In most other published SolidWorks materials that cover these topics, sweeps are covered before
lofts because many people consider lofts the more advanced topic. However, I have put lofts first
because understanding them is necessary before you can understand complex sweeps, as complex
sweeps really are just lofts.

Pierce relation

The Pierce sketch relation is the only sketch relation that applies to a 3D out-of-plane edge or
curve without projecting the edge or curve into the sketch plane. It acts as if the 3D curve is a
length of thread and the sketch point is the eye of a needle, where the thread pierces the needle
eye. The Pierce relation is most important in the Sweep feature when it is applied in the profile
sketch between endpoints, center points, or sketch points and the guide curves. This is because the
Pierce relation determines how the profile sketch will be solved when it is moved down the sweep
path to create a new intermediate profile.

Figure 7.17 illustrates the function of the Pierce relation in a sweep with guide curves. The dark
section on the left is the sweep section that is sketched. The lighter sketches to the right represent
the intermediate profiles that are automatically created behind the scenes.

The effects of the Pierce relation

Guide curve Pierce relation forces contact

Sketched sweep profile

230

Figure 7.17 shows what is happening behind the scenes in a sweep feature. The sweep recreates
the original profile at various points along the path. The guide curve in this case forces the profile
to rebuild with a different shape. Pierce constraints are not required in simple sweeps, but when

you start using guide curves, you should also use a pierce.
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TR If you feel that you need more profile control, but still want to create a sweep-like
feature, try a centerline loft. The centerline acts like a sweep path that doesn’t
touch the profiles, but unlike a sweep you can use multiple profiles with it.

Figure 7.18 shows a more complicated 3D sweep, where both the path and the guide curve are 3D
curves. I cover 3D curves toward the end of this chapter, and so you can refer ahead to these fea-
tures to understand how this part is made.

FIGURE 7.18

A 3D sweep

O e CD-2OY) The part shown in Figure 7.18 is on the CD-ROM with the filename Chapter 7 3D

~ - Sweep.sldprt.
This part is created by making a pair of tapered helices, with the profile sketch plane perpendicular
to the end of one of the curves. The taper on the outer helix is greater than on the inner one, which
causes the twist to become larger in diameter as it goes up.

To make the circle follow both helices, you must create two pierce relations, one between the cen-
ter of the circle and a helix, and the other between a sketch point that is placed on the circumfer-
ence of the circle and the other helix. This means that the difference in taper angles between the
two helices is what drives the change in diameter of the sweep.
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Cut Sweep with a solid profile

The Cut Sweep feature has an option to use a solid sweep profile. This kind of functionality has
many uses, but is primarily intended for simulating complex cuts made by a mill or lathe. Figure
7.19 shows a couple of examples of cuts you can make with this feature. The part used for this
screen shot is also on the CD-ROM.

FIGURE 7.19

Cuts you can make with the Cut Sweep feature using a solid profile
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The solid profile cut sweep has a few limitations that I need to mention:

It uses a separate solid body as the cutting tool, so you have to model multibodies

The path must start at a point where it intersects the solid cutting tool body (path starts
inside or on the surface of the cutting tool)

The cutting tool must be definable with a revolved feature

The cutting tool must be made of simple analytical faces (sphere, torus, cylinder, and
cone; no splines)

You cannot use a guide curve with a solid profile cut (cannot control alignment)

The cut can intersect itself, but the path cannot cross itself

You can create many useful shapes with the solid profile cut sweep, but because of some of the
limitations I've listed, some shapes are more difficult to create than others. For these shapes you
might choose to use regular cut sweep features. Figure 7.20 shows an example of a cam-like fea-
ture that you may want to create with this method, but may not be able to adequately control the
cutting body.
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Controlling a cam cut may be a challenge

Creating Curve Features

Curves in SolidWorks are often used to help define sweeps and lofts, as well as other features.
Curves differ from sketches in that curves are defined using sketches or a dialog box, and you can-
not manipulate them directly or dimension them in the same way that you can sketches. Functions
that you are accustomed to using with sketches often do not work on curves.

TR When you come across a function that does not work using a curve entity, but that
works on a sketch (for example, making a tangent spline), then it may help to use
the Convert Entities feature. Converting entities on a helix into a 3D sketch creates a spline that
lies directly on top of the helix and allows you to make another spline that is tangent to the new
spline.

The following types of curves can be defined in SolidWorks:
Helix/tapered helix/variable helix/spiral
Projected curve

Curve through XYZ points

Curve through reference points

Composite curve

You can find all the curve functions on the Curves toolbar or through the menus at Insert=> Curve.

233



m Building Intelligence into Your Parts

FIGURE 7.21

Helix

The Helix curve types are all based on a circle in a sketch. The circle represents the starting loca-
tion and diameter of the helix. Figure 7.21 shows the PropertyManagers of the Constant Pitch and
Variable Pitch helix types.

The Helix PropertyManager
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You can create all the helical curve types by specifying any combination of total height, pitch, and
the number of revolutions. The start angle is best thought of as a relative number. It is difficult to
predict where zero degrees starts, and this depends on the relation of the sketch plane to the
Origin. The start angle cannot be controlled outside of the PropertyManager, and cannot be driven
by sketch geometry. The term pitch refers to the straight-line distance along the axis between the
rings of the helix. Pitch for the spiral is different and is described later.

Tapered Helix

The Tapered Helix panel in the Helix PropertyManager enables you to specify a taper angle for the
helix. The taper angle does not affect the pitch. If you need to affect both the taper and the pitch,
then you can use a variable pitch helix. Figure 7.22 shows how the taper angle relates to the result-
ing geometry.

Variable Pitch Helix

You can specify the variable pitch helix either in the chart or in the callouts that are shown in
Figure 7.23. Both the pitch and the diameter are variable. The diameter number in the first row
cannot be changed, but is driven by the sketch. In the chart shown, the transition between 4 and
4.5 revolutions is where the pitch and diameter both change.
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The tapered helix

FIGURE 7.23

The variable pitch helix

Spiral
A spiral is a flattened (planar) tapered helix. The pitch value on a spiral is the radial distance
between revolutions of the curve.

Projected curve
Many users have difficulty envisioning the concept of the projected curve. The two options avail-
able for projected curves are:
W Sketch Onto Face
B Sketch Onto Sketch
These names can be misleading if you do not already know what they mean. In both cases, the

word sketch is used as a noun, not a verb, and so you are not actively sketching on a surface;
instead, you are creating a curve by projecting a sketch onto a face.

Sketch Onto Face

The Sketch Onto Face option is the easiest to explain, and so I will describe this one first. With
this option set, the projected curve is created by projecting a 2D sketch onto a face. The sketch is
projected normal (perpendicular) to the sketch plane. This is like extruding the sketch and using
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the Up To Surface end condition. The sketch can be an open or closed loop, but it may not be
multiple open or closed loops, nor can it be self-intersecting. Figure 7.24 shows an example of
projecting a sketch onto a face to create a projected curve.

FIGURE 7.24

A projected curve using the Sketch Onto Face option
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Sketch Onto Sketch

This is the concept that most frequently causes difficulty for users. The Sketch Onto Sketch
Projected Curve option can be visualized in a few different ways.

Reverse 2D drawing visualization method

One way is to think of it as being the reverse of a 2D drawing. In a 2D drawing, 3D edges (you can
think of the edges as curves) are projected onto orthogonal planes to represent the edge from the
Front or Top planes. The Sketch Onto Sketch projection takes the two orthogonal views, placed on
perpendicular planes, and projects them back to make the 3D edge or curve. This is part of the
attraction of the projected curve, because making 3D curves accurately is difficult if you do it directly
by using a tool such as a 3D sketch spline; however, if you know what the curve looks like from two
different directions, then it becomes easy. Figure 7.25 illustrates this visualization method.

When you think of describing a complex 3D curve in space, one of the first methods that usually
comes to mind is describing it as a 2D curve from perpendicular directions, exactly in the same
way as you would if you created projected drawing views from it. From this, it makes sense to see
the creation of the curve as the reverse process, drawing the 2D views first, from which you can
then create the 3D curve.

Intersecting surfaces visualization method

A second method used for visualizing Sketch On Sketch projected curves is the intersecting sur-
faces method. In this method, you can see the curve being created at the intersection of two sur-
faces that are created by extruding each of the sketches. This method is shown in Figure 7.26.
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FIGURE 7.25

The reverse 2D drawing visualization method for projected curves

e

Doing the reverse drawing technique,
the curve is built from two views.

This is what the curve From this view,
looks like from this view. the curve looks like this.

FIGURE 7.26

Using intersecting surfaces to visualize a Sketch on Sketch projected curve

Projected curve

Sketch profiles
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FIGURE 7.27

Curve Through XYZ Points

The Curve Through XYZ Points feature enables you to either type in or import a text file with
coordinates for points on a curve. The text file can be generated by any program that makes lists of
numbers, including Excel. The curve reacts like a spline, and so the teeter-tottering effect may be
noticeable, especially because you cannot set end conditions or tangency. To avoid this effect, it
may be a good idea to overbuild the curve by a few points on each end.

If you import a text file, the file can have an extension of either *.txt or *.sldcrv. The data that it
contains must be formatted as three columns of X-, Y-, and Z-coordinates using the document
units (inch, mm, and so on), and the coordinates must be separated by comma, space, or tab.
Figure 7.27 shows both the Curve File dialog box displaying a table of the curve through X, Y, and
Z points, and the *.sldcrv Notepad file. The file can be read from the Curve File dialog box by
using the Browse button, but if you manually type the points, then you can also save the data out
directly from the dialog box. Just like any type of sketch, this type of curve cannot intersect itself.

The Curve File dialog box showing a table of the curve through X, Y, and Z points, and a Notepad text file
with the same information
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Curve Through Reference Points

The Curve Through Reference Points feature creates a curve entity from selected sketch points or
vertices. The curve can be an open or closed loop, but a closed loop requires that you select at least
three points. You cannot set end conditions of the curve, and so this feature works like a spline in
the same way as the XYZ curve.

The most common application of this feature is to create a simple two-point curve across the opening
of a surface feature to close the opening by using a surface feature such as Fill, Boundary, or Loft.

Composite curve

The composite curve joins together multiple curves, edges, or sketches into a single curve entity.
The part shown in Figure 7.28 was created by using a composite curve to join together a 3D
sketch, variable pitch helix, and a projected curve. You can also use model edges with the compos-
ite curve. The curve is shown on half of the part; the rest of the part is mirrored.
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Composite curves overlap in functionality with the Selection Manager to some extent. In some
ways the Composite Curve is nicer because you can save a selection in cast the creation of the fea-
ture that uses the Selection Manager fails (if you can't create the feature, you can’t save the selec-
tion). On the other hand, Composite Curves don’t function the same way that a selection of model
edges do for settings like tangency and curvature.

FIGURE 7.28

A part created from a composite curve

Split lines

Split lines are not exactly curves; they are really just edges that split faces into multiple faces. Split
lines are used for several purposes, but are primarily intended to split faces so that draft can be
added. They are also used for creating a broken-out face for a color break or to create an edge for a
hold line fillet, which I discuss later in this chapter.

There are some limitations to using split lines. First, they must split a face into at least two fully
enclosed areas. You cannot have a split line with an open loop sketch where the ends of the loop
are on the face that is to be split; they must either hang off the face to be split or be coincident with
the edges. Second, nested loops or multiple closed loops are not allowed, nor are self-intersecting
sketches. If you need to do something with a sketch of one of these types, then you may be able to
accomplish the same thing using multiple split-line features. If you want to create multiple stripes
across a face, the best option may be to create an open loop sketch with many S-shaped zigzags.

One result of all these limitations is that it becomes difficult to make split lines using sketch text or
other complex sketches. There are several ways of bypassing these limitations, such as copying the
surfaces with Knit or Offset at zero distance and then trimming the surface with the sketch, or cre-
ating a very shallow solid extrude (although this can be very detrimental to rebuild and graphics
speed).

As an alternative, you might consider using the Wrap feature with the Scribe option for situations
where a split line has to go around a cylindrical or conical object. Split lines can also be created by
Spline On Surface 3D sketch with the Intersection option in the Split line feature.
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FIGURE 7.29

| A word of caution is needed when using split lines, especially if you plan to add or
remove split lines from an existing model. The split lines should go as far down the
tree as possible. Split lines change the face IDs of the faces that they split, and often the edges as
well. If you roll back and apply a split line before existing features, you may have a significant
amount of cleanup to do. Similarly, if you remove a split line that already has several dependent
features, then many other features may also be deleted or simply lose their references.

Equation Driven Curve

The Equation Driven Curve is not really a curve feature, it is a sketch entity. It specifies a spline
inside a 2D sketch with an actual equation. Even though this is a spline based sketch entity, it can
only be controlled through the equation, and not by using spline controls.

Figure 7.29 shows the Equation Driven Curve PropertyManager along with a sample spline. If you
want to put the toolbar button on your toolbar, look for it in the Sketch page of
Tools=> Customize = Commands.

Creating an Equation Driven Curve

240

Use regular mathematical notation and order of operations to write the equation. X1 and X2 are for
the beginning and end of the curve. Use the transform options at the bottom of the
PropertyManager to move the entire curve in X, Y or rotation. To specify X = f(Y) (instead of Y =
f(X)), use a 90 degree transform.

Filleting

SolidWorks offers very powerful filleting functions. Many filleting options are available, but most
of them are relatively little used or even known. In fact, most users confine themselves to the
Constant Radius or Variable Radius fillets. The following section describes all the available fillet
types and options:
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B Constant Radius Fillet
Multiple Radius Fillet
Round Corners
Keep Edge/Keep Surface
Keep Feature

B Variable Radius Fillet

W Face Fillet
Curvature Continuous Fillet
Face Fillet with Help Point
Single Hold Line Fillet
Double Hold Line Fillet
Constant Width Fillet

B Full Round Fillet

B Setback Fillet

B Setback Fillet with Variable Radius

Figure 7.30 shows the Fillet PropertyManager. There are other options that affect preview and
selection of items, and these options are discussed in this section.

FIGURE 7.30

The Fillet PropertyManager
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The Fillet feature comprises various types of functionality. Simple fillets on straight and round
edges are handled differently from variable-radius fillets, which are handled differently from the
single or double hold line fillet or setback fillets. Once you click the OK button to create a fillet as
a certain type, you cannot switch it to another type. You can switch types before you click OK.

Creating a constant radius fillet

Constant radius fillets are the most common type that are created if you select only edges, features,
or faces without changing any settings. When applying fillets in large numbers, you should con-
sider several best-practice guidelines and other recommendations that come later in this chapter.

There are still some long-time users who distinguish between fillets and rounds (where fillets add
material and rounds remove it). SolidWorks does not distinguish between the two, and even two
edges that are selected for use with the same fillet feature can have opposite functions; for example,
both adding and removing material in a single feature.

Selecting entities to fillet

You can create fillets from several selections, including edges, faces, features, and loops. Edges
offer the most direct method, and are the easiest to control. Figure 7.31 shows how you can use
each of these selections to more intelligently create fillets on parts.

TP To select features for filleting, you must select them from the FeatureManager. The

Selection Filter only filters edges and faces for fillet selection. You can select loops

in two ways: through the right-click Select Loop option, or by selecting a face and Ctrl-selecting
an edge on the face.

Another option for selecting edges in the Fillet command is the Select Through Faces option,
which appears on the Fillet Options panel. This option enables you to select edges that are hid-
den by the model. This can be a useful option on a part with few hidden edges, or a detrimental
option on a part where there are many edges due to patterns, ribs, vents, or existing fillets. You
can control a similar option globally for features other than fillets at Tools > Options => Display/
Selection, Allow Selection In HLR and Shaded Modes.

Faces and Features selections are useful when you are creating fillets where you want the selections
to update. In Figure 7.32, the ribs that are intersecting the circular boss are also being filleted. If
the rib did not exist when the fillet was applied, but was added later and reordered so that it came
before the Fillet feature, then the fillet selection automatically takes the rib into account. If the fillet
used edge selection, then this automatic selection updating would not have taken place.
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Selection options for fillets

Select individual edges Selecting a loop is justa
shortcut to selecting several edges

Selecting a feature fillets Selecting a face fillets all
all the edges edges around the face
that touch the feature
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FIGURE 7.32

Tangent propagation

By default, fillets have the Tangent Propagation option turned on. This is almost always a good
choice, although there may be times when you want to experiment with turning it off. Tangent
propagation simply means that if you select an edge to fillet, and this edge is tangent to other
edges, then the fillet will keep going along tangent edges until it forms a closed loop, the tangent
edges stop, or the fillet fails.

If you turn off Tangent Propagation, but there are still tangent edges, then you may see different
results. One possible result is that it could fail. One of the tricks with fillet features is to try to envi-
sion what you are asking the software to do. For example, if one edge is filleted and the next edge
is not, then how is the fillet going to end? Figure 7.32 shows two of the potential results when fil-
lets are asked not to propagate, whether or not to tangent edges. The fillet face may continue along
its path until it runs off of the part or until the feature fails.

Turning off the Tangent Propagation option
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TR This may sound counter-intuitive, but sometimes when fillet features fail, it may be
useful to turn off propagation and make the fillet in multiple features. There are
times when creating two fillets like the one shown in Figure 7.32 will work when making the
same geometry as a single feature will not. This may be due to geometry problems where the
sharp edges come together and are eliminated by the fillet.

BEST PRACTLOL In general, fillets should be the last features that are applied to a model, particularly
DEvlrifc.s the small cosmetic or edge break fillets. Larger fillets that contribute to the structure
or overall shape of the part may be applied earlier.

Be careful of the rock-paper-scissors game that you inevitably get caught up in when modeling
plastic parts and deciding on the feature order of fillets, draft, and shell. Most fillets should
come after draft, and large fillets should come before the shell. Draft may come either before or
after the shell, depending on the needs of the area that you are dealing with on the part. In
short, there is no single set of rules that you can consistently apply and that works best in all situ-
ations.

Dealing with a large number of fillets

Figure 7.33 shows a model with a bit of a filleting nightmare. This is a large plastic tray that
requires many ribs underneath for strength. Because the ribs may be touched by the user, the
sharp edges need to be rounded. Interior edges need to be rounded also for strength and plastic
flow through the ribs. Literally hundreds of edges would need to be selected to create the fillets if
you do not use an advanced technique.

FIGURE 7.33

A plastic tray with a large number of fillets

Selecting entities

Some of the techniques outlined previously, such as face and feature selection, can be useful for
quickly filleting a large number of edges. Another method that still selects a large number of edges,
but is not as intuitive as the others, is window selection of the edges. To use this option effectively,
you may want to first position the model into a view where only the correct edges will be selected,
turn off the Select Through Faces option, and use the Edges Selection filter.
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FIGURE 7.34

Fillet Xpert

The Fillet Xpert is a tool with several uses. One of the functions is the ability to select multiple
edges. A part like the one shown in Figure 7.33 is ideal for this tool. To use the Fillet Xpert, click
the Fillet Xpert button in the Fillet PropertyManager. Figure 7.34 shows this. When you select an
edge, the Fillet Xpert presents a pop-up tool bar giving you a choice of several selection options.
Notice that Figure 7.34 shows the majority of the edges selected that are needed for this fillet.

Using the Fillet Xpert selection technique
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The Fillet expert is also a tool that automatically finds solutions to complex fillet problems, partic-
ularly when you have several fillets of different sizes coming together.

The Corner tab of the Fillet Xpert enables you to select from different corner options, which are
usually the result of different fillet orders. To use the Corner Xpert, make sure the Fillet Xpert is
active; then click on the corner face, and toggle through the options.

Using preview

I like to use the fillet preview. It helps to see what the fillet will look like, and perhaps more
important, the presence of a preview usually means that the fillet will work.

Unfortunately, when you have a large number of fillets to create, the preview can cause a signifi-
cant slowdown. Turning it off or using the Partial Preview are both possible options. Partial
Preview shows the fillet on only one edge in the selection, and is much faster when you are creat-
ing a large number of fillets.
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pener ., s w0 ~- Forrebuild speed efficiency, you should make fillets in a minimum number of fea-

PEEFOUSMANCE tures. For example, if you have 100 edges to fillet, it is better for performance to do
it with a single fillet feature that has 100 edges selected rather than 100 fillet features that have
one edge selected. This is the one case where creating the feature and rebuilding the feature are
both faster by choosing a particular technique (usually if it is faster to create, it rebuilds more
slowly).

Although creation and rebuild speed are in sync when you use the minimum num-
ber of features to create the maximum number of fillets, this is not usually the case.
(There had to be a downside.) When a single feature has a large selection, any one of these
edges that fail to fillet will cause the entire feature to fail. As a result, a feature with 100 edges
selected is 100 times more likely to fail than a feature with a single edge. Large selection sets are
also far more difficult to troubleshoot when they fail than small selection sets that fail.

[TV ~ T s
BEST PRACTLCE

Using folders

When you have a large number of fillet features, it can be tedious to navigate the FeatureManager.
It is therefore useful to place groups of fillets into folders. This makes it easy to suppress or unsup-
press all the fillets in the folder at once. Separate folders can be particularly useful if the fillets have
different uses, such as fillets that are used for PhotoWorks models and fillets that are removed for
FEA (Finite Element Analysis) or drawings.

Multiple Radius Fillet

The Multiple Radius Fillet option in the Fillet PropertyManager enables you to make multiple fillet
sizes within a single fillet feature. Figure 7.35 shows how the multiple radius Fillet feature looks
when you are working with it. You can change values from the callout flags or in the
PropertyManager.

FIGURE 7.35

Using the Multiple Radius Fillet option
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This may seem like an attractive way to group several fillets into as small a space on the
FeatureManager as possible, but I cannot think of a single reason that would drive me to use this
option. While there may be a small performance benefit to condensing several features into one,
there are many more downsides that adversely affect performance:

Loss of control of feature order
A single failed fillet causes the whole feature, and thus all the fillets, to fail

Troubleshooting is far more difficult

Smaller groups of fillets cannot be suppressed without suppressing everything

You cannot change the size of a group of fillets together

While this may be more personal opinion than best practice, | believe that there are
good reasons to consider using techniques other than single features that contain a
lot of fillets, or single features that drive fillets of various sizes. Best practice would lean more
toward grouping fillets that have a similar use and the same size. For example, you may want to
separate fillets that break corners on ribs from fillets that round the outer shape of a large plastic
part.

eIV N aakital
BEST PRACT.CE

Another consideration is feature order when it comes to the fillet’s relationship to draft and shell
features. If the fillets are all grouped into a single feature, then controlling this relationship
becomes impossible.

Round Corners

The Round Corners option refers to how SolidWorks handles fillets that go around sharp corners.
By default, this setting is off, which leaves fillets around sharp corners looking like mitered picture
frames. If you turn this setting on, the corner looks like a marble has rolled around it. Figure 7.36
shows the resulting geometry from both settings.

FIGURE 7.36

The Round Corners option, both on and off

Round corners off Round corners on
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Keep Edge/Keep Surface

The Keep Edge/Keep Surface toggle determines what SolidWorks should do if a fillet is too big to
fit in an area. The Keep Edge option keeps the edge where it is and tweaks the position (not the
radius) of the fillet to make it meet the edge. The Keep Surface option keeps the surfaces of the fil-
let and the end face clean; however, to do this, it has to tweak the edge. There is often a tradeoff
when you try to place fillets into a space that is too small. Sometimes it is useful to try to visualize
what you think the result should look like. Figure 7.37 shows how the fillet would look in a per-
fect world, followed by how the fillet looks when cramped with the Keep Edge option and how it
looks when cramped with the Keep Surface option.

FIGURE 7.37

The Keep Edge option and the Keep Surface option

The Default option chooses the best option for a particular situation. As a result, it seems to use the
Keep Edge option unless it does not work, in which case it changes to the Keep Surface option.
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Keep Feature

The Keep Feature option appears on the Options panel of the Fillet PropertyManager. By default,
this option is turned on. If a fillet completely surrounds a feature such as a hole (as long as it is not
a through hole) or a boss, then turning off the Keep Feature option removes the hole or boss.
When Keep Feature is on, the faces of the feature trim or extend to match the fillet, as shown in
Figure 7.38.

FIGURE 7.38

The Keep Feature option, both on and off

Keep feature off Keep feature on

Part before fillet

Creating variable radius fillets

Variable radius fillets are another powerful weapon in the fight against boring designs; they also
double as a useful tool to solve certain problems that arise. Although it is difficult to define exactly
when to use the variable radius fillet, you can use it when you need a fillet to round an edge, and it
has to change in size to fit the available geometry.

Leeer o, ~- ~- It may be easier to identify when not to use a variable radius fillet. Fillets are gener-

BEST PRACTICE ally used to round or break edges, not to sculpt a part. If you are using fillets to
sculpt blocky parts, unless you are actively trying to make blocky parts with big fillets, then you
may consider another approach using complex modeling, which will give the part a better shape
and make it more controllable. Other options exist that give you a different type of control, such
as the double hold line fillet.
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In some ways, variable radius fillets function like other fillets. For example, they offer propagation
to tangent edges and preview options.

Applying the values

When you first select an edge for the variable radius fillet, the endpoints are identified by callout
flags with the value unassigned. A preview does not display until at least one of the points has a
radius value in the box. You can also apply radius values in the PropertyManager, but they are eas-
ier to keep track of using the callouts. Figure 7.39 shows a variable radius fillet after the edge selec-
tion, after one value has been applied, and after three values have been applied. To apply a radius
value that is not at the endpoint of an edge, you can select one of the three colored dots along the
selected edge. The preview should show you how the fillet will look in wireframe display.

FIGURE 7.39

Assigning values to a variable radius fillet

By default, the variable radius fillet puts five points on an edge, one at each endpoint, one at the
midpoint, and one each halfway between the ends and middle. If you want to create an additional
control point, there are three ways to do this:
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FIGURE 7.40

B Ctrl-drag an existing point
B Select the callout of an existing point and change the P (percentage) value

B Change the Number of Instances value in the Variable Radius Parameters panel of the
PropertyManager

If you have selected several edges, and several unassigned values are on the screen, then you can
use the Set Unassigned option in the PropertyManager to set them all to the same value. The Set
All option sets all radius values to the same number, including any values that you may have
changed to be different than the rest. Figure 7.40 shows the Variable Radius Parameters panel.

The Variable Radius Parameters panel of the Fillet PropertyManager
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Another available option with the variable radius fillet is that you can set a value of zero at an end
of the fillet. You need to be careful about using a zero radius, because it is likely to cause down-
stream problems with other fillets, shells, offsets, and even machining operations. You cannot
assign a zero radius in the middle of an edge, only at the end. If you need to end a fillet at a partic-
ular location, you can use a split line to split the edge and apply a zero radius at that point. Figure
7.41 shows a part with two zero-radius values.

Straight versus smooth transitions

Variable radius fillets have an option for either a straight transition or a smooth transition. This
works like the two-profile lofts that were mentioned earlier in this chapter. The names may be
somewhat misleading because both transitions are smooth. The straight transition goes in a straight
line, from one size to the next, and the smooth transition takes a swooping S-shaped path between
the sizes. The difference between these two transitions is demonstrated in Figure 7.42.

Other reasons to use the variable radius fillet

Variable radius fillets use a different method to create the fillet geometry than the default constant
radius fillet. Sometimes using a variable radius fillet can make a difference where a constant radius
fillet does not work. This is sometimes true even when the variable radius fillet uses constant
radius values. It is just another tool in the toolbox.



Selecting Features

Zero radius values in the variable radius fillet

FIGURE 7.42

Straight versus smooth transitions of a variable radius fillet

Straight transition

Smooth transition

Face fillet

Face fillets may be the most flexible type of fillet because of the range of what they can do. Face fil-
lets start as simply an alternate selection technique for a constant radius fillet and extend to the
extremely flexible double hold line face fillet, which is more of a blend than a fillet.

Under normal circumstances, the default fillet type uses the selection of an edge to create the fillet.
An edge is used because it represents the intersection between two faces. However, there can
sometimes be a problem with the edge not being clean, or being broken up into smaller pieces, or
any number of other reasons causing a constant radius fillet using an edge selection to fail. In cases
like this, SolidWorks displays the error message, “Failed to create fillet. Please check the input
geometry and radius values or try using the ‘Face Fillet’ option.”
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Users almost universally ignore these messages. In the situation shown in Figure 7.43, the Face
Fillet option suggested in the error message is exactly the one that you should use. Here the face
fillet covers over all the junk on the edge that prevents the fillet from executing.

FIGURE 7.43

A face fillet covering a bad corner

Face fillets are sometimes amazing at covering over a mess of geometry that you might think you
could never fillet. The main limitation on fillets of this type is that the fillet must be big enough to
bridge the gap. That’s right, I said big enough. Face fillets can fail if they are either too small or too
large. Figure 7.44 shows a complex fillet situation that is completely covered by a face fillet.

FIGURE 7.44

A face fillet covering complex geometry
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01 | he CL-2 O] The model used for this image can be found on the CD-ROM, with the filename
Ui e CD-1201 Chapter 7 Plastic Cover Fillets.sldprt.

Continuous curvature face fillets

Curvature continuity refers to the quality of a transition between two curves or faces, where the
curvature is the same or continuous at and around the transition. The best way to convey this
concept is with simple 2D sketch elements. When a line transitions to an arc, you have non-
continuous curvature. The line has no curvature, and there is an abrupt change because the arc has
a specific radius.

N QJ- e Radius is the inverse of curvature, and so r = 1/c. For a straight line, r = =, in which
\ - case c=0.

To make the transition from r = % to r = 2 smoothly, you would need to use a variable radius arc if
such a thing existed. There are several types of sketch geometry that have variable curvature, such
as ellipses, parabolas, and splines. Ellipses and parabolas follow specific mathematical formulas to
create the shape, but the spline is a general curve that can take on any shape that you want, and
you can control its curvature to change smoothly or continuously. Splines, by their very definition,
have continuous curvature within the spline, although you cannot control the specific curvature or
radius values directly.

All of this means that continuous curvature face fillets use a spline-based variable-radius section for
the fillet, rather than an arc-based constant radius. Figure 7.45 illustrates the difference between
continuous curvature and constant curvature. The spikes on top of the curves represent the curva-
ture (1/r, and so the smaller the radius, the taller the spike). These spikes are called a curvature
comb.

FIGURE 7.45

Using curvature combs to evaluate transitions

Lines and arc Lines and spline
non-continuous curvature continuous curvature
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Notice how in Figure 7.46, the curvature comb immediately jumps from no curvature to the con-
stant arc radius, but the spline image ramps up to a curvature that varies.

Face fillets with Help point

The Help point in the Face Fillet PropertyManager is a fairly obscure option. However, it is useful
in cases where the selection of two faces does not uniquely identify an edge to fillet. For example,
Figure 7.46 shows a situation where the selection of two faces could result in either one edge or
the other being filleted (normally, I would hope that both edges would be filleted). The fillet will
default to one edge or the other, but you can force it to a definite edge using the Help point.

FIGURE 7.46

Using a Help point with a face fillet

Selecting the Help point forces it to the other side

Face fillet defaults to the right side
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In some cases, the Help point is ignored altogether. For example, if you have a simple box, and
select both ends of the box as selection set 1, and the top of the box as selection set 2, then the fil-
let could go to either end. Consequently, assigning a Help point will not do anything in this case,
because multiple faces have been selected. The determining factor is which of the multiple faces is
selected first. If this were a more commonly used feature, the interface for it might be made a little
less cryptic, but because this feature is rarely, if ever, used, it just becomes a quirky piece of trivia.

Single hold line fillet

A single hold line fillet is a form of variable radius fillet, but instead of it being defined using the
variable radius fillet type, it is created using the face fillet. Rather than the radius being driven by
specific numerical values, it is driven by a hold line, or edge, on the model. The hold line can be
an existing edge, forcing the fillet right up to the edge of the part, or it can be created by a split
line, which enables you to drive the fillet however you like. Figure 7.47 shows these two options,
before and after the fillets. Notice that these fillets are still arc-based fillets; if you were to take a
cross-section perpendicular to the edge between filleted faces, it would be an arc cross-section with
a distinct radius. However, in the other direction, hold line fillets do not necessarily have a con-
stant radius, although they may if the hold line is parallel with the edge between faces.

FIGURE 7.47

Single hold line fillets

Hold line (edge) Hold line (split line)

You can select the Hold line in the Fillet Options panel of the Face Fillet PropertyManager, as
shown in Figure 7.48. The top panel, Fillet Type, is available only when the feature is first created.
When you edit it after it has been created, the Fillet Type panel does not appear. As a result, you
cannot change from one top level type of fillet to another after it has been initially created.
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FIGURE 7.48
The PropertyManager interface for the hold line face fillet
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Double hold line fillet

There are times when a single hold line does not meet your needs. The single hold line controls
only one side of the fillet, and in order to control both sides of the fillet, you must use a double
hold line fillet. SolidWorks software does not specifically differentiate between the single and dou-
ble hold line fillets, but they are radically different in how they create the geometry. When both
sides of the fillet are controlled, it is not possible to span between the hold lines with an arc that is
tangent to both sides unless you were careful about setting up the hold lines so that they are equi-
distant from the edge where the faces intersect. This means that the double hold line fillet must use
a spline to span between hold lines, as shown in Figure 7.49.

To get this feature to work, you need to use the Curvature Continuous option in the Fillet Options
panel. Remember that this option creates a spline-based fillet rather than an arc-based fillet, which
is exactly what you need for a double hold line fillet. This makes the double hold line fillet more of
a blend than a true fillet. Figure 7.50 shows examples of the double hold line fillet.
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A double hold line uses a spline, not an arc.

Arc tangent on both ends Spline tangent
does not fit both edges on both ends fits

FIGURE 7.50

Examples of the double hold line fillet
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Constant width fillet

The Constant Width option of the Face Fillet PropertyManager drives a fillet by its width rather
than by its radius. This is most helpful on parts where the angle of the faces between which you
are filleting is changing dramatically. Figure 7.51 illustrates two situations where this is particularly
useful. The setting for constant width is found in the Options panel of the Face Fillet
PropertyManager. The part shown in the images is on the CD-ROM as Chapter 7 Constant
Width.sldprt.

FIGURE 7.51

The constant width fillet

No fillet Default face fillet Face fillet with
Constant Width option

Full round fillet

The full round fillet is very useful in many situations. In fact, it may actually work in situations
where you would not expect it to. It does require quite a bit of effort to accomplish the selection,
but it compensates by allowing you to avoid alternate fillet techniques.

To create a full round fillet, you have to select three sets of faces. Usually one face in each set is
sufficient. The fillet is tangent to all three sets of faces, but the middle set is on the end, and the
face is completely eliminated. Figure 7.52 shows several applications of the full round fillet. Notice
that it is not limited to faces of a square block, but also propagates around tangent entities and can
create a variable radius fillet over irregular lofted geometry.
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A full round fillet

Setback fillet

The setback fillet is the most complex of the fillet options. You can use the Setback option in con-
junction with constant radius, multiple radius, and variable radius fillet types. A setback fillet
blends several fillets together at a single vertex, starting the blend at some “setback” distance along
each filleted edge from the vertex. At least three, and often more, edges come together at the set-
back vertex. Figure 7.53 shows the PropertyManager interface and what a finished setback fillet
looks like. The following steps demonstrate how to use the setback fillet.

Setting up a setback fillet can take some time, especially if you are just learning about this feature.
You must specify values for fillet radiuses, select edges and vertices, and specify six setback dis-
tances. If you are using multiple radius fillets or variable radius fillets, then this becomes an even
larger task. The steps are as follows:
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The Setback Fillet Interface and a finished fillet

Setback vertices: all edges coming
to these vertices will be filleted

1. Determine the type of fillet to be used:
B Constant radius fillet
W Multiple radius fillet
W Variable radius fillet

2. Select the edges to be filleted. Selected edges must all touch one of the setback vertices
that will be selected in a later step.

3. Assign radius values for the filleted items. Figure 7.54 shows a sample part that illus-
trates this step.

FIGURE 7.54

The setback fillet setup for Steps 1 through 3
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4. Select the setback vertices. In the Setback Parameters panel of the PropertyManager,
with the second box down highlighted, select the vertices. Although this box looks like it
is only big enough for a single selection, it can accept multiple selections.

5. Enter setback values. As shown in Figure 7.55, the setback callout flags have leaders
that point from a specific value to a specific edge. The dimensions refer to distances, as
shown in the image to the right in Figure 7.55. The setback distance is the distance over
which the fillet will blend from the corner to the fillet.

FIGURE 7.55

Entering setback values

setback =3 setback =4.5
setback=1.5
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~+ -~ «| Whenyouselect multiple vertices, the preview arrows that indicate which edge you
e N are currently setting the setback value for may be incorrect. The arrows can only be
shown on one vertex, and so you may want to rely on the leaders from the callouts to determine
which setback distance you are currently setting.

6. Repeat the process for all selected setback vertices. If you are using a preview, then
you may notice that the preview goes away when starting a second set of setback values.
Don’t worry. This is probably not because the feature is going to fail. Once you finish typ-
ing the values, the preview will return. When you have spent as much time setting up a
feature as you will spend on this, seeing the preview disappear can be frustrating; how-
ever, persevere, and it will return.

Selecting a Specialty Feature

SolidWorks contains several specialty features that perform tasks that you will use less often.
Although you will not use these features as frequently as others, you should still at least be aware
of them and what they do, because you never know when you will need them.

Dome and Shape

é The Dome and Shape features are similar in many ways. For example, they both bulge or indent a
single selected face. Neither of these features really offers you much control over the actual shape;
instead, the shape is controlled by the following:

The shape of the selected face

An internal algorithm

Various settings

A constraint sketch

While each of these elements influences the shape of the feature, this influence is not predictable
or controllable — it is more of a random or approximate affect. When SolidWorks first released
the Shape feature, they advertised it as a complex shape-creation tool. In fairness, it does create
complex shapes, but they are not truly intentional, predictable, or controllable, and are certainly
not anything that you would use on a consumer product. Dome and Shape are quick approxima-
tions, and rarely achieve professional-looking results.

Dome and Shape features are best used when you are looking for a generic bulge or
indentation, and are not too concerned about controlling the specific shape.
Occasionally, one of these features may be exactly what you need, but when you need more
precise, predictable control, then you should use the Fill, Boundary or Loft feature.

reeE R A~ A
BEST PRACTLCE
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Because there are more similarities than differences between the Dome and Shape features, I've
listed the differences first to distinguish them:

B The Dome feature can create multiple domes on multiple selected faces in a single fea-
ture, although it creates only a single dome for each face. Shape can shape only a single
face for each command.

B Using the Elliptical Dome setting, Dome can create a feature that is tangent to the vertical.
Shape is always tangent to the face that you have selected to create it.

B Shape has controls named Pressure, Bend, and Stretch, implying that you should visual-
ize its function as an elastic membrane with positive or negative fluid pressure that causes
it to bulge or collapse inward.

The similarities between the features include the following:

Both features can use constraint sketches to limit their shape.
Both features work on non-planar faces.
Neither feature can establish a tangent relationship to faces bordering the selected face.

Neither feature can span multiple faces.

Both features display a temporary untrimmed four-sided patch that extends beyond the
selected face when you use them on a non-four-sided face.

Both features function on solids.

B Neither feature functions on surfaces.

The Dome and Shape interfaces are shown in Figure 7.56. Notice that the Shape feature is not inte-
grated into the PropertyManager (SolidWorks features used to all use dialog boxes in the graphics
window until they were moved to the PropertyManager to save space. This is still true as late as
early releases of SolidWorks 2009, and is always a sign of a feature that is not used often. As is the
case with a rarely used feature that is not very useful, the feature may disappear rather than be
updated.

The Dome feature has two notable settings: the elliptical dome and continuous dome.

The elliptical dome is available only on flat faces where the boundary is either a complete circle or
an ellipse. The cross-section of the dome is elliptical, and does not account for draft, which means
that it is always tangent to the perpendicular from the selected flat face.

The continuous dome is a setting for any non-circular or elliptical face, including polygons and
closed-loop splines. The setting results in a single unbroken face. If you turn the continuous dome
setting off, it functions like the elliptical dome setting. Figure 7.57 shows the most useful settings
for the Dome feature.
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Dome and Shape interfaces

FIGURE 7.57

Settings for the Dome feature

Non-continuous dome

Elliptical dome Non-elliptical dome

Continuous dome
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Wrap feature

The Wrap feature enables you to wrap 2D sketches around cylindrical and conical faces. However,
trying to wrap around 360 degrees can cause some difficulties. Although all the available informa-
tion on the Wrap feature says that you can wrap onto a conical surface, it fails to mention that the
point of the cone must be cut off in order for it to work.

The Wrap feature works by flattening the face, relating the sketch to the flat pattern of the face,
and then mapping the face boundaries and sketch back onto the 3D face. The reason why it is lim-
ited to cylindrical and conical faces is that these types of geometry are developable. This means that
the faces can be mapped to the flat pattern through some relatively simple techniques that happen
behind the scenes. Developable geometry can be flattened without stretching. You will see in a
later chapter that sheet metal functions are limited in the same way and for the same reasons.

SolidWorks does not wrap onto other types of surfaces, such as spherical, toroidal, or general
NURBS surfaces, because you cannot flatten these shapes without distorting or stretching the mate-
rial. There is software that can flatten these shapes, but it is typically done for sheet-metal deep
drawing applications, which highly deform the metal. Figure 7.58 shows the Wrap
PropertyManager interface.

FIGURE 7.58

The Wrap PropertyManager interface

The Wrap feature has three main options:

B Emboss
B Deboss
W Scribe
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Scribe

Scribe is the simplest of the options to explain, and understanding it can help you understand the
other options. Scribe creates a split line-like edge on the face.

Several requirements must be met in order to make a wrap feature work:

B The face must be a cylindrical or conical face.
B The loop must be a closed loop or nested closed loop 2D sketch.

B The sketch must be on a plane that is either tangent to or parallel to another plane that is
tangent to the face.

B Wrap supports multiple closed loops within a single feature.

B The wrap should not be self-intersecting when it wraps around the part (self-intersection
will not cause the feature to fail, but on the other types, Emboss and Deboss, it may
produce unexpected results).

Scribes can be created on solid or surface faces. Scribed surfaces are frequently thickened to create
a boss or a cut.

Emboss

The Wrap Emboss option works much like the scribe, but it adds material inside the closed loop
sketch, at the thickness that you specify in the Emboss PropertyManager. Embossing can only be
done on solid geometry. If the feature self-intersects, then the intersecting area is simply not
embossed, and is left at the level of the original face. One result is that creating a full wrap-around
feature, such as the geometry for a barrel cam, requires a secondary feature. This is because the
Wrap feature always leaves a gap, regardless of whether the sketch to be wrapped is under or over
the diameter-multiplied-by-pi length.

TR To work around this problem, you can use a loft, extrude, or revolve feature to span
the gap.

When you use the Emboss option, you can set up the direction of pull and assign draft so that the
feature can be injection molded. This limits the size of the emboss so that it must not wrap more
than 180 degrees around the part.

Deboss
Deboss is just like emboss, except that it removes material instead of adding it.

Figure 7.59 demonstrates all these options. The part shown in the images is available on the
CD-ROM with the filename Chapter 7 Wrap.sldprt. For each of the demonstrated cases,
the original flat sketch is shown to give you some idea of how the sketch relates to the finished
geometry.
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The Wrap Feature options

Sketch Scribed surface feature
thickened into a solid and patterned

Scribed edge

Embossed barrel cam

Closed loop cam profile sketch

Keep in mind that this feature is not like the projected sketch. A projected sketch is not foreshort-
ened on the curved surface, but is projected normal from the sketch plane. A sketch that is one
inch long will measure one inch along the curvature of the surface and will measure less than one
inch linearly from end to end.
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The scribed part in the previous figure was created on a conical surface body. The surface was then
thickened as a separate body and patterned.

ClOSS-PER Chapter 26 covers working with multiple bodies, and Chapter 27 covers surfaces.
—1lJYy~IlE

The embossed cam employed a workaround with a revolve feature to close the gap that is always
created when wrapping all the way around a part.

The example with the debossed text employs a direction of pull and draft so that the geometry can
be molded.

Flex

The Flex feature is different from most other features in SolidWorks. Most other features create
new geometry, but Flex (and Deform, which follows) takes existing geometry and changes its
shape. Flex can affect the entire part, or just a portion of it. Flex works on both solid and surface
bodies, as well as imported and native geometry.

Figure 7.60 shows the Flex PropertyManager interface. Flex has four main options and many set-
tings. The four main options are as follows:

B Bending. Establish two trim planes to denote the ends of the bent area, and specify an
angle or radius for the bend.

B Twisting. Establish two trim planes to limit the area of the twist, and enter the number
of degrees through which to twist.

B Tapering. Establish two trim planes to limit the area of the taper. The body will be larger
toward one end and smaller toward the other end.

B Stretching. Establish two trim planes to limit the area to be stretched. You can stretch
the entire body by moving the trim planes outside of the body.

Flex is not the kind of feature that you should use to actually design parts, but it can
be extremely valuable when you need to show a part in an “in use” state. A simple
example would be a rubber strap that stretches over something when it is used, but that is
designed and manufactured in its free state. The geometry that you can create by using the flex
functions is not generally production-model quality, but it is usually adequate for a looks-like
model.

MESTT LN AT S

BEST PRACT.CE

Figure 7.61 shows examples of each flex option using a model of a rubber grommet. The part
shown in the figure can be found on the CD-ROM with the filename Chapter 7 Flex.sldprt.

270



Selecting Features

The Flex PropertyManager interface

In some cases, the triad and trim planes are slightly disoriented. The best thing to do in situations
like this is to simply reorient the triad using the angle numbers in the Triad panel of the
PropertyManager. This is also a solution if the planes are turned in such a way that the axis of
bending is not oriented to the bend that the part requires.

The Flex feature is very conscious of separate bodies. In some cases this can be helpful, but in
default situations when there is only one body in the part, it can be annoying. Remember to select
the body to be affected in the very first selection box at the top of the PropertyManager.

TR If you want to bend only one of the tabs on the grommet, then the best solution is
to split the single body into two bodies, and flex only one of the bodies. The exam-
ples shown for twisting and stretching use this technique.

‘ ~e~ r,~r Splitting a single body into multiple bodies is covered in Chapter 26.
CPOSS-MEF p 8 8 Y P p

You can place the trim planes by selecting a model vertex, by dragging the arrow on the plane, or
by typing in a number. Be careful when dragging the plane arrows because dragging the border of
the plane drags the flex value for the feature. (Dragging the plane in a bending operation is like
changing the angle or radius for the bend.)
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FIGURE 7.61

A rubber grommet in various flex states

Twisting Bending

Natural position Stretching
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Notice bodies have been split

Using the triad can be very tricky. Moving the triad in the bending option moves the axis of the
bend, and so it determines whether the bend will compress or stretch the material. The position of
the triad also determines which side of the bent body will move or stay stationary, or if both sides
will move. Placing the triad directly on a trim plane causes the material outside the bend on that
side of the trim plane to remain stationary.

I highly recommend taking a look at the models that are provided with this chapter to examine the
various functions of the Flex feature more carefully. The model uses configurations, which are cov-
ered in Chapter 10.
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Deform

Like the Flex feature, Deform changes the shape of the entire model without regard to parametrics,
features, history, or dimensions. Some software packages call this technique global shape modeling.
Also like Flex, Deform works on surface bodies as well as solids. Deform can also handle imported
geometry as well as SolidWorks native parts. Model complexity is not an issue unless the part runs
into itself during deformation.

The Deform feature is also another feature type that you may not use to actually design anything,
but that you may use to show a model in a deformed state.

Also, it is a minor point, but if you use the large icons setting, notice that the toolbar icon used for
Deform is the wrong one. The icon used for large icons is the Boundary Cut icon. Just be careful if
you use large icons.

r, . ~- ~- Typically, if you want a model to have a certain shape, then you need to intention-
ASe - ally and precisely model it with that shape. The problem with using deform and flex
geometry for actual design data is that they both create fairly approximate geometry, and this
process yields a result that is not completely intentional. The shape that you finally achieve is the
result of arbitrary uncontrolled function of the feature, not necessarily creating a shape that you
had clearly envisioned beforehand.

Deform has three types:

B Point. This type deforms a portion of the model by pushing a point and the geometry
around it.

B Curve to Curve. The most precise and useful deform type. Select an existing edge and
force the edge to match a curve.

B Surface Push. This type of deform, while conceptually a very interesting function, is
nearly unusable in practice. The part is deformed into a shape vaguely resembling an
intermediate shape between the existing state of the part and a “tool” body.

Figure 7.62 shows the PropertyManager interface for the Deform feature. The interface is different
for each of the three main types, and also changes, depending on selections within the individual

types. The interface shown is for the curve to curve type because 1 believe this to be the most use-
ful type.

Point Deform

The Point Deform option enables you to push a point on the model, and the model deforms as if it
were rubber. Figure 7.63 shows the PropertyManager, as well as a before-and-after example of the
Point Deform function. The key to using this feature is to ensure that the Deform Region option is
turned off. Aside from that, you just have to use trial and error when applying the Deform option.
The depth, diameter, and shape of the deformation are not very precise. Also, you cannot specify
the precise location for the point to be deformed. Again, this is best used for “looks-like” models,
not production data.

In the model from Figure 7.63, two Point Deform features are used, one to apply some shape to
the back and one to apply some shape to the seat.
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The PropertyManager interface for the curve to curve deform

FIGURE 7.63

The Deform Point PropertyManager and a before-and-after example
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Curve to Curve Deform

Because this option uses curve (or sketch or edge) data, it is a more precise method than the other
deform types. The main concept here is to transform a curve on the original model to a new curve,
thus deforming the body to achieve the new geometry.

The model shown in Figure 7.64 has been created using the curve to curve deform. The part starts
as a simple sweep (sweep an arc along an arc), and then a split line is created to limit the deform to
a specific area of the model. The model is on the CD-ROM with the filename Chapter 7 Deform
Curve to Curve.sldprt.

FIGURE 7.64

Using the curve to curve deform option
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FIGURE 7.65

Surface Push Deform

I do not go into much detail on the Surface Push Deform type because it is not one of the more
useful functions in SolidWorks. In order to use it, you must have the body of the part that you are
modeling, and a tool body that you will use to shape the part that you are modeling. The finished
shape does not fit the tool body directly, but looks about half-way between the model and the tool
body, blended together in an abstract sort of way. It looks like the dent that would result from an
object being thrown very hard at a car fender, in that neither the thrown part nor the fender is
immediately recognizable from the result.

Indent

The Indent feature is what the Surface Push Deform is trying to be, or should try to be. Indent uses
the same ingredients as the Surface Push, but it produces a result that is both intelligible and use-
ful. For example, if you are building a plastic housing around a small electric motor, then the
Indent feature shapes the housing and creates a gap between the housing and the motor. Figure
7.65 shows the PropertyManager interface for the Indent feature, as well as a before-and-after shot
of the indent.

Using the Indent feature

276

In this case, the small motor is placed where it needs to be, but there is a wall in the way. Indent is
used to create an indentation in the wall using the same wall thickness, and placing a gap of .010
inches around the motor. The motor is brought into the wall part using the Insert= Part com-
mand. This is a multibody technique. Multibodies are examined in detail in Chapter 26.
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Tutorial: Bracket Casting

When you follow this tutorial, you are encouraged to follow the directions the first time to

make sure that you understand the concepts involved, and then to go through it again, this time
deviating from the instructions to see if you can expand your understanding by experimentation.
To try bracket casting, follow these steps:

1. Open a new part using an inch-based template.

2. On the Right plane, draw a circle centered at the origin with a diameter of 1.50
inches, and a second circle placed 4.000 inches vertically from the first, with a
diameter of 2.250 inches.

3. Exit the sketch, and make sure Instant 3D is turned on. The Instant 3D icon is on the
Features toolbar, and looks like a ruler with an arrow. Click on the sketch in the graph-
ics window, and pull the Instant 3D arrow to create a solid. Edit the feature (right- or left-
click on the feature either in the graphics window or in the FeatureManager and click the Edit
Feature icon, which is the yellow and green block with a hand pointing to it). Now enter
numbers by hand so that you extrude the sketch 1.000 inch using a From condition of Offset
by 1.000 inch, such that the offset and the extrude depth are in the same direction. Rename
this feature Bosses in the FeatureManager. Figure 7.66 shows the results of these steps.

FIGURE 7.66

The results of Steps 1 to 3

L OSTE These steps produce multiple bodies that will be merged in a later step. Multiple-

) - body parts are covered in more detail in Chapter 26. You can tell that there are
multiple bodies by looking at the Solid Bodies folder near the top of the tree, and expanding the
folder. The bodies are listed in the folder.
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TIP

On the Top plane, open a new sketch and draw a horizontal construction line across
the cylinder, from the midpoint of one side to the midpoint of the other side. To
pick up the automatic relations for the midpoints more easily, it is recommended that
you orient the view, normal to the sketch, or use the Top view. It does not matter if you
make the relations to the top or bottom cylinder, because the midpoints of the sides are
in the same place when they are projected into the sketch plane.

Next, draw an ellipse (Tools= Sketch Tools= Ellipse) centered at the midpoint of
the construction line and that measures .700 inches horizontally and 1.375 inches
vertically. Exit the sketch.

Show the sketch for the Bosses feature (click the plus icon next to the Bosses
extrude to show the sketch, and then right-click the sketch and select Show).

Create a plane parallel to the Top plane at the center of the larger circle. You can
access the Plane creation interface at Insert = Reference Geometry = Plane. If you select
the Top plane from the flyout FeatureManager and the center of the larger sketch circle
from the graphics window, the interface automatically selects the Parallel Plane At Point
option. Click OK to create the plane. Rename this plane Top Boss Plane.

Draw a second ellipse on the Top Boss Plane. Do not draw a construction line as you
did for the first ellipse; instead, you can just make the center point of the second ellipse
directly on top of the first ellipse’s center point. The dimensions should be 1.000 inch
horizontal by 1.750 inches vertical. Figure 7.67 shows the results up to this point.

FIGURE 7.67

The results up to Step 8

When you are sketching on parallel planes that are separated by some distance and
trying to pick up automatic relations, it is often very helpful to be looking “normal

to” the sketch, so that you can see how other entities are projected into the sketch plane.

9.

Use the Loft feature to loft between the two ellipses. Be sure to select the ellipses in
approximately the same location so that they do not twist. If the loft preview accidentally
twists, then use the connectors (light-blue square dots on the sketches that are connected
by a straight line) to straighten out the loft.
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Notice that this feature joined together the other two disjoint bodies with the body
that was created by the loft into a single body. This is a result of selecting the Merge

Result option in the Options panel.

TP

loft.

10.

TP

If you want to experiment, expand the Start/End Constraints panel and apply end
conditions for the loft. This causes the loft to change from a straight loft to a curved

Right-click all sketches that are showing, and select Hide. Do the same for the Top
Boss Plane. This cleans up the display to prevent it from becoming confusing. However, if
you prefer to see the sketches, then you can leave them displayed.

You can either hide or show different types of entities in groups by using the View
menu. Hide All Types hides everything, and disables the options for individual

entity types to be used.

11.

12.

13.

14.

MNOUT
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16.

17.

18.

Open a sketch on the Right plane. Sketch an ellipse such that the center is oriented
1.750 inches vertically from the Origin, and the ellipse measures .750 inches horizontally
and 1.500 inches vertically.

Extrude this ellipse using the Up To Next end condition. If Up To Next does not
appear in the list, then change the direction of the extrude and try it again.

[13EL)

Show the sketch of the Bosses feature by expanding the feature (click the “+” next
to it), right- or left-clicking on the sketch icon, and selecting the Hide/Show icon
(eyeglasses). Next, open a sketch on the Right plane. Sketch two circles that are concen-
tric with the original circles, with the dimensions of .875 inches and 1.250 inches. Exit
the sketch.

Use Instant 3D to create an extruded cut that goes through the large circular bosses.
This feature will look like a boss extrusion at first, so when you have finished dragging its
depth, a small toolbar with two icons appears. One of the icons allows you to add draft;
the other allows you to turn the boss into a cut. Figure 7.68 shows the state of the model
up to this step.

Start a fillet feature, and select the face of the Loft feature. Assign a radius of .200
inches.

Although this fillet is created by selecting a face, it is not a face fillet. Selecting a
face for a regular constant radius fillet simply fillets any edge that is on the face.

Create a mirror feature, using the Right plane as the mirror plane. In the Mirror
PropertyManager, expand the Bodies To Mirror panel, and select anywhere on the part.
Make sure that the Merge Solids option is selected. Click OK to accept the mirror.

Orient the view to the Front view, and then turn the view on its side (hold down Alt
and press the left- or right-arrow key six times).

Open a new sketch on the Front plane. From the View menu, make sure that Hide All
Types is not on, and show Temporary Axes. Draw and dimension a horizontal construc-
tion line, as shown in Figure 7.69.
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19.

20.

21.

22,

FIGURE 7.68

The results up to Step 14

FIGURE 7.69

The results up to Step 18

With the construction line selected, start the Sketch Text command (Tools= Sketch
Entities= Text). Make sure that the line appears in the Curves selection box.

Click in the text box, and type Made in USA (or your name or company name). Select
the text and click the Bold button. Deselect the Use Document Font option, change the
font to use units, and set the height to .175 inches.

Click OK to exit the Sketch Text PropertyManager, and click OK again to exit the
sketch. You can turn off the Temporary Axis display.

Click Insert=> Features= Wrap. You should be prompted to select a plane or a sketch.
Use the Flyout FeatureManager to select the sketch that you just created with the sketch
text in it. Next, select the cylindrical face of the boss to see a preview of the text wrapped
onto the face. If the text appears backwards, then click the Reverse Direction option in
the Wrap PropertyManager.



23.

24.

Selecting Features

Select the Emboss option, and assign a thickness of .025 inches. Click in the Pull
Direction selection box and select the Front plane. Click OK to accept the feature.

Save the part and close it. If you would like to examine a reference part, you can find it
on the CD-ROM with the filename Chapter 7 Tutorial Bracket Casting.sld-
prt. The finished part is shown in Figure 7.70.

FIGURE 7.70

The finished part

Tutorial: Creating a Wire-Formed Part

Follow these steps to create a wire-formed part:

1.
2.

Open a new part using an inch-based template.

Open a sketch on the Right plane and sketch a circle that is centered on the Origin
with a diameter of 1.500 inches.

Create a Helix, Constant Pitch, Pitch, and Revolution, where the Pitch = .250
inches, Revolutions = 5.15, and Start Angle = 0. The Helix command is found at
Insert = Curve = Helix/Spiral.

Create a sketch on the Front plane, as shown in Figure 7.71. Pay careful attention
when adding the construction line, as shown. This line is used in the next step to refer-
ence the end of the arc.

Open a sketch on the Right plane and use Figure 7.72 to add the correct relations
and dimensions. Be aware that the two sketches shown are on different sketch planes,
which makes it difficult to depict in 2D. You can also open the part from the CD-ROM
for reference.
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The results up to Step 4

FIGURE 7.72

The sketch for Step 5

$

Coincident Vertical relation

Dimension references
end of construction line

6. Exit the sketch and create a projected curve. The Projected Curve function is found at
Insert= Curve = Projected Curve. Use the Sketch on Sketch option.
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10.

11.

12.

Selecting Features

Open a 3D sketch. You can access a 3D sketch from the Insert menu. Select the helix
and click Convert Entities on the Sketch toolbar. Then select the projected curve and
click Convert Entities again. You now have two sections of a 3D sketch that are uncon-
nected in space.

Draw a two-point spline to join the ends of the 3D sketch entities that are closest to
one another. Assign tangent relations to the ends to make the transition smooth. Figure
7.73 illustrates what the model should look like at this point.

FIGURE 7.73

The results up to Step 8

Connecting spline

Adjust the length of this handle

You may have to adjust the length of one of the spline tangency length arrows to
keep the spline from remaining inside the cylinder of the helix.

Open a sketch on the Right plane, and draw an arc that is centered on the Origin
and coincident with the end of the 3D sketch helix. The 185-degree angle is created
by activating the dimension tool and clicking first the center of the arc, and then the two
endpoints of the arc. Now place the dimension. This type of dimensioning allows you to
get an angle dimension without dimensioning to angled lines. Exit the sketch.

Create a Composite Curve (Insert= Curve= Composite) consisting of the 3D
sketch and the new 2D sketch.

Create a new plane using the Normal to Curve option, selecting one end of the com-
posite curve.

On the new plane, draw a circle that is centered on the end of the curve with a
diameter of .120 inches. You need to create a Pierce relation between the center of the
circle and the composite curve.
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13. Create a sweep feature using the circle as the profile and the composite curve as the
path. To create the sweep, you must first exit the sketch.

14. Hide any curves that still display.

15. Click Insert= Cut= With Surface. From the Flyout FeatureManager, select the Right
plane. Make sure that the arrow is pointing to the side of the plane with the least amount
of material. Click OK to accept the cut. The finished part is shown in Figure 7.74.

FIGURE 7.74

The finished part

Summary

SolidWorks has a wide range of feature types to choose from, ranging from simple extrudes and
revolves to more complex lofts and sweeps. It also offers a range of specialty features that may not
be useful on a day-to-day basis, but that have their place in the modeling techniques that you need
to know to get the job done.

Some features, such as extrude, fillet, and flex, have so many options that it may be difficult to take
them all in at once. You should browse through the models on the CD-ROM for this chapter and
use the Rollback bar (described in detail in Chapter 11) to examine how the parts were built. You
can then try to create a few on your own.
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Patterning and Mirroring

atterning and mirroring in SolidWorks are great tools to help you

improve your efficiency. The software provides many powerful pat-

tern types that also help you accomplish design tasks. In addition to
the different types of patterns, there are many more detailed options that
enable functionality that you may not have considered. A solid understand-
ing of patterning and mirroring tools is necessary to be able to build the
maximum amount of parametric intelligence into your models.

Patterning in a Sketch

You can use both pattern and mirror functions in Sketch mode, although sketch
patterns are not a preferred choice. The distinction between patterning and
mirroring in Sketch mode is important when it comes to sketch performance.

. s v ~ = Although there are many metrics for how software per-
TAMANCE forms, in SolidWorks, the word performance means the
same thing as speed. Sketch patterns have a very adverse effect on speed.

You might hear a lot of conflicting information about which features are bet-
ter to use in different situations. Users coming from a 2D background often
use functions such as sketch patterning because it’s familiar, without ques-
tioning whether there is a better approach. When in doubt, you can perform
a test to determine which features work best for a given situation.

In this test, I made a series of 20-by-20 patterns using circles, squares, and
hexagons. The patterns are both sketch patterns and feature patterns, and I
created them with both Verification On Rebuild and Geometry Pattern
turned on and off. Verification On Rebuild is a setting that you can access
through Tools=> Options = Performance, and Geometry Pattern is a setting
that is applicable only to feature patterns.
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TABLE 8.1
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oo rpp Foramore complete description of the Verification On Rebuild, see Appendix A.
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Given that this is the second edition of this book, I thought it would be useful to
run these tests again on the new versions of the software and with my original hard-
ware. The results of the test redo are very interesting. Most of the feature rebuild times are lon-
ger, in the range of twice to three times as long. The Verification On Rebuild results are the
exception. These results are faster by about 20 percent. This compares rebuild times from the
2007 (Service Pack 2) and 2009 (alpha) releases, and both tests were done without RealView.

Table 8.1 shows the rebuild times (in seconds) of solid geometry created from various types of pat-
terns as measured by Feature Statistics (found at Tools=> Feature Statistics). Sketch patterns are far
slower than feature patterns, by a factor of about ten. The biggest speed reduction occurs when
you use sketch patterns in conjunction with the Verification on Rebuild setting, especially as the
number of sketch entities being patterned increases.

Generally, the number of faces and sketch relations being patterned has a significant effect on the
speed of the pattern. The sketch pattern times are taken for the entire finished model, including
the sketch pattern and a single extrude feature, using the sketch with the pattern to do an extruded
cut. The sample parts are on the CD-ROM for reference. Look for the filenames beginning with
“Referencel” through “Reference?7.”

Pattern Rebuild Times

Pattern Type Default Geometry Pattern Verification on Rebuild
20 x 20 sketch circle 3.02 n/a 11.0

20 x 20 sketch square 10.1 n/a 112

20 x 20 sketch hex 17.4 n/a 232

20 x 20 feature circle .28 .78 .29

20 x 20 feature square .84 1.44 .84

20 x 20 feature hex 1.28 1.86 1.28
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The most shocking data here is the difference between a sketch pattern of a hex when extruded as
cuts into a flat plate compared to a feature pattern of a single extruded hex with each using the
Verification On Rebuild option. That is not a typo. 1.28 seconds compared to 232 seconds. Do you
still like sketch patterns? Figure 8.1 shows one of the parts used for this simple test.
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A pattern part used for the test

One interesting result of this test was that if a patterned extruded feature creates a situation where
the end faces of the extruded features have to merge into a single face, the feature can take ten
times the amount of time to rebuild as a pattern with unmerged end faces. This was an inadvertent
discovery. I'm sure there are many such discoveries that you could make on your own if you were
to investigate rebuild speeds for end conditions for cuts such as Through All, Up To Face, Up To
Next, and so on, as well as the difference between cuts and boss features. Further, using Instant 3D
can be an impediment when editing very large sketches simply due to the effects of the preview.

Further sketch myth debunking

People often say that it is best practice to fully define your sketches. I completely agree with this
statement. However, I have heard people go to the extent to say that fully defined sketches solve
faster, with the rationale being that SolidWorks has to figure out how to solve the underdefined
sketch, but the fully defined sketch is already spelled out. Let’s find out.

In this example, I created a sketch pattern of 4 X 4 rectangles, and use the Fully Define Sketch tool
to add dimensions. Then I copied and pasted the sketch and removed all the dimensions and rela-
tions. Figure 8.2 shows the Feature Statistic results.

It is safe to say that fully defined sketches are best practice, but it is not due to rebuild speed.
Sketch relations are costly. Patterning sketch relations are even more costly. The rebuild time does
not even come close to the time that it takes the Fully Define Sketch tool to create all the dimen-
sions and relations in the first place. This combination of geometry, software, and hardware took
about 30 seconds of CPU time to add the relations and dimensions.
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FIGURE 8.2

Comparing rebuild times of a fully defined sketch to a completely undefined sketch
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Patterning a sketch

It is best to pre-select the sketch entities that you want to pattern before using the Sketch Pattern
tool. If you do not pre-select, then after the PropertyManager is open, you can only select entities
to pattern one by one because the window select is not available for this function.

TP When creating a linear sketch pattern, be sure to select the Add Dimension check
boxes. If these dimensions are not added, then editing the pattern becomes more
difficult.

Linear Sketch Pattern
The Linear Pattern PropertyManager is shown in Figure 8.3.

The Direction 1 panel works predictably by establishing the direction and spacing, and then the
number. The Angle setting enables you to specify a direction that does not rely on anything outside
of the sketch.

The Direction 2 panel works a little differently. You must first specify how many instances you
want, and then the other information becomes available.

Circular Sketch Pattern

The Circular Sketch Pattern defaults to the sketch Origin as the center of the pattern. You can
move and position this point using the numbers in the PropertyManager, but you cannot dimen-
sion it until after the pattern is created. Again, this is another feature where you need to pre-select
because window selection is not available (patterned sketch entities must be selected one by one to
go into the Entities to Pattern panel). Figure 8.4 shows the Circular Pattern PropertyManager.
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The Linear Pattern PropertyManager

FIGURE 8.4

The Circular Pattern PropertyManager
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FIGURE 8.5

Mirroring in a Sketch

Mirroring in a sketch is a completely different matter from patterning in a sketch. It offers superior
performance, and the interface is better developed. Mirrored entities in a sketch are an instrumen-
tal part of establishing design intent.

Two methods of mirroring items in a sketch are discussed here, along with a method to make enti-
ties work as if they have been mirrored when in fact they were manually drawn.

Mirror Entities

Mirror Entities works by selecting the entities that you want to mirror along with a single center-
line, and clicking the Mirror Entities button on the Sketch toolbar. It is a simple and effective tool
that you can use on existing geometry. This method is the fastest way to use the tool but there are
other methods. You can preselect or post select, using a dialog box to select the mirror line, which
does not need to be a centerline.

One feature of Mirror Entities may sometimes cause unexpected results. For example, in some situ-
ations, Mirror Entities will mirror a line or an arc and merge the new element with the old one
across the centerline. This happens in situations where the mirror and the original form a single
line or a single arc. SolidWorks may delete certain relations and dimensions in these situations.

Dynamic Mirror

As the name suggests, Dynamic Mirror mirrors sketch entities as they are created. You can activate it
by selecting a centerline and clicking the button on the Sketch toolbar. Dynamic Mirror is not on the
toolbar by default; you need to select Tools=> Customize = Commands to add it to the toolbar. You
can also access Dynamic Mirror through the menus at Tools= Sketch Tools= Dynamic Mirror.

When you activate this function, the centerline displays with hatch marks on the ends and remains
active until you turn it off or exit the sketch. Figure 8.5 shows the centerline with hatch marks.

The Dynamic Mirror centerline with hatch marks
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Symmetry sketch relation

[ have covered the Symmetry sketch relation in previous chapters on sketching, but I mention it
here because it offers you a manual way to mirror sketch entities. There are editing situations when
you may not want to create new geometry, but instead use existing entities with new relations
driving them. To create the Symmetry sketch relation, you must have two similar items (such as
lines or endpoints) and a centerline selected.

Mirroring in 3D sketches

Chapter 31 deals with 3D sketches in more detail, but I discuss the mirror functionality here to
connect it with the rest of the mirroring and patterning topics. 3D sketches can contain planes and
if you are sketching on a plane in a 3D sketch, you can mirror items on it. You cannot mirror
general 3D sketch entities.

Sketch patterns are also unavailable in the 3D sketch, but starting with the 2009 release, you can use
the Move, Rotate, and Copy sketch tools on planes in 3D sketches. Combining one questionable
functionality (3D sketches) with another (sketch patterns) does not usually improve either one.

Geometry Pattern

The SolidWorks Help file says that the Geometry Pattern option in feature patterns results in a
faster pattern because it does not pattern the parametric relations. This claim is valid only when
there is an end condition on the patterned feature such that the feature will actually pattern the
end condition’s parametric behavior. The part shown in Figure 8.6 falls into this category. The
improved rebuild time goes from .30 to .11 seconds. Although a 60 percent reduction is signifi-
cant, the most compelling argument for the use of the Geometry Pattern is to avoid the effect of
patterning the end-condition parametrics.

Because of this speed differential, you need to be careful about using the Geometry Pattern option.
SolidWorks turns this option on by default for some patterns where you may not wish to use it for
rebuild time reasons.

Under some conditions, Geometry Pattern will not work. One example is any time a patterned face
merges with an unpatterned face. These situations can be difficult to identify. Figure 8.7 shows a
pattern that cannot be created using the Geometry Pattern option. The boss merges with the side
face of the block, which generates the error message shown in the figure. The circular part shown
in the image is an exception where the partial cylindrical bosses merge with the side of the cylin-
der, but Geometry Pattern works.

In some situations, SolidWorks error messages may send you in a loop. One message may tell you
that the pattern cannot be created with the Geometry Pattern turned on, so you should try to turn
it off. When you do that, you may get another message that says the pattern will not work, and
that you should try to use the Geometry Pattern setting. In cases like this you may try to use a dif-
ferent end condition, or change the selection of features patterned along with the feature, such as
fillets. You may also try to pattern bodies or even faces rather than features.
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A geometry pattern test

Geometry pattern off — Parametrics are patterned

Geometry pattern on — Parametrics not patterned

FIGURE 8.7

Merged faces
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Patterning Bodies

I cover multiple bodies in depth in Chapter 26, but need to deal with it briefly here. Any discus-
sion of patterning is not complete without a discussion of bodies because using bodies is an avail-
able option with all the pattern and mirror types.

SolidWorks parts can contain multiple solid or surface bodies. A solid body is a solid that comprises
a single contiguous volume. Surface bodies are defined differently, but they can also be patterned
and mirrored as bodies.

There are both advantages and disadvantages to mirroring and patterning bodies instead of fea-
tures. The advantages can include the simplicity of selecting a single body for mirroring or pattern-
ing. In cases where the geometry to be patterned is complex or there is a large number of features,
patterning bodies also can be much faster. However, in the example used earlier with patterning
features in a 20-by-20 grid of holes, when done by patterning a single body of 1" x 1" x .5" with a
.5" diameter hole, patterning bodies gives a rebuild time of about 130 seconds with or without
Verification On Rebuild. It is the function that combines the resulting bodies into a single body
that takes most of the time. This says that for large patterns of simple features, patterning bodies is
not an efficient technique. Although I do not have an experiment in this chapter to prove it, 1
believe that creating a pattern of a smaller number of complex bodies using a large number of fea-
tures in the patterned body would show a performance improvement over patterning the features.

Another disadvantage of patterning or mirroring bodies is that it does not allow you to be selective.
You cannot mirror the body minus a couple of features without doing some shuffling of feature
order in the FeatureManager. Another disadvantage is that if the base of the part has already been
mirrored by a symmetrical sketch technique, then body mirroring is not going to help you mirror
the subsequent features. Also, the Merge Bodies option within the mirror feature does not work as
you would want it to. It merges only those bodies that are part of the mirror to bodies that are part
of the mirror. Pattern Bodies does not even have an option to merge bodies. Both of these func-
tions are often going to require an additional combine feature (for solid bodies) or knit (for surface
bodies) to put the final results together.

Some of these details may seem obscure when you're reading about them, but when you begin to
work patterning bodies and begin trying to merge them into a single body, read over this section
again. The inconsistency between the Merge option existing in Mirror but not in Pattern is unex-
plainable, and a possible opportunity for an enhancement request.

Bodies are discussed in more detail in Chapter 26. Surface modeling is covered in

o)y e
R et Chapter 27.

Patterning Faces

Most of the pattern types have an option for Pattern Faces. This option has a few restrictions, the
main limitation being that all instances of the pattern must be created within the boundaries of the
same face as the original. Figure 8.8 shows an example of the Pattern Faces option working with a
Circular Pattern feature.
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A circular pattern using the Pattern Faces option

To get around this limitation, you can knit and pattern the surface body, as shown in Figure 8.9.

FIGURE 8.9

Patterning a surface body

Splitin face means faces
from feature on side cannot be
patterned all the way around
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Cl OSSR Working with surface bodies is covered in Chapter 27.

Patterning Fillets

You may hear people argue that you cannot pattern fillets. This is partially true and partially
untrue. It is true that fillets as individual features cannot be patterned. For example, if you have a
symmetrical box and a fillet on one edge and want to pattern only the fillet to other edges, this
does not work. However, when fillets are patterned with their parent geometry, they are a perfectly
acceptable candidate for patterning. This is also true for the more complex fillet types, such as vari-
able radius and full radius fillets. You may need to use the Geometry Pattern option, and you may
need to select all the fillets affecting a feature, but it certainly does work.

Understanding Pattern Types

Up to now, [ have discussed patterns in general; differentiated sketch patterns from feature pat-
terns, face patterns, and body patterns; and looked at some other factors that affect patterning and
mirroring. I will now discuss each individual type of pattern to give you an idea of what options
are available.

.
Linear Pattern
990 The Linear Pattern feature has several available options:
i)
B Single direction or two directions. Directions can be established by edge, sketch entity,
axis, or linear dimension. If two directions are used, the directions do not need to be per-
pendicular to one another.

B Spacing. The spacing represents the center-to-center distance between pattern instances,
and can be driven by an equation.

B Number of Instances. This number represents the total number of features in a pattern,
which includes the original seed feature. It can also be driven by an equation. Equations
are covered in detail in Chapter 9.

B Direction 2. The second direction works just like the first, with the one exception of
the Pattern Seed Only option. Figure 8.10 shows the difference between a default two-
direction pattern and one using the Pattern Seed Only option.

B Instances to Skip. This option enables you to select instances that you would like to
leave out of the final pattern. Pink dots are the instances that remain, and the red dots are
the ones that have been removed. Figure 8.11 shows the interface for skipping instances.
You may have difficulty distinguishing the red and pink colors on the screen.
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FIGURE 8.10

Using the default two-direction pattern and the Pattern Seed Only Option

Original feature Pattern seed only

FIGURE 8.11

Using the Instances to Skip option

Propagate Visual Properties. This option patterns the color, texture, or cosmetic thread
display, along with the feature to which it is attached.

Vary Sketch. This option in patterns is often overlooked and not widely used or under-
stood. While it may have a niche application, it is a powerful option that can save you a
lot of time if you ever need to use it.

Vary Sketch allows the sketch of the patterned feature to maintain its parametric relations
in each instance of the pattern. It is analogous to the Geometry Pattern. Where Geometry
Pattern disables the parametric end condition for a feature, Vary Sketch enables the para-
metric sketch relations for a pattern.

To activate the Vary Sketch option, the Linear Pattern must use a linear dimension for its
Pattern Direction. The dimension must measure in the direction of the pattern, and add-
ing the spacing for the pattern to the direction dimension must result in a valid feature.

The sketch relations must hold for the entire length of the pattern. Figure 8.12 shows the
sketch relations and the resulting pattern. The preview function for this feature does not work.
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Using the Vary Sketch option

O e CD-R O To better understand how this feature works, open the sam;.)le file from the
CD-ROM called Chapter 8 Vary Sketch.sldprt, and edit Sketch2.

Edit the .40-inch dimension. Double-click it and use the scroll arrow to increase the dimension;
watch the effect on the sketch. If a sketch does react to changes properly, then it cannot be used
with the Vary Sketch option. In this case, the .40-inch dimension is used as the direction. The
direction dimension has to be able to drive the sketch in the same way that this one does. These
dimensions cannot pass through the Zero value and cannot flip directions or move into negative
values.

To make the sketch react this way to changes in the dimension, the slot was created using the bi-
directional offset that was demonstrated in an earlier chapter, which means that the whole opera-
tion is being driven by the construction lines and arcs at the centerline of the slot. Sketch points
along the model edges are kept at a certain distance from the ends of the slots using the .50-inch
dimensions. The arcs are controlled by an Equal Radius relation and a single .58-inch radius
dimension. The straight lines at the ends of the slots are controlled by an Equal Length relation.

This type of dimensioning and relation creation is really what parametric design is all about. The
Vary Sketch option takes what is otherwise a static linear pattern and makes it react parametrically
in a way that would otherwise require a lot of setup to create individual features. If you model
everything with the level of care that you need to put into a Vary Sketch pattern feature sketch,
then your models will react very well to change.

Circular Pattern

The Circular Pattern feature requires a circular edge or sketch, a cylindrical face, a revolved face, a
straight edge, an axis, or a temporary axis to act as the Pattern Axis of the pattern. All the other
options are the same as the Linear Pattern — except that the Circular Pattern does not have a
Direction 2 option, and the Equal Spacing option works differently.
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FIGURE 8.13

Equal Spacing takes the total angle and evenly divides the number of instances into that angle. The
name equal spacing is a bit misleading because all Circular Patterns create equal spacing between
the instances, but somehow everyone knows what they mean.

Without using the Equal Spacing option, the Angle setting represents the angular spacing between
instances.

The Vary Sketch option is available in Circular Pattern as well. The principles for setup are the
same, but you must select an angular dimension for the direction. The part shown in Figure 8.13
was created using this technique.

A Circular Pattern vary sketch
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Curve Driven Pattern

A Curve Driven Pattern does just what it sounds like: it drives a pattern along a curve. The curve
could be a line, an arc, or a spline. It can be an edge, a 2D or 3D sketch, or even a real curve fea-
ture. An interesting thing about the Curve Driven Pattern is that it can have a Direction 2, and
Direction 2 can also be a curve. This pattern type is one of the most interesting, with many options
available.

For an entire sketch to be used as a curve, the sketch must not have any sharp corners — all the
entities must be tangent. This could mean using sketch fillets or a fit spline. The example shown in
Figure 8.14 is created using sketch fillets. This pattern uses the Equal Spacing option, which
spaces the number of instances evenly around the curve. It also uses the Offset Curve option,
which maintains the patterned feature’s relationship to the curve throughout the pattern, as if an
offset of the curve goes through the centroids of each patterned instance. The Align to Seed option
is also used, which keeps all the pattern instances aligned in the same direction.
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The Curve Driven Pattern using sketch fillets

Figure 8.15 shows the same part using the Transform Curve positioning option and Tangent to
Curve alignment option.

Instead of an offset of the curve going through the centroids of each patterned feature instance, in
the Transform Curve, the entire curve is moved rather than offset. On this particular part, this
causes a messy pattern. The Tangent to Curve option gives every patterned instance the same ori-
entation relative to the curve as the original.

The Face Normal option is used for a 3D pattern, as shown in Figure 8.16. Although this function-
ality seems a little obscure, it is useful if you need a 3D curve-driven pattern on a complex surface.
If you are curious about this example, it is on the CD-ROM with the filename Reference 34d
Curve Driven.sldprt.
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Using the Transform Curve and Tangent to Curve options

FIGURE 8.16

Using a 3D curve-driven pattern

Using a Direction 2 for a curve-driven pattern creates a result similar to that in Figure 8.17. This is
another situation that, although rare, is good to know about.
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Using Direction 2 with a curve-driven pattern

The rest of the Curve Driven Pattern works like the other pattern features that have already been
demonstrated.

Sketch Driven Pattern

Sketch-driven patterns use a set of sketch points to drive the locations of features. The Hole
Wizard drives the locations of multiple holes using sketch points in a similar way. However, the
Sketch Driven Pattern does not create a 3D pattern in the same way that the Hole Wizard does.
Figure 8.18 shows a pattern of several features that has been patterned using a sketch-driven pat-
tern. A reference point is not necessary for the first feature.

The Centroid option in the Reference Point section is fine for symmetrical and other easily defin-
able shapes such as circles and rectangles, where you can find the centroid just by looking at it, but
on more complex shapes, you may want to use the Selected Point option. The Selected Point
option is shown in Figure 8.19.

Table Driven Pattern

A table-driven pattern drives a set of feature locations, most commonly holes, from a table. The
table may be imported from any source with two columns of data (X and Y) that are separated by a
space, tab, or comma. Extraneous data will cause the import to fail.

The XY Origin for the table is determined by a Coordinate System reference geometry feature. The
XY plane of the Coordinate System is the plane to which the XY data in the table refers.

You can access the Coordinate System command through the menus at Insert = Reference
Geometry = Coordinate System. You can create the Coordinate System by selecting a combination
of a vertex for the Origin and edges to align the axes. Like the Sketch Driven Pattern, this feature
can use either the centroid or a selected point on the feature 